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and written consent from Keysight Technolo-
gies as governed by United States and inter-
national copyright laws.
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9-1, Takakura-machi, Hachioji-shi, Tokyo
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Regulatory Compliance
This product has been designed and tested in 
accordance with accepted industry standards, 
and has been supplied in a safe condition. To 
review the Declaration of Conformity, go to 
http://www.keysight.com/go/conformity.

Warranty
THE MATERIAL CONTAINED IN THIS DOCU-
MENT IS PROVIDED “AS IS,” AND IS SUBJECT 
TO BEING CHANGED, WITHOUT NOTICE, IN 
FUTURE EDITIONS. FURTHER, TO THE MAXI-
MUM EXTENT PERMITTED BY APPLICABLE 
LAW, KEYSIGHT DISCLAIMS ALL WARRAN-
TIES, EITHER EXPRESS OR IMPLIED, WITH 
REGARD TO THIS MANUAL AND ANY INFOR-
MATION CONTAINED HEREIN, INCLUDING 
BUT NOT LIMITED TO THE IMPLIED WAR-
RANTIES OF MERCHANTABILITY AND FIT-
NESS FOR A PARTICULAR PURPOSE. 
KEYSIGHT SHALL NOT BE LIABLE FOR 
ERRORS OR FOR INCIDENTAL OR CONSE-
QUENTIAL DAMAGES IN CONNECTION WITH 
THE FURNISHING, USE, OR PERFORMANCE 
OF THIS DOCUMENT OR OF ANY INFORMA-
TION CONTAINED HEREIN. SHOULD KEY-

SIGHT AND THE USER HAVE A SEPARATE 
WRITTEN AGREEMENT WITH WARRANTY 
TERMS COVERING THE MATERIAL IN THIS 
DOCUMENT THAT CONFLICT WITH THESE 
TERMS, THE WARRANTY TERMS IN THE SEP-
ARATE AGREEMENT SHALL CONTROL

KEYSIGHT TECHNOLOGIES DOES NOT WAR-
RANT THIRD-PARTY SYSTEM LEVEL (COMBI-
NATION OF CHASSIS, CONTROLLERS, 
MODULES, ETC.) PERFORMANCE, SAFETY, 
OR REGULATORY COMPLIANCE, UNLESS 
SPECIFICALLY STATED.

Technology Licenses 
The hardware and/or software described in 
this document are furnished under a license 
and may be used or copied only in accordance 
with the terms of such license.

U.S. Government Rights
The Software is “commercial computer soft-
ware,” as defined by Federal Acquisition Reg-
ulation (“FAR”) 2.101. Pursuant to FAR 12.212 
and 27.405-3 and Department of Defense FAR 
Supplement (“DFARS”) 227.7202, the U.S. 
government acquires commercial computer 
software under the same terms by which the 
software is customarily provided to the public. 
Accordingly, Keysight provides the Software 
to U.S. government customers under its stan-
dard commercial license, which is embodied 
in its End User License Agreement (EULA), a 
copy of which can be found at http://
www.keysight.com/find/sweula. The license 
set forth in the EULA represents the exclusive 
authority by which the U.S. government may 
use, modify, distribute, or disclose the Soft-
ware. The EULA and the license set forth 
therein, does not require or permit, among 
other things, that Keysight: (1) Furnish techni-
cal information related to commercial com-
puter software or commercial computer 
software documentation that is not customar-
ily provided to the public; or (2) Relinquish to, 
or otherwise provide, the  government rights 
in excess of these rights customarily provided 
to the public to use, modify, reproduce, 
release, perform, display, or disclose com-
mercial computer software or commercial 
computer software documentation. No addi-

tional government requirements beyond those 
set forth in the EULA shall apply, except to the 
extent that those terms, rights, or licenses are 
explicitly required from all providers of com-
mercial computer software pursuant to the 
FAR and the DFARS and are set forth specifi-
cally in writing elsewhere in the EULA. Key-
sight shall be under no obligation to update, 
revise or otherwise modify the Software.  With 
respect to any technical data as defined by 
FAR 2.101, pursuant to FAR 12.211 and 
27.404.2 and DFARS 227.7102, the U.S. gov-
ernment acquires no greater than Limited 
Rights as defined in FAR 27.401 or DFAR 
227.7103-5 (c), as applicable in any technical 
data.

Open Software License 
Portions of the software are licensed by third 
parties, including open source terms and con-
ditions.

To get the text of the license, use the Graphi-
cal Web Interface of the instrument. 

You can also visit www.keysight.com and type 
the model number in the search field to get 
the text of the license.

Contact Keysight to obtain the source code. 
Keysight may charge for shipping.

Latest Information
To get the latest firmware/software/electronic 
manuals/specifications/support information, 
go to www.keysight.com and type in the prod-
uct number in the Search field at the top of the 
page.

http://www.keysight.com/go/conformity


COMPLIANCE WITH GERMAN NOISE REQUIREMENTS

This is to declare that this product is in conformance with the German Regulation on Noise 
Declaration for Machines (Lärmangabe nach der Maschinenlärminformation-Verordnung 
-3.GSGV Deutschland).

• Herstellerbescheinigung

GERÄUSCHEMISSION

Lpa < 70 dB

am Arbeitsplatz

normaler Betrieb

nach DIN 45635 T. 19

• Manufacturer’s Declaration

ACOUSTIC NOISE EMISSION

Lpa < 70dB

operator position

normal operation

per ISO 7779

South Korean Class A EMC declaration

This equipment is Class A suitable for professional use and is for use in electromagnetic 
environments outside of the home.



• When the RED indicator lights, lethal voltage (3000 V dc/pulse) may appear at 
measurement terminals.

• Usually use the interlock function.

• Do not operate the instrument unless another person is around the work space who is 
familiar with instrument operation and hazards or administering first aid.

• Potentials less than 500 V may cause death under certain conditions. Therefore, 
adequate preventive measures must be taken at all times!

FIRST AID FOR ELECTRIC SHOCK

SPECIAL ATTENTION TO RESCUE IN SAFETY

• Never rush into an accidental situation. 

• Take special attention to the following notices to prevent second accident.

• Do NOT touch the CASUALTY or conductive surface with your hands unprotected.

• Shut off high voltage at once. 

• Disconnect AC mains. 

• If it is unsure to make safe, the following procedure will helps to protect your lives 
during the CASUALTY is rescued.

• Stand on a dry insulating material; use a dry wooden or plastic implement to free 
the CASUALTY from contact with hazardous electrical source.

• Ground the circuit to de-energize.

WARNING

High Voltage
is used in the operation of this equipment.

LETHAL VOLTAGE on CONTACT
may be present at measurement terminals, 
if you fail to take in all safety precautions!



• Free the CASUALTY from the LIVE conductor

CALL EMERGENCY

• Call your local Emergency number immediately, if any of signs or symptoms shown in 
the following table will be found.

http://en.wikipedia.org/wiki/Emergency_telephone_number#Emergency_numbers

DELAYED SYMPTOMS

• In some cases, electric shock can cause injuries that are not evident and symptoms 
may be delayed.

• Burns to the CASUALTY may be greater than they appear on the surface.

• For these reasons, all electric shock CASUALTY should be taken to hospital for 
advanced observation.

English Deutsch French Japanese Korean Simplified 
Chinese

Traditional 
Chinese

Symptoms Symptome Symptômes
Cardiac arrest Herz-Kreislauf -Stillsta

nd
Arestation 
cardiopulmonaire

Abnormal cardiac 
rhythm

Arrhythmia Arythmie

Respiratory failure 
(difficult or absent 
breathing)

Respiratorischer 
Mißerfolg

Échec respiratoire

Muscle pain and 
contractions

Muskelschmerz und 
Zusammenziehungen

Douleur du muscle 
et contractions

/ / / /

Seizures (heart 
beat stopped)

Herzlähmung Paralysie cardiaque

Numbness and 
tingling

Eine Taubheit / 
Stachel

Un engourdissement 
/ Une épine

/ / / /

Unconsciousness Bewusstlosigkeit Évanouissement
Entrance and exit 
wound burns

Eine elektrische 
Schockspur

Une trace du choc 
électrique



First Aid for Electric Shock Procedure  

 
D Danger Check for DANGER, make SAFE first to YOU, Others, and the CASUALTY.
R Response  Check for a RESPONSE.
  Leave on back.

If not conscious,  
1. Ask others to emergency CALL for an ambulance immediately.
2. HELP to bring AED, ASAP.
3. Start CPR by YOU. 

C CPR 
for ADULT  only 

Start the center of chest compressions (>100 compressions per minute)  without 
stopping until emergency medical services arrive . 

  One of the most famous chest compression-only CPR is AHA Hands-Only CPR which 
is without mouth-to-mouth rescue breaths.  
http://handsonlycpr.org/                                   
http://www.youtube.com/watch?v=zuJkRpJ7Fxg             
Rhythm of chest compression : 
http://www.heart.org/HEARTORG/CPRAndECC/CommunityTraining/CommunityPro
grams/CPR -Week_UCM_427219_SubHomePage.jsp  
http://www.youtube.com/watch?v=n5hP4DIBCEE&feature=player_detailpage        
Continue CPR until  
� Signs of life return.
� AED is ready to use.
� Medical services arrive and take over.

If YOU have a trained rescue skill, should apply the following step.     
If not, only keep chest compression until others help. 
A Airway  No foreign material  

Leave on back, open airway. 
Foreign material  
Place in  the recovery position,  clear of objects.

B Breathing  30 compress & 2 breaths  
D Defibrillator  

 

Apply AED with following voice prompts.  
If no AED available, continue CPR until qualified personnel arrives.  

 AED: Automated External Defibrillator  
 CPR: Cardio Pulmonary Resuscitation  
 AHA: American Heart Association, Inc.  

Do not give compression-only CPR to infants and children — all infants and children who have a sudden
cardiac arrest need conventional CPR.     Also should not be used for adults whose cardiac arrest is from
respiratory causes, or for an unwitnessed cardiac arrest.



Reference 

• AHA CPR & Emergency Cardiovascular Care (ECC) 
(http://www.heart.org/HEARTORG/CPRAndECC/CPR_UCM_001118_SubHomePage.js
p)

• AHA Hands-only CPR (http://handsonlycpr.org/)

• Save a Life 
(http://www.heart.org/HEARTORG/CPRAndECC/CommunityTraining/CommunityProgr
ams/CPR-Week_UCM_427219_SubHomePage.jsp)

• AHA CPR Translated Website 
(http://www.heart.org/HEARTORG/CPRAndECC/International/TranslatedWebsites/Tra
nslated-Websites_UCM_303149_SubHomePage.jsp) 
Deutsch (http://www.american-heart.de/startseite) 
Japanese (http://eccjapan.heart.org/) available as of March, 2012))

• Chain of Survival 
(http://www.heart.org/HEARTORG/CPRAndECC/WhatisCPR/ECCIntro/Chain-of-Surviv
al_UCM_307516_Article.jsp)

• ECC Guidelines Highlights 2010 
English (http://eccjapanheart.org/pdf/ECC_Guidelines_Highlights_2010.pdf) 
Japanese (http://eccjapanheart.org/pdf/ECC_Guidelines_Highlights_2010JP.pdf) 
Deutsch (http://www.american-heart.at/fileadmin/downloads/Guidelines2010-Highlig
hts_D/Guidelines2010-Highlights_D.pdf)

International

• ILCOR (http://www.ilcor.org/home/)

• ILCOR CoSTR 2010 Consensus 
(http://www.ilcor.org/consensus-2010/costr-2010-documents/)

Europe

• ERC (https://www.erc.edu/)

• ERC Guidelines 2010 (http://www.cprguidelines.eu/2010/)

Local language translation (https://www.erc.edu/index.php/doclibrary/en/185/1/)

America

• AHA (http://www.americanheart.org/)

• AHA Guidelines 2010 (http://guidelines.ecc.org/2010-guidelines-for-cpr.html)



Safety Summary
The following general safety precautions must be observed during all phases of operation, 
service, and repair of this instrument. Failure to comply with these precautions or with 
specific warnings elsewhere in this manual may impair the protections provided by the 
instrument. In addition, it violates safety standards of design, manufacture, and intended 
use of the instrument. Keysight Technologies assumes no liability for customer’s failure to 
comply with these requirements.

Product manuals may be provided on CD-ROM or in printed form. Printed manuals are an 
option for many products. Manuals may also be available on the Web. Go to 
www.keysight.com and type the product model number in the Search field at the top of the 
page.

NOTE Do not use this instrument in any manner not specified by the manufacturer. The protective 
features of this instrument may be impaired if it is used in a manner not specified in the 
operation instructions.

This instrument is an INDOOR USE product.

This instrument complies with OVERVOLTAGE CATEGORY II for mains input and 
POLLUTION DEGREE 2 defined in IEC 61010-1.

If an instrument is marked CAT I (IEC Measurement Category I), or it is not marked with a 
measurement category, its measurement terminals must not be connected to line-voltage 
mains.

Safety of any system incorporating the equipment is the responsibility of the assembler of 
the system.

WARNING Hazardous voltage, instrument maximum output voltage may appear at the measurement 
terminals (High, Force, Guard, and Sense) if Interlock terminal is closed. Open the Interlock 
terminal when the measurement terminals are accessible. Voltage applied to the terminals 
will be limited up to ±42 V.

Do not work the interlock function intentionally in order to bring the output voltage to the 
safe level. While the high voltage indicator is lit, the dangerous voltage by the output 
voltage or the residual charge appears on the measurement terminal.



• DANGEROUS PROCEDURE WARNINGS

Warnings, such as WARNING on the previous page, shall be complied. Procedures 
throughout in this manual prevent you from potentially hazard. Their instructions 
contained in the warnings must be followed.

• BEFORE APPLYING POWER

Verify that all safety precautions are taken. Make all connections to the instrument 
before applying power. Note the instrument's external markings described under 
“Safety Symbols”.

• GROUND THE INSTRUMENT

This is Safety Class I instrument. To minimize shock hazard, the instrument chassis and 
cabinet must be connected to an electrical ground. The power terminal and the power 
cord must meet International Electrotechnical Commission (IEC) safety standards.

• DO NOT OPERATE IN AN EXPLOSIVE ATMOSPHERE

Do not operate the instrument in the presence of flammable gases or fumes. Operation 
of any electrical instrument in such an environment constitutes a definite safety hazard.

• DO NOT REMOVE COVERS

No operator serviceable parts inside. Refer servicing to qualified personnel. To prevent 
electrical shock do not remove covers.

• IN CASE OF DAMAGE

Instruments that appear damaged or defective should be made inoperative and 
secured against unintended operation until they can be repaired by qualified service 
personnel. Return the instrument to a Keysight Technologies sales or service office for 
services and repair to ensure that safety features are maintained.

• USE ONLY THE SPECIFIC ACCESSORIES

Specific accessories satisfy the requirements for specific characteristics for using the 
instrument. Use the specific accessories, cables, adapters, and so on for safety 
reasons.



Safety Symbols
The general definitions of safety symbols used on equipment or in manuals are listed below.

Direct current.

Alternating current.

Earth (ground) terminal.

Protective conductor terminal. For protection against electrical shock in case of a fault. 
Used with field wiring terminals to indicate the terminal which must be connected to 
ground before operating equipment.

Frame or chassis terminal. A connection to the frame (chassis) of the equipment which 
normally includes all exposed metal structures.

Grounded terminal which indicates the earth potential.

On supply.

Off supply.

Standby supply. The equipment will be marked with this symbol is not completely 
disconnected from AC mains when power switch is in the standby position.

In position of a bi-stable push switch.

Out position of a bi-stable push switch.

Hazardous voltage and potential for electrical shock. Do not touch terminals that have this 
symbol when the equipment is on.

Hot surface. Avoid contact. Surfaces are hot and may cause personal injury if touched.

Low temperature or freezing conditions. Avoid contact. Surfaces are cold and may cause 
personal injury if touched.

Caution, refer to accompanying documentation. The equipment will be marked with this 
symbol when it is necessary for the user to refer to the instruction manual.

Read operator's manual. To indicate that the operator's manual or card should be read 
before continuing the operation.

IEC Measurement Category I

The CE mark shows that the product complies with all applicable European Directives.

CAT I



The CSA mark is a registered trademark of the Canadian Standards Association.

The RCM mark is a registered trademark of the Australian Communications Authority. This 
signifies compliance with the Australian EMC Framework Regulations under the terms of 
the Radio communications Act.

This ISM device complies with Canadian ICES-001.
Cet appareil ISM est conforme à la norme NMB-001 du Canada.

This ISM device complies with Canadian ICES-001 Class A.
Cet appareil ISM est conforme à la norme NMB-001 classe A du Canada.

This is the symbol for an Industrial, Scientific and Medical, Group 1 Class A product. (CISPR 
11)

The UKCA mark shows that the product complies with all applicable UK regulations.

Korea’s safety and EMC mark

China RoHS -  Environmentally Green Product Label

China RoHS -  Product with Toxic Substance 40 yr EPUP

The Chinese mark for paper-based packaging materials; Paperboard and Corrugated 
Fiberboard

Plastic Material Coding Identification

WARNING A WARNING notice denotes a hazard. It calls attention to an operating procedure, practice, 
or the like that, if not correctly performed or adhered to, could result in personal injury or 
death. Do not proceed beyond a WARNING notice until the indicated conditions are fully 
understood and met.

CAUTION A CAUTION notice denotes a hazard. It calls attention to an operating procedure, practice, 
or the like that, if not correctly performed or adhered to, could result in damage to the 
product or loss of important data. Do not proceed beyond a CAUTION notice until the 
indicated conditions are fully understood and met.

 



Power Supply and Measurement Safety
• Power Supply Safety

This instrument can output high currents and voltages. Make sure that the load or 
device under test can safely handle the output current and voltage. Also, make sure 
that the connection leads can safely withstand the expected currents and are insulated 
for the expected voltages.

The instrument outputs may be connected so as to float relative to earth ground. 
Isolation or floating voltage ratings are indicated on the instrument, near the output 
terminal or the Circuit Common terminal. There is the danger of electric shock by 
touching the floated measurement terminals. Keep in mind it to protect yourself. And it 
is a reason of using the recommended accessories.

• Voltage/Current Measurement Safety

Multimeters and other instruments capable of measuring high voltages and currents 
are subject to specific safety concerns because of the circuits to which they may be 
connected. To safely use these instruments, you need to understand the markings on 
the instrument near the input terminals, which include the Protection Limits and the 
IEC Measurement Category.

• Protection Limits

Keysight multimeters and other voltage measurement instruments provide protection 
circuitry to prevent damage to the instrument and to protect against the danger of 
electric shock, provided the Protection Limits are not exceeded. To ensure safe 
operation of the instrument, do not exceed the Protection Limits shown on the input 
terminals.

• Source/Monitor Terminals

Source/monitor unit, SMU, can simultaneously perform DC voltage or current output 
and measurement. Typical SMU has the Force, Guard, Sense, and Circuit Common 
terminals as shown below. Normally the Force, Guard, and Sense terminals are the 
same potential. Voltage marked around the terminals indicates the Protection Limits.

Force and Sense must be connected to a terminal of a device under test for the Kelvin 
connection which is effective for high current measurement and low resistance 
measurement. For the non-Kelvin connection to ease the connections, connect Force 
only. Do not connect Sense. It must be opened.



Guard should be extended to around the device terminal for reducing leakage current 
caused by a coaxial cable used. Guard must be never connected to anything at the 
device side.

Circuit Common should be connected to shielding of the coaxial cable used.

The following image is the Kelvin triaxial connector of Medium Power SMU.

• To Avoid Risk of Residual Charge

This graph shows the load capacitance vs voltage characteristics generally considered 
as safety. Use the instrument within the safety area up to 0.1 F or 45 C according to 
the voltage. Also do not connect the capacitive load over the maximum load 
capacitance specified for the instrument, for example 10 nF for HVSMU.

Before touching the measurement terminal, confirm that it has been discharged 
enough. For that, ground and discharge the terminals over 10 seconds after stopping 
the high voltage output, and confirm that they have been safety voltage by using 
another volt meter.

If abnormal end of measurement, breaking of cable, or device damage occurs, do not 
touch the terminals until they are discharged enough.

Also if a series resistor is connected, do not touch the terminal until it is discharged 
enough.

Force Sense GuardCircuit CommonGuard
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(Based on standards IEC60950-1 and IEC61010-1.)



High Voltage Shock Hazard

Keysight B1506A can force dangerous voltages (±3000 Vdc for HVSMU and ±100 Vdc for 
MPSMU) at the High, Force, Guard, and Sense terminals. To prevent electric shock hazard, 
the following safety precautions must be observed during the use of Keysight B1506A.

• Connect the instrument to an electrical ground (safety ground) by using 
three-conductor AC power cord.

• Before performing measurement, connect the interlock circuit to the Interlock terminal 
of this instrument.

• Confirm periodically that the interlock function works normally.

• Before touching the connections of the High, Force, Guard, and Sense terminals, turn 
the instrument off and discharge any capacitors of the measurement path. If you do not 
turn the instrument off, complete “all” of the following items, regardless of any 
instrument settings.

• Terminate measurement by pressing the Stop key, confirm that the Measurement 
status indicator is not lit.

• Confirm that the High Voltage indicator is not lit.

• Open the Interlock terminal.

• Discharge any capacitors if the capacitance is connected to an SMU.

• Warn workers in the vicinity of the instrument about hazardous conditions.



Gefahr durch Hochspannung

Von den Geräten Keysight B1506A können Spannungen an den Anschlüssen “High”, 
“Force”, “Guard” und “Sense” von bis zu 3000 V ausgehen. Um elektrischem Schlag 
vorzubeugen, ist bei der Benützung der Geräte Keysight B1506A folgendes zu beachten.

• Verwenden Sie ein dreiphasiges AC-Stromkabel für die Gerätsteckvorrichtung 
(Eingang) und schließen Sie das Instrument an eine Erdung an (Sicherheitserdung).

• Vor der Messung verbinden Sie den Verriegelungsstromkreis mit dem 
Interlock-Anschluss dieses Instruments.

• Prüfen Sie in regelmäßigen Abständen, dass die Verriegelungsfunktion 
ordnungsgemäß funktioniert.

• Bevor Sie die Verbindungen zu den Anschlüssen “High”, “Force”, “Guard” und “Sense” 
berühren, schalten Sie das Instrument aus und entladen alle Kondensatoren des 
Messwegs. Wenn Sie das Instrument nicht ausschalten, führen Sie, unabhängig von 
den Instrumenteinstellungen, alle folgenden Schritte durch.

• Beenden Sie die Messung, indem Sie auf die Taste “Stop” drücken. Stellen Sie 
sicher, dass die Statusanzeige “Measurement” nicht leuchtet.

• Stellen Sie sicher, dass die Anzeige “High Voltage” nicht leuchtet.

• Öffnen des Interlock-Anschlusses.

• Entladen Sie alle Kondensatoren, wenn die Kapazität mit einer SMU verbunden ist.

• Warnen Sie Mitarbeiter in der Umgebung des Instruments vor den Gefahren.



Danger de choc dû à une haute tension

Une tension dangereuse  (max. ± pour HVSMU; 3000 Vdc, max. ± pour MPSMU; 100 Vdc) 
émanant du dispositif Keysight B1506A peut être sortie aux bornes High, Force, Guard et 
Sense. Les précautions suivantes doivent être obserées contre commotion électrique acci-
dentelle.

• Utilisez un câble d’alimentation CA à trois conducteurs vers le coupleur secteur 
(entrée) et branchez l’instrument sur une mise électrique à la terre (prise de terre de 
sécurité).

• Avant de procéder aux mesures, connectez le circuit de sécurité à la borne Interlock de 
l’instrument. 

• Vérifiez régulièrement le bon fonctionnement de la fonction de sécurité.

• Avant de toucher les connexions des bornes High, Force, Guard et Sense, mettez 
l’instrument hors tension et déchargez tout condensateur du chemin de mesure. Si 
vous ne mettez pas l’instrument hors tension, effectuez « toutes » les opérations 
ci-dessous, quels que soient les paramètres de l’instrument.

• Terminez les mesures en appuyant sur la touche Stop ; vérifiez que l’indicateur 
d’état Measurement est éteint.

• Vérifiez que le témoin High Voltage est éteint.

• Ouvrez la borne Interlock.

• Déchargez les éventuels condensateurs si la capacité est connectée à une unité 
SMU.

• Informez les personnes travaillant à proximité de l’instrument des conditions.



高電圧感電注意

Keysight B1506A の High、Force、Guard、Sense 端子には、危険電圧が出力されること
があります（HVSMU の場合は最大 ±3000 Vdc、MPSMU の場合は最大 ±100 Vdc）。感電
事故防止のため、Keysight B1506A の使用時には必ず以下の事柄を守ってください。

• 3 極電源ケーブルを使用して本器を接地してください。

• 測定を開始する前にはインターロック回路を本器の Interlock 端子に接続してく
ださい。

• インターロック機能が正常であることを定期的に確認してください。

• High、Force、Guard、Sense 端子に繋がる接続部に触れる前には、本器の電源をオ
フしてください。また、測定系のキャパシタを放電してください。電源をオフ
しない場合は、以下の事項を全て実施してください。

• Stop キーを押して Measurement インジケータが消灯したことを確認してくだ
さい。

• 高電圧警告（High Voltage）インジケータが消灯していることを確認してくだ
さい。

• Interlock 端子を開放してください。

• キャパシタが SMU に接続されているならば、キャパシタを放電してくださ
い。

• 周囲のほかの作業者に対しても、高電圧危険に対する注意を徹底してください。



Product Stewardship
• Waste Electrical and Electronic Equipment (WEEE)

The crossed out wheeled bin symbol indicates that separate collection for waste 
electric and electronic equipment (WEEE) is required, as obligated by the EU 
DIRECTIVE and other National legislation.

Please refer to http://keysight.com/go/takeback to understand your Trade in options 
with Keysight in addition to product takeback instructions.

• LCD Fluorescent Lamp

Certain products sold by Keysight contain a liquid crystal display (LCD); backlighting 
for the LCD is provided by a fluorescent lamp which contains mercury, and must be 
managed, recycled, and/or disposed in accordance with all applicable laws, ordinances 
and regulations. 

For information on how to recycle or dispose of the fluorescent lamp contained in your 
own product, visit the following website.

http://about.keysight.com/en/quality/env_compliance.shtml

If you live in the U.S., also visit the following websites.

http://www.lamprecycle.org

http://www.eiae.org

If you have additional questions, please visit the following website.

http://www.keysight.com/go/contactus

• Perchlorate Information

Perchlorate Material - special handling may apply. Visit the following website.

http://www.dtsc.ca.gov/hazardouswaste/perchlorate/

Equipment's real-time clock battery or coin cell battery may contain perchlorate and 
may require special handling when recycled or disposed of in California.



Precautionary Statement
Keysight B1506A Power Device Analyzer for Circuit Design operates in the Microsoft 
Windows environment. Keysight B1506A requires Keysight Easy Test Navigator software, a 
specially-designed Windows application program.

• About guarantee and support for Keysight B1506A

Keysight Technologies guarantees and supports the performance of Keysight B1506A 
for the same condition as the preload condition when shipped from the factory.

• About updating Keysight Easy Test Navigator and the Windows Update

Keysight Technologies confirms the operation of Easy Test Navigator patch programs 
and important Windows security patches, and provides recommended update 
information. Visit Keysight B1506A support site, download the patches, and perform 
the software update.

• About Windows application programs and peripherals (including driver)

Using commercial products on Keysight B1506A is your responsibility. Keysight 
Technologies cannot provide compatibility information for commercial products. 

• About servicing

Bench repair service is available at your nearest Keysight Technologies service center. 
Be aware that the B1506A configuration might be updated to the latest one without 
notice because of support issues.

The internal solid state drive (SSD) might be initialized during servicing. If peripherals 
are connected, they will be removed.

When Keysight B1506A is returned, the internal SSD might be initialized. Peripherals 
will be returned separately.

• Other notes

• Back up the internal SSD to prevent loss of data by accident or failure.

• Protect Keysight B1506A from computer viruses.

• If you connect Keysight B1506A to the network, take care to protect it from 
computer virus.



Working in Comfort
To optimize your comfort and productivity, it is important that you set up your work area 
correctly and use your instrument properly. With that in mind, we have developed some 
set-up and use recommendations for you to follow based on established ergonomic 
principles. Improper and prolonged use of keyboards and input devices are among those 
tasks that have been associated with repetitive strain injury (RSI) to soft tissues in the 
hands and arms. If you experience discomfort or pain while using the instrument, 
discontinue use immediately and consult your physician as soon as possible. For more 
information on RSI you may wish to consult the About Repetitive Strain Injury section. 
Please study the recommendations described below. Included there are references to 
relevant parts of international standards, regulations and guidelines, such as ISO 9241 and 
the European Community Display Screen Equipment directive. You may also wish to consult 
your employer’s human resources department or other relevant departments for guidance 
specific to your company.

About Repetitive Strain Injury

Because your comfort and safety are our primary concern, we strongly recommend that you 
use the instrument in accordance with established ergonomic principles and 
recommendations. Scientific literature suggests that there may be a relationship between 
injury to soft tissues -especially in the hands and arms- and prolonged improper use of 
keyboards or other equipment requiring repeated motions of the hands and forearms. This 
literature also suggests that there are many other risk factors that may increase the chance 
of such injury, commonly called Repetitive Strain Injury.

What is RSI?

Repetitive Strain Injury (RSI -also known as cumulative trauma disorder or repetitive 
motion injury) is a type of injury where soft tissues in the body, such as muscles, nerves, or 
tendons, become irritated or inflamed. RSI has been a reported problem for those who 
perform repetitive tasks such as assembly line work, meatpacking, sewing, playing musical 
instruments, and computer work. RSI also has been observed in those who frequently 
engage in activities such as carpentry, knitting, housework, gardening, tennis, windsurfing 
and lifting children.

What causes RSI?

The specific causes of RSI have not been established. Nevertheless, the incidence of RSI 
has been associated with a variety of risk factors, including:

• Too many uninterrupted repetitions of an activity or motion.

• Performing an activity in an awkward or unnatural posture.



• Maintaining static posture for prolonged periods.

• Failing to take frequent short breaks.

• Other environmental and psychosocial factors.

In addition, there have been reports associating the occurrence of RSI with the use of 
keyboards, mice, and other input devices. Also, certain medical conditions, such as 
rheumatoid arthritis, obesity and diabetes, may predispose some people to this type of 
injury.

What if I experience discomfort?

If you are experiencing any discomfort, seek professional medical advice immediately. 
Typically, the earlier a problem is diagnosed and treated, the easier it is to resolve.

Mice and Other Input Devices

Various aspects of using mice and other input devices may increase your risk of discomfort 
or injury. Observing the following recommendations may reduce that risk.

• Try to keep your hand, wrist, and forearm in a neutral position while using your mouse 
or other input device.

• If you use your thumb to rotate the ball on a trackball or spaceball, keep it in a relaxed, 
natural shape, and maintain a neutral posture in your hand, wrist, and forearm.

• Hold the mouse gently by draping your fingers over it. Keep your hand relaxed and 
fingers loose. Do not grip the mouse tightly.

• It takes very little pressure or force from your fingers to activate the buttons or scroll 
wheel on your mouse, scrolling mouse, trackball, or other input device. Using too much 
force can place unnecessary stress on the tendons and muscles in your hands, wrists, 
and forearms.

• If you are using a scrolling mouse, be sure to keep your fingers and hand in a relaxed, 
neutral position when activating the scroll wheel. Also, this type of mouse features 
software that can minimize the number of mouse movements or button clicks.

• When using a mouse, trackball, or other input device, position it as close to the 
keyboard as possible, and keep it at the same level as you do not have to stretch while 
using it.

• Be sure to keep your mouse and trackball clean. Regular removal of accumulated dust 
and dirt helps ensure proper tracking and reduces unnecessary hand and wrist 
motions.



Is your product software up-to-date?
Periodically, Keysight releases software updates to fix known defects and incorporate 
product enhancements. To search for software updates for your product, go to the Keysight 
Technical Support website at:

https://www.keysight.com/find/techsupport

Where to Find the Latest Information
Documentation is updated periodically. For the latest information about these products, 
including instrument software upgrades, application information, and product information, 
browse to one of the following URLs, according to the name of your product:

https://www.keysight.com/find/b1506a

To receive the latest updates by email, subscribe to Keysight Email Updates at the following 
URL:

https://support.keysight.com

Information on preventing instrument damage can be found at:

https://www.keysight.com/find/PreventingInstrumentDamage



Product and Solution Cybersecurity
Keysight complies with multinational regulations for the cybersecurity of its own products 
and is committed to providing information to assist you in protecting your products and 
solutions from external cyber threats. For more information, see:

https://www.keysight.com/us/en/about/quality-and-security/security/product-and-soluti
on-cyber-security.html

Keysight also recommends that you secure your IT environments using appropriate 
third-party tools. For instruments that run the Microsoft Windows operating system, 
Keysight concurs with Microsoft's recommendations for ensuring that the instrument is 
protected:

• Get the latest critical Windows updates

• For network-connected instruments, use an Internet firewall (in Keysight instruments, 
Windows Firewalls enabled by default)

• For network-connected instruments, use up-to-date antivirus and anti-spyware 
software

Responsible Disclosure Program
Keysight recommends that security researchers share the details of any suspected 
vulnerabilities across any asset owned, controlled, or operated by Keysight (or that would 
reasonably impact the security of Keysight and our users) using this form:

https://www.keysight.com/us/en/contact/responsible-disclosure-program.html



Report a Product Cybersecurity Issue
If you discover a cybersecurity issue that you suspect may involve Keysight's proprietary 
software, or third-party software supplied by Keysight as part of a product, or that may 
affect the operation of Keysight products, we encourage you to report it to us using this 
form:

https://www.keysight.com/us/en/about/quality-and-security/security/product-and-soluti
on-cyber-security.html

Disable and Reduce Unnecessary Access
The instrument comes configured to allow access for remote services which allows flexible 
measurement configurations and access to data.

You can disable these features if you don't use them.

Windows Firewall is automatically configured with open ports which can be closed, 
depending on your test application needs. 

The following ports are open by default on the B150xA.

Port 5025: Used by EasyEXPERT SCPI Socket

Port 3389: Used by Windows Remote Desktop

Disable these port if you are not using these feature.



In This Manual
This manual describes the product overview, installation information, measurement 
operation, and software reference information of Keysight Technologies B1506A. 

This manual consists of the following chapters:

1. “Introduction”

This chapter describes basic features of Keysight B1506A.

2. “Installation”

This chapter describes installation and maintenance.

3. “How To Perform Measurement”

This chapter explains how to perform measurement by using Keysight B1506A.

4. “GUI Reference”

This chapter provides the reference information of Keysight Easy Test Navigator 
software.

NOTE For the specifications of the B1506A, see Data Sheet.

To get the latest Data Sheet, go to www.keysight.com/find/b1506a and click “Technical 
Support” and “Specifications”.

NOTE The information is subject to change without notice due to the future enhancement. 

The actual screen image on the B1506A may be different from the image shown in this 
manual.
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Introduction

This chapter describes the basic functions and features of Keysight B1506A Power 
Device Analyzer for Circuit Design, and consists of the following sections.

• “Overview”

• “Mainframe Front View”

• “Mainframe Rear View”

• “Test Fixture Front View”

• “Test Fixture Rear View”

• “Software”

• “Accessories”

• “Options”

• “Measurement Resources”
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Overview
Keysight B1506A Power Device Analyzer for Circuit Design is a complete solution 
that can help power electronic circuit designers maximize the value of their power 
electronics products by enabling them to select the correct power devices for their 
applications. It can evaluate all relevant device parameters under a wide range of 
operating conditions, including IV parameters such as breakdown voltage and 
on-resistance, as well as three terminal FET capacitances, gate charge and power 
loss.The B1506A has a wide range of capabilities that help it identify substandard 
devices under actual circuit operating conditions, including a wide voltage and 
current range (3 kV and 1500 A), a wide temperature measurement range (-50 °C to 
+250 °C), fast pulsing capability, and sub-nA level current measurement capability. 
Its unique software interface presents the user with a familiar device data sheet 
format that makes it easy to characterize devices without going through any formal 
training. Integrated switching circuitry within the test fixture supports fully 
automated testing, with the ability to automatically change between both high 
voltage and high current testing as well as between IV and CV measurements. In 
addition, a unique plug-in style device test fixture socket adapter eliminates cable 
connection and other human-related errors. The B1506A also supports the complete 
automation of thermal characterization. This can be accomplished either through the 
integrated Thermostream control or via the Thermal Plate. Since the DUT is in close 
proximity to the B1506A’s measurement resources, the large parasitics caused by 
cable extensions leading to a temperature chamber do not exist. For this reason, 
oscillation free ultra-high currents of up to 1500 A can be accurately evaluated at 
both low and high temperature.
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Keysight B1506A provides the following packages.

• B1506A-H20: 20 A/3 kV IV Package

• B1506A-H50: 500 A/3 kV IV Package

• B1506A-H70: 1500 A/3 kV IV Package

• B1506A-H21: 20 A/3 kV IV/CV/Gate Charge Package

• B1506A-H51: 500 A/3 kV IV/CV/Gate Charge Package

• B1506A-H71: 1500 A/3 kV IV/CV/Gate Charge Package

Each package contains the mainframe, the test fixture, the connection cables, and 
the control software. For the furnished accessories, see Table 1-1.

Mainframe
Mainframe is equipped with the measurement resources listed below, the 15-inch 
touch screen LCD panel, solid state drive, DVD drive, USB, LAN, GPIB, GPIO 
interfaces, and so on. For more information on the measurement resources, see 
“Measurement Resources” on page 1-26.

NOTE The B1506A with serial number MY64320101 or later is not equipped with DVD 
drive.

• HVSMU, high voltage source/monitor unit, 1 ea. 

• HCSMU, high current source/monitor unit, 1 ea. for the B1506A-H20/H21

• MCSMU, medium current source/monitor unit, 1 ea. for the B1506A-H20, 2 ea. 
for H21, 3 ea. for H50/H70, 4 ea. for H51/H71

• MFCMU, multi frequency capacitance measurement unit, 1 ea. for the 
B1506A-H21/H51/H71

• MPSMU, medium power source/monitor unit, 1 ea. 

• GNDU, ground unit, 1 ea. 

The B1506A provides an intuitive graphical user interface, touch screen LCD, 
stylus pen, USB keyboard, and USB mouse for easy and effective measurement and 
analysis on the Windows environment, and supports the B1506A measurement 
control software listed below. For more information, see “Software” on page 1-20.

• Easy Test Navigator software

• EasyEXPERT software
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Test Fixture
The test fixture is required to connect your device under test (DUT). The following 
furnished accessories are available.

• Socket module for connecting a 3-pin inline package device

• Socket module for connecting a curve tracer test adapter

• Universal socket module kit for connecting variety of packaged devices.

• Accessories for connecting other type of device

• Blank silicon plate

• Connection wire

• Clip

• Banana pin adapter

• Socket adapter for performing gate charge measurement, for the 
B1506A-H21/H51/H71

• Thermocouple for performing temperature measurement

The test fixture initially installs the selector for switching the measurement resource 
connected to the collector/drain terminal of the DUT. The measurement resource 
will be the MFCMU, the HVSMU, the MPSMU, the HCSMU, or the ultra high 
current unit (UHCU). Available resources depend on the package (option).

The B1506A-H50/H51/H70/H71 configures the UHCU by using the test fixture and 
two MCSMU installed in the mainframe. The B1506A-H50/H51 supports up to 500 
A and the B1506A-H70/H71 supports up to 1500 A.

Additionally, for controlling temperature of DUT, the test fixture can be equipped 
with Thermal Plate inside the fixture cover or Thermostream by using the 
B1506A-T01 Thermal Test Enclosure. 

For the Thermal Plate and the Thermostream, contact inTEST Corporation.

NOTE Selector may emit a noise sound during operation. However it is not abnormal 
status.
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Mainframe Front View
This section describes the front view of the mainframe.

1. Standby switch

Turns on/off the mainframe. Pressing the button in the ON state makes it in the 
standby state. The green LED lights when it is in the ON state.

NOTE Opening measurement terminals

Open the measurement terminals at the device side when turning the B1506A on. 
Also disconnect the device from the measurement terminals and open the 
measurement terminals after the measurement. If you leave the connection with the 
device, the device may be damaged by unexpected operations or charge-up of 
measurement cables.

2. SSD access indicator

This green LED lights in the access status of SSD or DVD drive. Do not turn the 
instrument off during this LED lights.
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NOTE The B1506A with serial number MY64320101 or later is not equipped with DVD 
drive.

3. LCD adjustment keys

LCD Off enables or disables the LCD panel. The green LED lights when the 
LCD is disabled.

Four keys are available for adjusting brightness. Use + and - to adjust it and 
then press Set to fix it. Pressing Cancel instead of Set cancels the adjustment. 

4. USB interfaces

USB, 2 ports. For keyboard, mouse, and so on.

To remove USB devices from the instrument, use “Safely Remove Hardware” 
on Windows taskbar. If it is not used, the instrument may cause the internal USB 
communication error. If the error occurs, turn the instrument off and disconnect 
the power cord from it. Leave it about 30 seconds before rebooting it, and 
connect the power cord again, and then turn the instrument on.

5. LCD panel

15 inch TFT XGA display, 1024  768 resolution. Displays the Windows screen, 
the B1506A measurement control software, and so on. Touch screen operation is 
available when the Touch Panel Off indicator does not light.

To adjust the touch panel, use Microchip TSHARC Control Panel which is 
opened by selecting Microchip TSHARC Control Panel from the Start menu.

6. Stop key

Stops the present measurement or source output immediately.

7. High voltage status indicator

This red LED lights when a source channel applies dangerous voltage.

8. Measurement status indicator

This green LED lights when a measurement channel performs measurement.

9. Rotary knob

Works on the execution environment of the B1506A measurement control 
software. Rotating the knob moves the marker on the graph, or 
increases/decreases/changes the value in the active entry field. Pressing the knob 
sets or enters the value.
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10. Softkeys

Seven softkeys are available for the B1506A measurement control software. 
Used to select an alternative for the entry field specified or the dialog box.

11. DVD-R drive

For data backup, software update, and so on.

NOTE The B1506A with serial number MY64320101 or later is not equipped with DVD 
drive.

12. Touch Panel Off key

Works on the execution environment of the B1506A measurement control 
software. Enables or disables the touch screen operation. The green LED lights 
when the touch screen is disabled.
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Mainframe Rear View
This section describes the rear view of the mainframe.

WARNING To avoid electrical shock and instrument damage, turn the all instruments off 
before connecting or disconnecting measurement cable.

Mettez la machine hors tension pour fixer le connecteur ou pour retirer le 
connecteur de l’unité centrale.

WARNING There are potentially hazardous voltages (± 3000 Vdc for HVSMU and ± 100 
Vdc for MPSMU) present at the High, Force, Sense, and Guard terminals of 
the instruments. To prevent electrical shock, the following safety precautions 
must be observed during the use of instruments.

• Connect the instrument to an electrical ground (safety ground) by using 
three-conductor AC power cord.

• Connect the mainframe Interlock terminal to the test fixture Interlock 
terminal by using an interlock cable.

• Confirm periodically that the interlock function works normally.

• Before touching the connections on the High, High Force, High Sense, and 
Guard terminals in the test fixture, turn the instruments off and discharge 
any capacitors. If you do not turn the instruments off, complete all of the 
following items, regardless of the instrument settings.

• Press the front panel Stop key to set the source output off. 

• Confirm that the front panel High Voltage indicator is not lit.

• Open the Interlock terminal (open the fixture cover).

• Discharge any capacitors connected to a measurement resource.

• Warn persons working around the instruments about dangerous 
conditions.
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1. Serial number

You need this serial number when using Keysight Technologies telephone 
assistance program.

2. LED status indicator

For troubleshooting. Followings are some examples.

• Both LEDs turn off:

The instrument is in the standby state and Standby switch is OFF position.

• One LED turns green:

Power supply works normally.

• Both LEDs turn orange:

The instrument is in the standby state and Standby switch is ON position.

3. LINE input receptacle

AC power cord is connected to this receptacle.
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4. GPIB interface

For the GPIB connection of this instrument, use an GPIB interface, Keysight 
82350B/C (for PCI bus), Keysight 82351A/B (for PCIe bus), Keysight 
82357A/B (USB/GPIB), or National Instrument GPIB-USB-HS.

For using an USB/GPIB interface, it is recommended to set the GPIB address of 
this instrument to an even number. The USB/GPIB interface might cause serial 
poll error intermittently due to the intrinsic communication scheme differences. 
It is reported that using an even GPIB address sometimes significantly decreases 
the chance of the error. 

5. Video output terminal

VGA connector. For an external display. Signal to the built-in LCD is also 
applied to this terminal.

6. Measurement Resources

See A to F described later.

7. Circuit Common ( ) and frame ground ( ) terminals

Normally, connect the terminals together by using the shorting bar. For floating 
measurement, remove the shorting bar.

WARNING If the Circuit Common terminal is not connected to the frame ground terminal 
(for floating measurement), a potential shock hazard may present. Do not 
touch any of measurement circuit at any time while a floating measurement is 
in progress.

Si la borne Circuit Common n'est pas connectée à la borne de terre du cadre 
(pour des mesures de flotte), il peut y avoir un risque de choc électrique. Ne 
touchez aucun circuit de mesure à n'importe quel moment quand la mesure de 
flotte est en cours.

CAUTION For floating measurement, do not apply dangerous voltage to the Circuit Common 
terminal. Failure to heed this caution may result in damage to the instrument.

8. Zero Check terminal

Ground reference point of the instrument.

CAUTION The Zero Check terminal can be used for the service purpose only. For the normal 
operation, leave this terminal open and do not connect anything to this terminal. 
Connecting anything can damage the instrument.
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9. GNDU terminal

0 V constant voltage source. Used for the reference of measurement ground. 
Triaxial connector.

10. LAN interface

RJ45 connector.

11. USB interfaces

USB, 2 ports. For keyboard, mouse, or peripherals.

To remove USB devices from the instrument, use “Safely Remove Hardware” 
on Windows taskbar. If it is not used, the instrument may cause the internal USB 
communication error. 

If the error occurs, turn the instrument off and disconnect the power cord from it. 
Leave it about 30 seconds before rebooting it, and connect the power cord again, 
and then turn the instrument on.

12. Ext Trig terminals

Two BNC connectors, one for trigger input, and one for trigger output. For 
details about the trigger function, see Programming Guide.

13. Digital I/O terminal

Used to connect the test fixture.

14. Interlock terminal

Used to connect the test fixture. If the fixture cover is open, maximum output is 
limited to ±42 V. 

To verify the interlock function, perform the Interlock Open/Close test on the 
Main Frame tab screen of the EasyEXPERT Configuration window.

WARNING Dangerous voltage, instrument maximum output voltage may appear at High, 
Force, Sense, and Guard terminals if the fixture cover is closed.

Une tension dangereuse, une tension de sortie maximale de l'appareil peut 
apparaître aux bornes High, Force, Guard et Sense si la borne Interlock est 
fermée.

A. GNDU/ADC

Ground unit (GNDU) and A/D converter.
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B. MPSMU

Medium power source/monitor unit (MPSMU) has two triaxial connectors, force 
and sense, for the Kelvin connections. 

C. MFCMU for B1506A-H21/H51/H71

Multi frequency capacitance measurement unit (MFCMU) has four coaxial 
connectors, Lcur, Lpot, Hpot, and Hcur, for the four-terminal pair connection.

CAUTION Do not apply voltage more than ±25 V to the MFCMU input terminals. Failure to 
heed this caution may result in damage to the MFCMU.

D. MCSMU

Medium current source/monitor unit (MCSMU) has two triaxial connectors, 
force and sense, for the Kelvin connections. 

E. HCSMU for B1506A-H20/H21

High current source/monitor unit (HCSMU) has the force coaxial connector and 
the sense triaxial connector, for the Kelvin connections. 

F. HVSMU

High voltage source/monitor unit (HVSMU) has the force connector. 
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Test Fixture Front View
This section describes the front view of the test fixture.

1. Measurement terminals

Connects the connection wire or attaches the socket module/adapter for 
connecting your device under test (DUT). For more information, see 
“Measurement Terminals” on page 1-16.

2. DUT stage

In the above picture, the Blank Silicon Plate is set on the stage, and the Thermal 
Plate is placed on the Blank Silicon Plate. For the Thermal Plate, contact 
inTEST Corporation.

3. Terminal for connecting wrist strap

4. Fixture cover

The fixture cover should be closed to avoid electrical shock by touching 
measurement terminals and to prevent a device under test from external noise.

When the fixture cover is open, maximum output voltage is limited to ± 42 V.
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WARNING Hazardous voltage, instrument maximum output voltage may appear at the 
High, High Force, High Sense, and Guard terminals if the fixture cover is 
closed.

WARNING Make sure that the cover is closed properly before starting measurement. Do 
not perform the measurement when a wire is protruding from the fixture cover.

Assurez-vous que le couvercle est fermé correctement avant de commencer la 
mesure. Ne pas effectuer la mesure lorsqu’un câble dépasse du couvercle de 
l'appareil.

5. Thermal Plate connector

This connector is used to connect the cable from the Thermal Plate. For the 
Thermal Plate, contact inTEST Corporation.

6. Thermocouple terminals

For connecting thermocouple to measure temperature around a DUT. 
Temperature range is -50 C to 250 C.

7. Status indicator

Power LED turns yellow when the AC power is applied to the test fixture.

Power LED turns green when the test fixture is ready to use.

IV LED lights when the B1506A is in the IV measurement condition.

CV LED lights when the B1506A is in the capacitance measurement condition.

8. Hazardous voltage status indicator

This red LED lights when a measurement resource applies dangerous voltage. 
This indicator is connected to the mainframe via the Interlock terminal and 
works with the High Voltage indicator on the mainframe front panel.

Warming labels written in French, German, and Japanese are furnished. Attach 
the label to the front panel of the fixture if you need.

WARNING The red light indicates that hazardous voltage (maximum ± 3000 Vdc) may 
appear at measurement terminals. Check this indicator before accessing.

Le témoin rouge indique qu'une tension dangereuse (± 3000 V Max) risque 
d’apparaître au niveau des bornes de mesure. Vérifiez cet indicateur avant 
d’accéder.

9. Thermal Plate
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Contact inTEST Corporation.

10. Temperature controller of Thermal Plate

Contact inTEST Corporation.

Measurement Terminals

WARNING Set the instrument output off before connecting or disconnecting connection 
wire.

Press the mainframe front panel Stop key to set the source output off. And 
confirm that the mainframe front panel High Voltage indicator is not lit.

WARNING To prevent electrical shock and DUT damage, do not connect or disconnect the 
DUT while the instrument is applying voltage or current.

When you touch the DUT after measurement, devise a countermeasure of 
residual charge and heat to prevent electrical shock and burn. Use glove and 
any tool. Also have enough time for discharge and radiation.

Pour éviter toute électrocution et tout risque d'endommagement de l'appareil, 
ne retirez pas les câbles pendant le fonctionnement.

Lorsque vous touchez le MST après la mesure, élaborez une contre-mesure de 
la charge résiduelle et du chauffage afin d'éviter tout choc électrique et toute 
brûlure. Utilisez des gants et des outils. Prévoyez également du temps pour la 
décharge et la radiation.

CAUTION Never connect the High, High Force, High Sense, or Guard terminal to any output, 
including circuit common and chassis ground. Connecting other output may damage 
the connected one.

NOTE To use the 3-pin Inline Package Socket Module or the Curve Tracer Test Adapter 
Socket Module, attach it to the Base/Gate, Collector/Drain, and Emitter/Source 
terminals. Then do not use the Guard terminal.

NOTE To use the Gate Charge Socket Adapter, attach it to the Base/Gate, Collector/Drain, 
Emitter/Source, and AUX Force terminals. Then do not use the AUX Sense.

If you do not use the socket module or the Gate Charge Socket Adapter, connect 
your device under test (DUT) to the terminals by using connection wire, clip, 
adapter, and so on. Then set the Blank Silicon Plate on the DUT stage.
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1. Base/Gate High and Low terminals

Connect High to the gate or base terminal of DUT.

Connect Low to the source or emitter terminal of DUT.

2. Collector/Drain High Force and Sense terminals

Connect Force and Sense to the drain or collector terminal of DUT.

Force and Sense must be connected together at the terminal of DUT for making 
the Kelvin connection.

3. Collector/Drain Guard terminal

Guard of Collector/Drain High. The guard has the same potential as the 
Collector/Drain High. You may extend the guard as close as possible to the drain 
or collector terminal of DUT to reduce the leakage current caused by the cable. 
Open the guard at the end of the cable. Never connect it to anything.

4. Emitter/Source Low Force and Sense terminals

Connect Force and Sense to the source or emitter terminal of DUT.

Force and Sense must be connected together at the terminal of DUT for making 
the Kelvin connection.

5. Chassis common terminal

Use for grounding or shielding.

6. AUX High Force and Sense terminals and Low Force and Sense terminals

Output terminals internally connected to the AUX input connectors. The 
measurement resource is the SMU3 (MCSMU) installed in the mainframe.

Connect High Force and Sense to the high terminal of DUT.

Connect Low Force and Sense to the low terminal of DUT.

Force and Sense must be connected together at the terminal of DUT for making 
the Kelvin connection.

Force

High

Low

High

Low

±100 V Max
GuardSense

Force Sense

±3 kV   Max
Collector/Drain

Emitter/Source

Base/Gate

SenseForce

AUX
±30 V Max

High

Low
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Test Fixture Rear View
WARNING To avoid electrical shock and instrument damage, turn the all instruments off 

before connecting or disconnecting measurement cable.

Mettez la machine hors tension pour fixer le connecteur ou pour retirer le 
connecteur de l’unité centrale.

This section describes the rear view of the test fixture. For connecting the cables, see 
“To Connect Test Fixture” on page 2-10.

1. Power switch

Turns on/off the test fixture.

2. LINE input receptacle

AC power cord is connected to this receptacle.

3. Option number label

4. Serial number label

You need this serial number when using Keysight Technologies telephone 
assistance program.

5. Connectors for connecting the system cable
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The following measurement resources in the mainframe are connected by using 
the system cable.

• HVSMU

• HCSMU for B1506A-H20/H21

• MCSMU

• MPSMU

• GNDU

6. Connectors for connecting the CMU cable, for B1506A-H21/H51/H71

The connectors are used to connect the CMU cable from the MFCMU in the 
mainframe.

7. Digital I/O terminal

This terminal is used to connect the Digital I/O cable from the mainframe 
Digital I/O terminal.

8. Earth terminal

Screw terminal for earthing.

WARNING Connect a wire from an electrical ground (safety ground) to this terminal.

Connecter un fil depuis une mise à la terre électrique (mise à la terre de 
sécurité) à la borne de terre.

9. Interlock terminal

This terminal is used to connect the interlock cable from the mainframe 
Interlock terminal. The interlock cable is included in the system cable.

WARNING Potentially hazardous voltage may be present at the High, Force, Sense, and 
Guard terminals when the interlock terminals are shorted on test fixture, probe 
station, and such.

10. Thermal Plate connector

This connector is used to connect the cable from the temperature controller of 
the Thermal Plate. For the Thermal Plate, contact inTEST Corporation.
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Software
Keysight B1506A realizes easy and effective measurement and analysis on the 
Windows environment using an intuitive graphical user interface, touch screen 
LCD, stylus pen, keyboard, and mouse. The following software is previously 
installed or stored in the mainframe.

• “Easy Test Navigator Software”

• “EasyEXPERT Software”

• “Utility Software”

Easy Test Navigator Software
The Easy Test Navigator software provides measurement control software for power 
device characterization. It supports various types of measurement task with 
ease-of-use and simple operation. Some of the functions are listed below. For more 
information on the Easy Test Navigator software, see Chapters 3 and 4.

• Software included:

• Datasheet characterization software

• I/V measurement software

• Capacitance measurement software, for B1506A-H21/H51/H71

• Gate charge measurement software, for B1506A-H21/H51/H71

• Power loss calculation software, for B1506A-H21/H51/H71

• Thermal monitor/control software

• Ready-to-use measurement templates for typical power device characteristics 
measurements

• Ability to automatically accumulate measurement data on the SSD in exportable 
formats

• Oscilloscope view for a pulsed sweep measurement point
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EasyEXPERT Software
The EasyEXPERT software is an application program for controlling Keysight 
B1500 series. Some of the functions are listed below. For more information, see 
Keysight EasyEXPERT User’s Guide.

• Single measurement, repeat measurement, and append measurement

• Module selector control

• Measurement/setup data management by workspace

• Graph display and analysis with markers, cursors, and lines; and auto analysis

• Data import/export capability, data output by CSV/XML format, and graph 
output by EMF/BMP/GIF/PNG format

• Maintenance; self-test and self-calibration

• Remote control function from an external computer

The EasyEXPERT has the following measurement execution environments.

• Application test

• Classic test

• Tracer test

• Quick test

NOTE Application Library

The EasyEXPERT contains an application library that is a set of test definitions. The 
application test can be performed by selecting a test definition and setting the test 
condition for the actual DUT (device under test).

All test definitions are just sample. If the samples damage your devices, Keysight 
Technologies is NOT LIABLE for the damage.

Utility Software
Followings are the utility software available for the B1506A. For more information 
on the utility software, see Keysight EasyEXPERT User’s Guide.

• EasyEXPERT for PC software

EasyEXPERT software runs on an external Windows PC.
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• 4155/4156 setup file converter

Program for converting the 4155/4156 measurement setup files (file extension 
MES or DAT) into EasyEXPERT classic test setup files. This program is stored 
in the following folder.

<program folder>\Agilent\B1500\EasyEXPERT\415xC\Conversion\

• MDM file converter

Program for converting EasyEXPERT data files (file extension XTR or ZTR) 
into Keysight IC-CAP MDM files. This program is stored in the following 
folder.

<program folder>\Agilent\B1500\EasyEXPERT\IC-CAP Support\MDM\

• Prober control programs

Execution files for controlling the probers listed below. The files are stored in 
the following folder.

<program folder>\Agilent\B1500\EasyEXPERT\Utilities\

Probers supported:

• Cascade Microtech Summit 12K or S300

• SUSS MicroTec PA200 or PA300

• Vector Semiconductor VX-2000 or VX-3000

• sleep.exe program

Execution file for inserting a wait time in the test execution flow of an 
EasyEXPERT application test. This file is stored in the following folder.

<program folder>\Agilent\B1500\EasyEXPERT\Utilities\

NOTE Notations

<program folder> is as follows. Then, <system drive> is the drive the B1506A 
measurement control software has been installed.

For Windows 10/7 64 bit version, <system drive>:\Program Files (x86)

For Windows 10/7 32 bit version, Vista, or XP, <system drive>:\Program Files
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Accessories
Furnished accessories and the available accessories for Keysight B1506A are listed 
in Tables 1-1 and 1-2.

Table 1-1 Furnished Accessories

Description Quantity

System cable 1

CMU cable 1

Digital I/O cable 1

Blank silicon plate 1

3-pin inline package socket module 1

Curve tracer test adapter socket module 1

Gate charge socket adapter, for the B1506A-H21/H51/H71 1

Universal socket module kit, for the B1506A-H21/H51/H71 1

Thermocouple (high temperature resistant, 75 cm) 2

Connection wire with mini alligator clip, 200 mm 8

Connection wire with mini alligator clip, 300 mm 6

High current connection wire, 200 mm 2

High current connection wire, 300 mm 2

Clip for high current connection wire, large alligator 4

Banana pin adapter for connection wire 18

Spare clip, mini alligator 14

USB keyboard 1
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Table 1-2 Available Accessories

USB mouse 1

Stylus pen 1

Power cord 2

Model 
Number Option Item Description 

16444A Accessories for B1500 series

16444A-001 USB keyboard

16444A-002 USB mouse

16444A-003 Stylus pen

16493G Digital I/O connection cable

16493G-001 1.5 m length

16493G-002 3 m length

N1300A CMU connection cable

N1300A-001 1.5 m length

N1300A-002 3 m length

N1254A N1254A-524 500 A Ultra High Current Prober System Cable

Description Quantity
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Options
Options available for Keysight B1506A are listed in Table 1-3.

Table 1-3 Options

Option Item Description 

Power Device Analyzer for Circuit Design

B1506A-H20 20 A/3 kV/Thermal Fixture Package

B1506A-H50 500 A/3 kV/Thermal Fixture Package

B1506A-H70 1500 A/3 kV/Thermal Fixture Package

B1506A-H21 20 A/3 kV/C-V/Gate Charge/Thermal Fixture Package

B1506A-H51 500 A/3 kV/C-V/Gate Charge/Thermal Fixture Package

B1506A-H71 1500 A/3 kV/C-V/Gate Charge/Thermal Fixture Package

Thermal enclosure

B1506A-T01 Thermal Test Enclosure (Thermostream Compatible)

Calibration

B1506A-A6J ANSI Z540-1-1994 Calibration

B1506A-UK6 Commercial calibration certificate with test data



1-26 B1506A User’s Guide, Edition 7

Introduction
Measurement Resources

Measurement Resources
Keysight B1506A can be equipped with the following measurement resources. 
Available resources depend on the package (option).

• “GNDU - Ground Unit”

• “MPSMU - Medium Power SMU”

• “HVSMU - High Voltage SMU”

• “MCSMU - Medium Current SMU”

• “HCSMU - High Current SMU”

• “UHCU - Ultra High Current Unit”

• “MFCMU - Multi Frequency CMU”

See Keysight EasyEXPERT User’s Guide for the functions available for the 
EasyEXPERT software. See Programming Guide for the functions available for the 
GPIB remote mode.

GNDU - Ground Unit
The ground unit (GNDU) is a 0 V constant voltage source, and used for the 
reference of measurement ground. Also the GNDU can sink up to ±4.2 A, so it is 
effective for using MPSMU or HVSMU. When the HCSMU, MCSMU, or UHCU is 
used, the GNDU must be connected to the Low terminal side to apply the reference 
zero voltage. Figure 1-1 is a simplified circuit diagram of GNDU.

Figure 1-1 Simplified GNDU Circuit Diagram 

GNDU
0 V

Force

Common
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About SMU
Source/monitor unit (SMU) can apply DC voltage or current, and can measure DC 
current or voltage. Figure 1-2 is a simplified SMU circuit diagram. 

The MPSMU can perform the following operations:

• Apply voltage and measures current or voltage

• Apply current and measures current or voltage

The HCSMU, MCSMU, and HVSMU can perform the following operations:

• Apply voltage and measures current and/or voltage

• Apply current and measures current and/or voltage

NOTE To select the SMU operation mode in the GPIB remote condition, enter the CMM 
command.

Figure 1-2 Simplified SMU Circuit Diagram

Compliance
The SMU has a compliance feature that limits output voltage or current to prevent 
damage to the device under test. When the SMU applies voltage, you can specify 
current compliance. When the SMU applies current, you can specify voltage 
compliance. For details on the compliance, see Keysight EasyEXPERT User’s 
Guide.

SMU
Force

Common

V

A

+
-

+ -
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MPSMU - Medium Power SMU
This section describes typical specification of the medium power source/monitor 
unit (MPSMU).

• Maximum voltage, current, output power: ± 100 V, ± 100 mA, 2 W

• Minimum range: 0.5 V, 1 nA

• Output/measurement value and resolution: see Table 1-4 to Table 1-7.

Figure 1-3 MPSMU Output and Measurement Ranges 

100 100

4040 2020

100

50

20

50

20

100

Voltage (V)

Current (mA)

-
- -

-

-

-



B1506A User’s Guide, Edition 7 1-29

Introduction
Measurement Resources

Table 1-4 MPSMU Output Voltage Ranges and Resolutions 

Table 1-5 MPSMU Output Current Ranges and Resolutions 

Range Output Value Setting 
Resolution 

Maximum 
Current

0.5 V 0   |V|   0.5 V 25 V ± 100 mA

2 V 0   |V|  2 V 100 V ± 100 mA

5 V 0  |V|   5 V 250 V ± 100 mA

20 V 0  |V|   20 V 1 mV ± 100 mA

40 V 0  |V|  20 V 2 mV ± 100 mA

20 V < |V|    40 V 2 mV ± 50 mA

100 V 0  |V|  20 V 5 mV ± 100 mA

20 V <  |V|   40 V 5 mV ± 50 mA

40 V  <  |V|   100 V 5 mV ± 20 mA

Range Output Value Setting 
Resolution 

Maximum 
Voltage

1 nA 0    |I|    1.15 nA 50 fA ± 100 V

10 nA 0   |I|   11.5 nA 500 fA ± 100 V

100 nA 0   |I|   115 nA 5 pA ± 100 V

1 A 0   |I|    1.15 A 50 pA ± 100 V

10 A 0    |I|   11.5 A 500 pA ± 100 V

100 A 0  |I|   115 A 5 nA ± 100 V

1 mA 0  |I|  1.15 mA 50 nA ± 100 V

10 mA 0  |I|   11.5 mA 500 nA ± 100 V

100 mA 0   |I|  20 mA 5 A ± 100 V

20 mA <  |I|    50 mA 5 A ± 40 V

50 mA  <  |I|  100 mA 5 A ± 20 V
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Table 1-6 MPSMU Measurement Voltage Values and Resolutions 

Table 1-7 MPSMU Measurement Current Values and Resolutions 

Range 
Measurement 

Value a
Measurement Resolutions

High Speed ADC High Resolution ADC

0.5 V 0   |V|   0.55 V 25 V 0.5 V

2 V 0   |V|  2.2 V 100 V 2 V

5 V 0   |V|   5.5 V 250 V 5 V

20 V 0   |V|  22 V 1 mV 20 V

40 V 0  |V|   44 V 2 mV 40 V

100 V 0   |V|  100 V 5 mV 100 V

Range 
Measurement 

Value a 

a. This column is applied to the auto ranging or the limited auto ranging. 
For fixed ranging, maximum measurement value is Range column value.

Measurement Resolutions

High Speed ADC High Resolution ADC

1 nA 0  |I|   1.15 nA 50 fA 10 fA

10 nA 0  |I|   11.5 nA 500 fA 10 fA

100 nA 0   |I|   115 nA 5 pA 100 fA

1 A 0   |I|   1.15 A 50 pA 1 pA

10 A 0   |I|   11.5 A 500 pA 10 pA

100 A 0   |I|   115 A 5 nA 100 pA

1 mA 0   |I|   1.15 mA 50 nA 1 nA

10 mA 0   |I|   11.5 mA 500 nA 10 nA

100 mA 0   |I|   100 mA 5 A 100 nA
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HVSMU - High Voltage SMU
This section describes typical specification of the high voltage source/monitor unit 
(HVSMU).

• Maximum voltage/current: 3000 V/4 mA, -3000 V/-4 mA, 1500 V/8 mA, or 
-1500 V/-8 mA

• Maximum output power: 12 W

• Minimum range: 200 V, 1 nA

• Output/measurement value and resolution: see Table 1-8 and Table 1-9.

CAUTION Never connect the HVSMU Force and Guard terminals to any output, including 
circuit common, chassis ground, or any other measurement resource such as SMU. 
Connecting other measurement resource may damage the connected one.

Figure 1-4 HVSMU Output and Measurement Ranges 
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Table 1-8 HVSMU Voltage Ranges and Resolutions 

Table 1-9 HVSMU Current Ranges and Resolutions 

Range Output Value and 
Measurement Value

Setting/ 
Measurement 

Resolution 

Maximum Current 
|Imax|

200 V 0   |V|    200 V 200 V 8 mA

500 V 0   |V|    500 V 500 V 8 mA

1500 V 0   |V|   1500 V 1.5 mV 8 mA

3000 V 0   |V|   3000 V 3 mV 4 mA

Range Output Value and 
Measurement Value 

Setting/ 
Measurement 

Resolution 

Maximum Voltage 
|Vmax|

1 nAa

a. DC only

0   |I|   1.15 nA 10 fA 3000 V

10 nA 0   |I|   11.5 nA 100 fA 3000 V

100 nA 0   |I|   115 nA 100 fA 3000 V

1 A 0   |I|   1.15 A 1 pA 3000 V

10 A 0   |I|   11.5 A 10 pA 3000 V

100 A 0   |I|   115 A 100 pA 3000 V

1 mA 0  |I|   1.15 mA 1 nA 3000 V

10 mA 0   |I|   8 mA 10 nA 1500 V

0   |I|   4 mA 3000 V
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MCSMU - Medium Current SMU
This section describes typical specification of the medium current source/monitor 
unit (MCSMU).

• Maximum current: ± 1 A (pulse), ± 0.1 A (DC)

• Maximum voltage: ± 30 V

• Maximum output power: 30 W (pulse), 3 W (DC)

• Minimum range: 0.2 V, 10 A

• Minimum pulse width: 10 s

• Output/measurement value and resolution: see Table 1-10 and Table 1-11.

Figure 1-5 MCSMU Output and Measurement Ranges
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Table 1-10 MCSMU Voltage Ranges and Resolutions

Table 1-11 MCSMU Current Ranges and Resolutions 

Range Output Value and 
Measurement Value

Setting/ 
Measurement 

Resolution 

Maximum 
Current

Maximum 
Pulse Base 

Value 

0.2 V 0   |V|    0.2 V 200 nV 100 mA, 1 A a

a. For pulse.

± 0.2 V

2 V 0   |V|    2 V 2 V ± 2 V

20 V 0   |V|   20 V 20 V ± 20 V

40 V 0   |V|   30 V 40 V ± 30 V

Range Output Value and 
Measurement Value

Setting/ 
Measurement 

Resolution 

Maximum 
Voltage

Maximum 
Pulse Base 

Value 

10 A 0   |I|   11.5 A 10 pA ± 30 V ± 10 A

100 A 0   |I|   115 A 100 pA ± 100 A

1 mA 0  |I|   1.15 mA 1 nA ± 1 mA

10 mA 0   |I|   11.5 mA 10 nA ± 10 mA

100 mA 0   |I|   100 mA, 
0   |I|   115 mA a

a. For pulse.

100 nA ± 100 mA

1 A b

b. For pulse. Maximum pulse width and duty cycle are 100 ms and 5 % 
respectively.

0   |I|   1 A 1 A ± 50 mA
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HCSMU - High Current SMU
This section describes typical specification of the high current source/monitor unit 
(HCSMU). The HCSMU is available for the B1506A-H21. 

• Maximum current: ± 20 A (pulse), ± 1 A (DC)

• Maximum voltage: ± 40 V, ± 20 V only for the pulse over ± 1 A

• Maximum output power: 40 W

• Minimum range: 0.2 V, 10 A

• Minimum pulse width: 50 s

• Output/measurement value and resolution: see Table 1-12 and Table 1-13.

NOTE Do not put any conductor on the HCSMU Low Force and Low Sense terminals, 
outer conductor of the coaxial connectors. Putting conductor of circuit common, 
chassis ground, or any potential on causes the measurement error.

Figure 1-6 HCSMU Output and Measurement Ranges
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Table 1-12 HCSMU Voltage Ranges and Resolutions

Table 1-13 HCSMU Current Ranges and Resolutions 

Range Output Value and 
Measurement Value 

Setting/Measurement 
Resolution 

Maximum 
Current

Maximum Pulse 
Base Value 

0.2 V 0   |V|    0.2 V 200 nV ± 20 A / ± 40 A ± 0.2 V

2 V 0   |V|    2 V 2 V ± 20 A / ± 40 A ± 2 V

20 V 0   |V|   20 V 20 V ± 20 A / ± 40 A ± 20 V

40 V 0   |V|   40 V 40 V ± 1 A / ± 2 A ± 40 V

Range Output Value and 
Measurement Value 

Setting/Measurement 
Resolution 

Maximum 
Voltage

Maximum Pulse 
Base Value

10 A 0   |I|   11.5 A 10 pA ± 40 V ± 10 A

100 A 0   |I|   115 A 100 pA ± 40 V ± 100 A

1 mA 0  |I|   1.15 mA 1 nA ± 40 V ± 1 mA

10 mA 0   |I|   11.5 mA 10 nA ± 40 V ± 10 mA

100 mA 0   |I|   115 mA 100 nA ± 40 V ± 100 mA

1 A 0   |I|   1.15 Aa

a. Maximum value is 1 A for DC output or measurement.

1 A ± 40 V ± 1 A

20 A 0   |I|   20 A 20 A ± 20 V ± 100 mA
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UHCU - Ultra High Current Unit
This section describes typical specification of the ultra high current unit (UHCU). 
The UHCU is available for the B1506A-H51/H71.

• Output: voltage pulse or current pulse

• Measurement: current or voltage

• Maximum current: ± 500 A (B1506A-H51) or ± 1500 A (B1506A-H71)

• Maximum voltage: ± 60 V

• Maximum power: 7.5 kW for 500 A range, or 22.5 kW for 2000 A range

• Minimum pulse width: 10 s

• Maximum pulse duty: 0.4 % for 500 A range, or 0.1 % for 2000 A range

• Output/measurement value and resolution: see Table 1-14 and Table 1-15.

Figure 1-7 UHCU Output and Measurement Ranges 
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Table 1-14 UHCU Voltage Ranges and Resolutions 

Table 1-15 UHCU Current Ranges and Resolutions 

Range Output Value Measurement 
Value 

Setting 
Resolution 

Measurement 
Resolution 

Maximum 
Current

100 V 0   |V|   60 V a

a. Pulse base value is always 0 V.

0   |V|   60 V 200 V 100 V ± 500 A, 
± 1500 A b

b. Only for the B1506A-H71. 

Range Output Value Measurement 
Value 

Setting 
Resolution 

Measurement 
Resolution 

Maximum 
Voltage

500 A 0   |I|   500 A a

a. Pulse base value is always 0 A.

0   |I|   500 A 1 mA 500 A ± 63 V b

b. This is the maximum voltage compliance value. 

2000 A c

c. Only for the B1506A-H71. Pulse base value is always 0 A.

0   |I|   1500 A 0   |I|   1500 A 4 mA 2 mA
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MFCMU - Multi Frequency CMU
This section describes typical specification of the multi frequency capacitance 
measurement unit (CMU). The CMU performs the impedance measurement and 
returns the specified measurement data such as Cp-G.

• Measurement parameters: See Table 1-16.

• AC signal, output frequency:

1 kHz to 5 MHz

Setting resolution: 1 mHz (1 kHz to), 10 mHz (10 kHz to), 0.1 Hz (100 kHz to), 
or 1 Hz (1 MHz to 5 MHz)

• AC signal, output level:

10 mVrms to 250 mVrms, 1 mV resolution

• DC bias:

0 to ± 25 V, using MFCMU internal DC bias

0 to ± 3000 V, using HVSMU and high voltage bias-tee

• Measurement range:

For the fixed ranging mode, measurement range (impedance range) must be 
specified to perform measurement. Table 1-17 shows the available measurement 
ranges and the corresponding impedance value. And Figure 1-8 shows the 
calculation example of the impedance vs frequency characteristics of a 
capacitive load. Use these information to decide the measurement range.

Impedance Z is calculated by the following formula.

Z = 1 / (2 f C)

where f is frequency (Hz) and C is capacitance (F).
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Table 1-16 Measurement Parameters

Primary Parameter Secondary Parameter

R (resistance, ) X (reactance, )

G (conductance, S) B (susceptance, S)

Z (impedance, )  (phase, radian)

Z (impedance, )  (phase, degree)

Y (admittance, S)  (phase, radian)

Y (admittance, S)  (phase, degree)

Cp (parallel capacitance, F) G (conductance, S)

Cp (parallel capacitance, F) D (dissipation factor)

Cp (parallel capacitance, F) Q (quality factor)

Cp (parallel capacitance, F) Rp (parallel resistance, )

Cs (series capacitance, F) Rs (series resistance, )

Cs (series capacitance, F) D (dissipation factor)

Cs (series capacitance, F) Q (quality factor)

Lp (parallel inductance, H) G (conductance, S)

Lp (parallel inductance, H) D (dissipation factor)

Lp (parallel inductance, H) Q (quality factor)

Lp (parallel inductance, H) Rp (parallel resistance, )

Ls (series inductance, H) Rs (series resistance, )

Ls (series inductance, H) D (dissipation factor)

Ls (series inductance, H) Q (quality factor)



B1506A User’s Guide, Edition 7 1-41

Introduction
Measurement Resources

Table 1-17 Measurement Range for Fixed Ranging Mode

Figure 1-8 Impedance vs Frequency Characteristics of Capacitive Load, Calculation 
Example

Impedance Z
Measurement range (impedance range)

1 kHz  f  200 kHz 200 kHz < f  2 MHz 2 MHz < f  5 MHz

0   Z < 100  50  50  50 
100   Z < 300  100  100  100 
300   Z < 1 k 300  300  300 
1 k  Z < 3 k 1 k 1 k 1 k

3 k  Z < 10 k 3 k 3 k 3 k
10 k  Z < 30 k 10 k 10 k
30 k  Z < 100 k 30 k 30 k
100 k  Z < 300 k 100 k

300 k  Z 300 k
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This chapter describes how to install Keysight B1506A.

• “Requirements”

• “Inspection and Installation”

• “Connecting Accessories”

• “Maintenance”

• “Before Shipping to Service Center”

WARNING To avoid electrical shock and instrument damage, turn the all instruments off 
before connecting or disconnecting measurement cable.

Mettez la machine hors tension pour fixer le connecteur ou pour retirer le 
connecteur de l’unité centrale.

WARNING The mainframe and the test fixture are heavy and require a two person lift.

Le châssis principale et l'équipement de test sont lourds et nécessitent un levage 
par deux personnes.

CAUTION Do not grab the fixture cover when lifting the test fixture.
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WARNING There are potentially hazardous voltages (± 3000 Vdc for HVSMU and ± 100 
Vdc for MPSMU) present at the High, Force, Guard, and Sense terminals of 
the instruments. To prevent electrical shock, the following safety precautions 
must be observed during the use of instruments.

• Connect the instrument to an electrical ground (safety ground) by using 
three-conductor AC power cord.

• Connect the mainframe Interlock terminal to the test fixture Interlock 
terminal by using an interlock cable.

• Confirm periodically that the interlock function works normally.

• Before touching the connections on the High, Force, Guard, and Sense 
terminals in the test fixture or the shielding box, turn the instruments off 
and discharge any capacitors. If you do not turn the instruments off, 
complete all of the following items, regardless of the instrument settings.

• Press the front panel Stop key to set the source output off. 

• Confirm that the front panel High Voltage indicator is not lit.

• Open the Interlock terminal (open the fixture cover or the shielding box 
access door).

• Discharge any capacitors connected to a measurement resource.

• Warn persons working around the instruments about dangerous 
conditions.
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Requirements 
This section describes the requirements for the environment this instrument is used.

• “Power Requirements”
• “Operating Environment”
• “Storaging/Shipping Environment”
• “Installation Requirements”
• “Power Cord”

Power Requirements 
This instrument can operate from any single-phase AC power source supplying 100/ 
240 V (±10 %) at 50/60 Hz. The maximum power consumption is shown below.

• Mainframe: 900 VA

• Test fixture of B1506A-H20/H21: 130 VA

• Test fixture of B1506A-H50/H51/H70/H71: 470 VA

Operating Environment 
This instrument must be operated within the following environmental conditions:

Temperature: +5 C to +40 C, +5 C to +30 C if Thermal plate is used, or 
+20 C to +30 C if Thermostream is used

Humidity: 20 % to 70 % RH or 20 % to 50 % RH if the Thermostream 
setting temperature is +20 C or below. No condensation.

Altitude: 0 to 2,000 m (6,561 ft.)

Storaging/Shipping Environment 
This instrument must be stored/shipped within the following environmental 
conditions:

Temperature: -20 C to +60 C

Humidity: 10 % to 90 % RH, no condensation

Altitude: 0 to 4,600 m (15,092 ft.)
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Installation Requirements

WARNING Do not operate the instrument in dusty environment, or in the presence of 
flammable gases, corrosive gases, or fumes.

Ne pas utiliser l’appareil dans un endroit poussiéreux, ou en présence de gaz 
inflammables, corrosifs ou de fumée.

• Environmental conditions for this instrument are documented in the previous 
page. In principle, this instrument should only be operated indoors in a 
controlled environment.

• Install the instrument horizontal place then face the roof up.

• The dimensions of this instrument are shown below. Fan cools the instrument by 
drawing air through the sides and exhausting it out the back. The instrument 
must be installed in a location that allows sufficient space at the sides and back 
of the instrument for adequate air circulation.

• Mainframe: 420 mm (W)  575 mm (D)  330 mm (H)

• Test fixture: 420 mm (W)  575 mm (D)  360 mm (H)

If the airflow is restricted, the internal operating temperature will be higher. This 
may reduce the instrument’s reliability, or cause the thermal-protection circuits 
to turn the instrument off.

• Make sure that there is enough space for connecting/disconnecting the power 
cord easily.
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Power Cord

WARNING FIRE HAZARD: Use only the power cord supplied with your instrument. 
Using other types of power cord may cause overheating of the power cord, 
resulting in fire.

SHOCK HAZARD: The power cord provides the chassis ground through a 
third conductor. Be sure to connect to a three-conductor type power outlet with 
the correct pin grounded.

RISQUE D’INCENDIE : utilisez uniquement le câble d'alimentation fourni 
avec votre appareil. L’utilisation d’autres types de câble d’alimentation peut 
provoquer une surchauffe du câble d’alimentation et provoquer un incendie.

RISQUE DE CHOC ÉLECTRIQUE: le câble d’alimentation fournit la masse 
du châssis par le biais d’un troisième conducteur. Assurez-vous de connecter la 
prise d'alimentation de type trois conducteurs avec la broche correcte mise à la 
terre.

NOTE The detachable power cord may be used as an emergency disconnecting device. 
Removing the power cord will disconnect AC input power to the instrument.

Connect the power cord to the IEC 320 connector on the rear of the instrument. If 
the wrong power cord was shipped with your instrument, contact your nearest 
Keysight Sales and Support Office.

The AC input on the back of your instrument is a universal AC input. It accepts 
nominal line voltages in the range of 100 to 240 VAC.
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Inspection and Installation
Do the following when this instrument arrived.

• “To Inspect Shipment”

• “To Perform Initial Setup”

• “To Connect Test Fixture”

• “To Check Operation of Test Fixture”

Do the following setup if you need.

• “To Change Windows Logon Setting”

• “To Change GPIB Address”

• “To Enable System Controller”

To Inspect Shipment
1. Before unpacking any components, inspect all boxes for any signs of damage 

that might have occurred during shipment, such as:

• dents

• scratches

• cuts

• water marks

If you suspect any damage, contact Keysight Technologies.

2. When you open the boxes that contain the instrument and accessories, check the 
components against the contents lists attached to the boxes.

If anything is missing, contact Keysight Technologies.

After the inspection, move the instrument and accessories to the installation site. For 
the requirements for the installation site, see “Requirements” on page 2-4.
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To Perform Initial Setup
1. Place the mainframe at the installation site.

2. Make sure that the Standby switch is set to off.

3. On the rear panel, connect the Circuit Common terminal to the frame ground 
terminal by using a shorting-bar.

4. If you use the furnished USB keyboard and/or USB mouse, connect it to an USB 
port of the mainframe.

5. Connect the power cord from the mainframe to an AC power outlet.

6. Open the measurement terminals and press the Standby switch to turn on the 
mainframe. 

If the mainframe is operating correctly, the power-on self-test is automatically 
performed. If problems arise, contact Keysight Technologies.

7. Perform the initial Windows setup. The setup method may vary depending on 
the manufacturing period.

a. If the Windows Setup Wizard appears:

Follow the on-screen instructions to complete the setup.

• Set the system display language to English. The language must be 
English.

• If you use the 16444A-001 USB keyboard, the keyboard layout must be 
US.

• Accept the End User License Agreement (EULA) when prompted during 
setup.

b. If the Windows Setup Wizard does not appear and Windows starts 
automatically:

Accept the End User License Agreement (EULA) when it is displayed after 
startup.

If the mainframe has been already connected to your site LAN, you can proceed the 
network connection setup. If you connect the mainframe to the network, take care to 
protect it from computer virus.
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NOTE Other Windows setups

You can configure other Windows settings after the initial setup. This is your 
responsibility. 

Users listed in Table 2-1 are available just after the initial setup. 

You can add users after the initial setup. Add users as you need.

Table 2-1 Users Available Just After the Initial Setup

User Account Description

Keysight B1500 User Account for automatic logon. Password is not set or 
Keysight4u!, depending on the manufacturing period. 
Set or change the password to something more secure 
(and less well-known). 

KeysightOnly Account for Keysight service personnel. Do not delete 
this account. This account is password protected.

Administrator Administrator. Password is not set or Keysight4u!, 
depending on the manufacturing period. Set or change 
the password to something more secure (and less 
well-known). 
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To Connect Test Fixture

WARNING To avoid electrical shock and instrument damage, turn the all instruments off 
before connecting or disconnecting measurement cable.

Mettez la machine hors tension pour fixer le connecteur ou pour retirer le 
connecteur de l’unité centrale.

Connect the system cables between the mainframe and the test fixture as shown in 
Figure 2-1. Also see one of Tables 2-2 to 2-5 associated with your B1506A.

1. Connect the Digital I/O cable.

2. Only for the B1506A-H21/H51/H71, connect the CMU cable.

3. Connect the System cable in order of the label number.

Figure 2-1 B1506A Rear View

System cableCMU cable

Digital I/O cable
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Table 2-2 B1506A-H20 System Cable Connections 

Test Fixture Label of Cable Mainframe

Digital I/O Cable

Digital I/O none none Digital I/O

System Cable

MPSMU 
SMU1

Force (1F) 1F 1F Force SMU1

Sense (1S) 1S 1S Sense

Gate 
Control 
SMU2

Force (2F) 2F 2F Force SMU2

Sense (2S) 2S 2S Sense

HCSMU 
SMU3

Force (3F) 3F 3F Force SMU3

Sense (3S) 3S 3S Sense

HVSMU 
SMU4

Force (4F) 4F 4F Force SMU4

GNDU GNDU GNDU GNDU

Interlock none none Interlock
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Table 2-3 B1506A-H21 System Cable Connections 

Test Fixture Label of Cable Mainframe

Digital I/O Cable

Digital I/O none none Digital I/O

CMU Cable

MFCMU Lcur (LC) LC Lcur MFCMU

Lpot (LP) LP Lpot

Hcur (HC) HC Hcur

Hpot (HP) HP Hpot

System Cable

MPSMU 
SMU1

Force (1F) 1F 1F Force SMU1

Sense (1S) 1S 1S Sense

Gate 
Control 
SMU2

Force (2F) 2F 2F Force SMU2

Sense (2S) 2S 2S Sense

AUX 
SMU3

Force (3F) 3F 3F Force SMU3

Sense (3S) 3S 3S Sense

HCSMU 
SMU4

Force (4F) 4F 4F Force SMU4

Sense (4S) 4S 4S Sense

HVSMU 
SMU5

Force (5F) 5F 5F Force SMU5

GNDU GNDU GNDU GNDU

Interlock none none Interlock
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Table 2-4 B1506A-H50/H70 System Cable Connections 

Test Fixture Label of Cable Mainframe

Digital I/O Cable

Digital I/O none none Digital I/O

System Cable

MPSMU 
SMU1

Force (1F) 1F 1F Force SMU1

Sense (1S) 1S 1S Sense

Gate 
Control 
SMU2

Force (2F) 2F 2F Force SMU2

Sense (2S) 2S 2S Sense

V Control 
SMU3

Force (3F) 3F 3F Force SMU3

Sense (3S) 3S 3S Sense

I Control 
SMU4

Force (4F) 4F 4F Force SMU4

Sense (4S) 4S 4S Sense

HVSMU 
SMU5

Force (5F) 5F 5F Force SMU5

GNDU GNDU GNDU GNDU

Interlock none none Interlock
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Table 2-5 B1506A-H51/H71 System Cable Connections 

Test Fixture Label of Cable Mainframe

Digital I/O Cable

Digital I/O none none Digital I/O

CMU Cable

MFCMU Lcur (LC) LC Lcur MFCMU

Lpot (LP) LP Lpot

Hcur (HC) HC Hcur

Hpot (HP) HP Hpot

System Cable

MPSMU 
SMU1

Force (1F) 1F 1F Force SMU1

Sense (1S) 1S 1S Sense

Gate 
Control 
SMU2

Force (2F) 2F 2F Force SMU2

Sense (2S) 2S 2S Sense

AUX 
SMU3

Force (3F) 3F 3F Force SMU3

Sense (3S) 3S 3S Sense

V Control 
SMU4

Force (4F) 4F 4F Force SMU4

Sense (4S) 4S 4S Sense

I Control 
SMU5

Force (5F) 5F 5F Force SMU5

Sense (5S) 5S 5S Sense

HVSMU 
SMU6

Force (6F) 6F 6F Force SMU6

GNDU GNDU GNDU GNDU

Interlock none none Interlock
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To Check Operation of Test Fixture
After completing the cable connections described in “To Connect Test Fixture” on 
page 2-10, perform the following procedure.

1. Open the measurement terminals of the test fixture and close the fixture cover.

2. Connect the power cord from the test fixture to an AC power outlet.

3. Connect the power cord from the mainframe to an AC power outlet.

4. Set the test fixture power switch to the ON position.

5. Press the mainframe Standby switch and wait for the Easy Test Navigator 
software palette to arise.

6. Launch the I/V Measurement software.

7. Click the Configuration > Module menu to display the Module Configuration 
dialog box.

8. Use the Module Configuration dialog box and perform diagnosis of the test 
fixture. If problems arise, contact Keysight Technologies.

To Change Windows Logon Setting
Windows automatic logon has been enabled initially. If you want to change this 
setting, select All Programs > Control Auto Logon from the Start menu. Control 
Auto Logon is displayed on the browser. Then click one of the following buttons on 
the browser and follow the setup script.

• Enable Auto Logon

• Disable Auto Logon

NOTE If you set a password for the user account Keysight B1500 User, disable the 
automatic logon.
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To Change GPIB Address
When this instrument is shipped from the factory, the GPIB address is set to 17. To 
change the GPIB address, perform the following procedure.

1. If the Easy Test Navigator software is running, terminate it by clicking on the 
Exit button which appears by pointing the upper right corner of the software 
palette.

2. If the EasyEXPERT software is running, terminate it as shown below:

a. Select the menu function File > Exit on the EasyEXPERT main screen.

b. Click [x] at the upper right corner of the Start EasyEXPERT button.

3. Select All Programs > Keysight IO Libraries Suite > Keysight Connection 
Expert from the Start menu. Keysight Connection Expert window appears.

4. At the Instrument I/O on this PC area, select GPIB0, and click the Change 
Properties... button. Keysight 82350 PCI GPIB Interface - GPIB0 window 
appears.

5. Change the GPIB Address value.

6. Remove the check from the Auto-discover instruments connected to this 
interface box.

7. Click the OK button on Keysight 82350 PCI GPIB Interface - GPIB0 window.

8. On the Reboot Required dialog box, click the Reboot Now button, and reboot 
the mainframe.

NOTE For the GPIB connection of this instrument, use an GPIB interface, Keysight 
82350B/C (for PCI bus), Keysight 82351A/B (for PCIe bus), Keysight 82357A/B 
(USB/GPIB), or National Instrument GPIB-USB-HS.

For using an USB/GPIB interface, it is recommended to set the GPIB address of this 
instrument to an even number. The USB/GPIB interface might cause serial poll error 
intermittently due to the intrinsic communication scheme differences. It is reported 
that using an even GPIB address sometimes significantly decreases the chance of 
the error. 
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To Enable System Controller
To allow this instrument to control external GPIB devices, perform the following 
procedure. After the procedure, you cannot control the instrument from an external 
computer. 

1. If the Easy Test Navigator software is running, terminate it by clicking on the 
Exit button which appears by pointing the upper right corner of the software 
palette.

2. If the EasyEXPERT software is running, terminate it as shown below:

a. Select the menu function File > Exit on the EasyEXPERT main screen.

b. Click [x] at the upper right corner of the Start EasyEXPERT button.

3. Select All Programs > Keysight IO Libraries Suite > Keysight Connection 
Expert from the Start menu. Keysight Connection Expert window appears.

4. At the Instrument I/O on this PC area, select GPIB0, and click the Change 
Properties... button. Keysight 82350 PCI GPIB Interface - GPIB0 window 
appears.

5. Set the GPIB Address value to 21 that is the typical address number for the 
system controller.

6. Check the System Controller box.

7. Remove the check from the Auto-discover instruments connected to this 
interface box.

This disables the automatic device detection. So the Connection Expert cannot 
detect the instruments connected to the GPIB interface by itself.

8. Click the OK button on Keysight 82350 PCI GPIB Interface - GPIB0 window.

9. On the Reboot Required dialog box, click the Reboot Now button, and reboot 
the mainframe.

NOTE To Disable System Controller

To disable the system controller, change the steps 5 and 6 for setting the GPIB 
Address value to not 21 and removing the check from the System Controller box, 
and perform the procedure to the step 9.
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Connecting Accessories
The test fixture is used to connect your device under test (DUT). The B1506A is 
furnished with the following accessories.

• “3-pin Inline Package Socket Module”

• “Curve Tracer Test Adapter Socket Module”

• “Universal Socket Module Kit”

• “Gate Charge Socket Adapter”

• “Accessories for Connecting a DUT”

• “Prober System Cable”

• “Thermocouple”

Also, the following equipment can be used with the B1506A for controlling 
temperature of DUT. Contact inTEST Corporation for the equipment.

• “Thermal Plate”

• “Thermostream”

WARNING Set the instrument output off before connecting or disconnecting connection 
wire.

Press the mainframe front panel Stop key to set the source output off. And 
confirm that the mainframe front panel High Voltage indicator is not lit.

WARNING To prevent electrical shock and DUT damage, do not connect or disconnect the 
DUT while the instrument is applying voltage or current.

When you touch the DUT after measurement, devise a countermeasure of 
residual charge and heat to prevent electrical shock and burn. Use glove and 
any tool. Also have enough time for discharge and radiation.

Pour éviter toute électrocution et tout risque d'endommagement de l'appareil, 
ne retirez pas les câbles pendant le fonctionnement.

Lorsque vous touchez le MST après la mesure, élaborez une contre-mesure de 
la charge résiduelle et du chauffage afin d'éviter tout choc électrique et toute 
brûlure. Utilisez des gants et des outils. Prévoyez également du temps pour la 
décharge et la radiation.
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3-pin Inline Package Socket Module
Use the socket module to connect a three-terminal inline packaged device. See the 
following simple instruction.

Requirements • 3-pin inline package socket module

• DUT

Procedure 1. Attach the socket module directly to the Base/Gate, Collector/Drain, and 
Emitter/Source terminals of the test fixture.

2. Set your DUT on the socket.

3. Close the fixture cover and perform measurement.

WARNING Hazardous voltage, instrument maximum output voltage may appear at the 
measurement terminals if the fixture cover is closed.

CAUTION Do not apply voltage/current over the maximum limit of the socket module.

Maximum voltage: 3000 V

Maximum current: 500 A pulse, 39 A dc

CAUTION Use the socket module within the temperature range of 0 C to +100 C.

NOTE Short plate is furnished with the socket module. It is used for performing the short 
correction before the capacitance measurement. Set it on the socket before the short 
correction and remove it after the correction.

Socket module
Test 
fixture

DUT
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Curve Tracer Test Adapter Socket Module
This module provides a socket available for connecting a test adapter designed for 
connecting to Tektronix 370B/371B curve tracers. To use this module, see the 
following simple instruction.

Requirements • Curve tracer test adapter socket module

• DUT and a test adapter for curve tracer

Procedure 1. Attach the socket module directly to the test fixture.

2. Set your test adapter on the socket module.

3. Set your DUT on the test adapter.

4. Close the fixture cover and perform measurement.

WARNING Hazardous voltage, instrument maximum output voltage may appear at the 
measurement terminals if the fixture cover is closed.

CAUTION Do not apply voltage/current over the maximum limit of the socket module.

Maximum voltage: 3000 V

Maximum current for Collector/Drain/Emitter/Source Force: 500 A pulse, 39 A dc

Maximum current for other terminals: 40 A pulse, 2 A dc

CAUTION Use the socket module within the temperature range of +5 C to +40 C.

Collector/Drain Force
Collector/Drain Sense

Emitter/Source Force

Emitter/Source Sense

Base/Gate Force and Sense

Not connected

Socket module

Test fixture
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Universal Socket Module Kit
This is a blank module, kind of a do-it-yourself kit for supporting variety of 
packaged devices. This kit is furnished with the B1506A-H21/H51/H71. The 
contents of this kit are shown in Figure 2-2 and Table 2-6.

You can use this handmade socket module with the same manner as the 3-pin Inline 
Package Socket Module. See “3-pin Inline Package Socket Module”.

Figure 2-2 Universal Socket Module Kit

Table 2-6 Parts of Universal Socket Module Kit

Reference Parts Description Qty.

1 Blank module Base of the socket module 1 ea.

2 Dummy board This is pre-assembled to the blank 
module. You can also make a socket 
board using this board, instead of a new 
blank board.

1 ea.

3 Wire For internal connections 2 m

4 Lug terminal For internal connections 20 ea.

5 Wire for high current For internal connections 2 m

6 Lug terminal for high 
current

For internal connections 6 ea.

1

2

3

4

5

6
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Making the Universal Socket Module

Requirements • T10 Torx screwdriver

• T15 Torx screwdriver

• 9 mm wrench

• Caulking tool for lug terminals, 2.0sq

• Caulking tool for high current lug terminals, 5.5sq

Prepare a socket for your test devices, a blank board, tools for mounting the socket, 
screws and nut for socket terminals, and so on separately.

For the dimensions and screw holes of a blank board, see Figure 2-3.

CAUTION Confirm the allowable temperature range of the blank board and the socket and use 
the socket module within the range.

The allowable temperature range of the dummy board is approximately 0 C to 
+100 C.

Procedure 1. Remove the dummy board from the blank module using a T15 Torx screwdriver.

2. Make a socket board by process a blank board or the dummy board and mount 
your device socket onto the board.

WARNING Make enough space between the socket terminal and the shield/chassis, for 
example, about 1 mm for maximum 200 V output and 6 mm for 3000 V, to 
prevent discharge and any accident.

3. Fix the socket board to the blank module using the screws and tooth washers you 
kept when removing the dummy board.

4. Remove the bottom cover of the blank module using a T10 Torx screwdriver.

5. Assemble cables using the wire and lug terminals.

Cut the appropriate length of the wire, tear off the coating of wire ends, and then 
secure the lug terminals to the wire ends using a caulking tool.

WARNING When the measurement uses higher range than 500A range, use the wire for 
high current and lug terminals for high current for connecting the Force 
terminals of the Collector/Drain and Emitter/Source.

6. Connect one ends of all cables to the inside terminals on the blank module.
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Remove screws and tooth washers from the terminals, and fix the lug terminal of 
the cable end in order of a washer, a lug terminal, a tooth washer, and a screw. 
When fixing the lug terminal, secure a screw by a T15 Torx screwdriver with 
fixing the bottom nut by a 9 mm wrench.

Positions of the wiring side terminals are shown below.

7. Connect the other ends of the cables to the terminals on the back side of the 
socket board.

If a socket terminal does not have a screw or nut for securing a lug terminal of 
the cable, prepare it. Ensure the terminal position of the blank module and the 
socket board, and connect the cables correctly.

8. Fix the bottom cover to the blank module using a T10 Torx screwdriver.

Figure 2-3 Dimensions and Screw Holes of Blank Board

Collector/Drain

High

Base/Gate

Emitter/Source

Low

ForceSense

AUX
ForceSense

High

Low

ForceSense

Chassis

Guard

Blank module wiring side view:

Socket board
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Gate Charge Socket Adapter
This socket adapter is designed for performing the gate charge measurement. The 
adapter supports 3-pin inline package device and other type of device. This socket 
adapter is furnished with the B1506A-H21/H51/H71.

• “Connecting 3-pin Inline Package Device”

• “Connecting Other Type of Device”

CAUTION Use the gate charge socket adapter at ambient temperatures.

Connecting 3-pin Inline Package Device

Requirements • Gate charge socket adapter and Shorting bar (furnished with the adapter)

• DUT (3-pin inline package device)

• Current control device or Load resistor

The current control device must be an extra 3-pin inline package device which is 
expected to have the same characteristics as DUT. If the device is not available, use 
a load resistor. The resistor must satisfy the following specifications.

Resistance = Vr/Ir (Vr: rated voltage, Ir: rated current)

Peak power  Vr  Ir  1 ms

CAUTION Be sure to connect a current control device or a load resistor. If the current control 
device does not work or the load resistor does not satisfy the specification described 
above, the socket adapter may be damaged.

Procedure 1. Attach the socket adapter directly to the Base/Gate, Collector/Drain, 
Emitter/Source, and AUX Force terminals of the test fixture.

1 Gate
2 Collector/Drain
3 Emitter/Source

±3 kV Max

B1506A-F14
Gate Charge Measurement Adapter

Inline Package

External DUT

±3 kV Max

Collector/Drain
Gate

Emitter/Source

SenseForce

Sense Force

To External DUT

Attach shorting bar
for Inline Package.
Remove it for 
External DUT.

Socket for
current
control
device

Studs for
load resistor

Slide switch
(Inline Package position)

Socket for DUT
Shorting bar

Top Side
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2. Attach the shorting bar to the Sense terminals on the side panel.

3. Set the slide switch to the Inline Package position.

4. Set the current control device on the left socket or connect the load resistor 
between the studs for the resistor.

5. Set your DUT on the right socket.

6. Close the fixture cover and perform measurement.

WARNING Hazardous voltage, instrument maximum output voltage may appear at the 
measurement terminals if the fixture cover is closed.

NOTE Open the AUX Sense terminals of the test fixture. Do not connect anything to them.

NOTE Short plate is furnished with the adapter. It is used for performing the short 
correction before the gate charge measurement. Set it on “Socket for DUT” before 
the short correction and remove it after the correction.

Connecting Other Type of Device

Requirements • Gate charge socket adapter

• Blank silicon plate

• Connection wire, clip, adapter, and so on. Use the furnished accessories.

Banana pin to Large alligator clip wire can be assembled by fixing a banana pin 
adapter and a clip to a connection wire using a screw and a nut.

• DUT (other than 3-pin inline package device)

• Current control device or Load resistor

The current control device must be an extra 3-pin inline package device which is 
expected to have the same characteristics as DUT. If the device is not available, use 
a load resistor. The resistor must satisfy the following specifications.

Resistance = Vr/Ir (Vr: rated voltage, Ir: rated current)

Peak power  Vr  Ir  1 ms

CAUTION Be sure to connect a current control device or a load resistor. If the current control 
device does not work or the load resistor does not satisfy the specification described 
above, the socket adapter may be damaged.
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Procedure 1. Set the blank silicon plate on the DUT stage of the test fixture.

2. Attach the socket adapter directly to the Base/Gate, Collector/Drain, 
Emitter/Source, and AUX Force terminals of the test fixture.

3. Remove the shorting bar from the Sense terminals if it is attached.

4. Set the slide switch to the External DUT position.

5. Set the current control device on the left socket or connect the load resistor 
between the studs for the resistor.

6. Put your DUT on the space for the external DUT. The device size should be 
smaller than approximately 170 mm (W)  170 mm (D)  130 mm (H).

7. Connect your DUT to the side panel terminals by using connection wire, clip, 
adapter, and so on.

Force and Sense must be connected together at the terminal of DUT for making 
the Kelvin connection.

8. Close the fixture cover and perform measurement.

1 Gate
2 Collector/Drain
3 Emitter/Source

±3 kV Max

B1506A-F14
Gate Charge Measurement Adapter

Inline Package

External DUT

Socket for
current
control
device

Studs for
load resistor

Slide switch
(External DUT position)

Space for External DUT on the silicon plate:
180 mm x 180 mm

External DUT

Base

Emitter Collector

Low High

External DUT

±3 kV Max

Collector/Drain
Gate

Emitter/Source

SenseForce

Sense Force

To External DUT

Attach shorting bar
for Inline Package.
Remove it for 
External DUT.

Gate Low is internally 
connected to Emitter/Source Sense.

Open
Base

Base

Emitter

Low High

External DUT

Collector

Base Low is internally 
connected to Emitter.
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WARNING Hazardous voltage, instrument maximum output voltage may appear at the 
measurement terminals if the fixture cover is closed.

WARNING Make sure that the cover is closed properly before starting measurement. Do 
not perform the measurement when a wire is protruding from the fixture cover.

Assurez-vous que le couvercle est fermé correctement avant de commencer la 
mesure. Ne pas effectuer la mesure lorsqu’un câble dépasse du couvercle de 
l'appareil.

NOTE Open the AUX Sense terminals of the test fixture. Do not connect anything to them.

NOTE Open/short correction should be performed before the gate charge measurement. 
Open between the Gate/Base terminal and the Emitter/Source terminal for the open 
correction and short them for the short correction at the end of the extension cables.
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Accessories for Connecting a DUT
Use the connection wire, clip, adapter, and so on to connect a device that cannot be 
connected to any socket module or adapter.

In the above picture, the blank silicon plate is set on the DUT stage, and the Thermal 
Plate is placed on the plate and connected to the Thermal Plate connector. Also, the 
thermocouples are connected to the K Thermocouple terminals and put on the places 
to monitor temperature. For the Thermal Plate, contact inTEST Corporation.

Requirements • Blank silicon plate

• Connection wire, clip, adapter, and so on. Use the furnished accessories.

Banana pin to Large alligator clip wire can be assembled by fixing a banana pin 
adapter and a clip to a connection wire using a screw and a nut.

• DUT (other than 3-pin inline package device)

Procedure 1. Set the blank silicon plate on the DUT stage of the test fixture.

2. Put your DUT on the blank silicon plate. The device size should be smaller than 
approximately 330 mm (W)  170 mm (D)  130 mm (H).

3. Connect your DUT to the measurement terminals of the test fixture by using 
connection wire, clip, adapter, and so on.

Force and Sense must be connected together at the terminal of DUT for making 
the Kelvin connection.

Test fixture

Thermocouple

Thermal plate
Blank silicon plate

Cable assembly

DUT

Force

High

Low

High

Low

±100 V Max
GuardSense

Force Sense

±3 kV   Max
Collector/Drain

Emitter/Source

Base/Gate

SenseForce

AUX
±30 V Max

High

Low

±100 V   Max

Base
Base

Emitter

Low High

External DUT

Collector

Base Low is internally 
connected to Emitter.
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4. Close the fixture cover and perform measurement.

WARNING Hazardous voltage, instrument maximum output voltage may appear at the 
measurement terminals if the fixture cover is closed.

WARNING To reduce the leakage current of the extension cable, the Guard terminal may 
be extended as close as possible to the drain or collector terminal of DUT.

Then, open the Guard terminal at the end of the extension cable to avoid 
electrical shock, instrument damage, or DUT damage. Do not connect anything 
to this terminal which has the same potential as the High Force and High Sense.

WARNING Make sure that the cover is closed properly before starting measurement. Do 
not perform the measurement when a wire is protruding from the fixture cover.

Assurez-vous que le couvercle est fermé correctement avant de commencer la 
mesure. Ne pas effectuer la mesure lorsqu’un câble dépasse du couvercle de 
l'appareil.

CAUTION Never connect the High, High Force, High Sense, or Guard terminal to any output, 
including circuit common and chassis ground. Connecting other output may damage 
the connected one.
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Prober System Cable
The N1254A-524 prober system cable is used to extend the measurement terminals 
to a probe station. For connecting this cable to the B1506A, see “Connecting Prober 
System Cable to Test Fixture” on page 2-31. Connection image is shown in Figure 
2-4. Cable length is approximately 1.8 m.

The prober side of this cable is a connector box which provides five connectors. The 
connector box should be installed near DUT interface such as manipulators and 
must be connected to it. For the connection cables to DUT interface, see Table 2-8.

The prober side connector type, maximum voltage, and maximum current of the 
prober system cable are shown in Table 2-7. This cable internally connects Low and 
Low Sense.

CAUTION Do not apply voltage/current over the maximum limit of the cable. 

Figure 2-4 Connection Image using N1254A-524 Prober System Cable

Table 2-7 Prober Side Connector Type and Maximum Voltage/Current of N1254A-524

Connector 
label

Connector 
type

Test fixture measurement 
terminals to extend

Maximum 
voltage

Maximum 
current

High Force Banana(jack) Collector/Drain High Force 3000 V 39 A dc, 
500 A pulse aLow Force Banana(jack) Emitter/Source Low Force 200 V

N1254A-524 Prober System Cable

High Force

Guard

B1506A Test Fixture

Gate

Drain

Source

Co
lle

ct
or

/D
ra

in
Em

itt
er

/S
ou

rc
e

Chassis

Low Force

High Sense
Low Sense

High
Low High Force

Low Force

High Sense

Low Sense

Gate

Ba
se

/G
at

e

DUT
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Table 2-8 Connection Cables to DUT Interface

CAUTION Never connect the High Force and High Sense terminals to any output, including 
circuit common, chassis ground, or any other measurement resource such as SMU. 
Connecting other measurement resource may damage the connected one.

Connecting Prober System Cable to Test Fixture

Requirements • Box wrench, M5 hex

• Clear plastic plate, 2 ea. (furnished with the N1254A-524 prober system cable)

Procedure 1. Turn the all instruments off.

2. Remove power cord from the all instruments.

High Sense HV(jack) Collector/Drain High Sense 3000 V 1 A dc, 
20 A pulseLow Sense BNC(f) Emitter/Source Low Sense 200 V

Base/Gate Low
Gate BNC(f) Base/Gate High 200 V

a. Pulse of 1 ms pulse width and 0.4 % duty cycle

N1254A-524 
connectors Required cables/Description Connect to

Low Force Ultra high current cable with banana(plug). N1254A-523 
can be used.

DUT low 
terminal 

(ex: source)Low Sense Coaxial cable with BNC(m) connector. N1254A-503 can be 
used.

High Force Ultra high current cable with banana(plug). N1254A-523 
can be used.

DUT high 
terminal 

(ex: drain)High Sense Triaxial cable with HV(plug) connector. N1254A-505 can 
be used.

Gate Coaxial cable with BNC(m) connector. N1254A-503 can be 
used.

DUT drive 
terminal 
(ex: gate)

Connector 
label

Connector 
type

Test fixture measurement 
terminals to extend

Maximum 
voltage

Maximum 
current
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3. Open the test fixture cover.

4. Remove connection wire from the test fixture measurement terminals if the wire 
is connected.

5. Remove the clear plastic plate from the test fixture cover. This makes opening 
for passing the cable through. Use the box wrench and unscrew six hex nuts to 
remove the plate.

Treasure the removed plate. It must be replaced in the normal use conditions 
without the N1254A-524 prober system cable.

6. Connect two connector boxes of the prober system cable to the Collector/Drain, 
Emitter/Source, and Base/Gate terminals properly. See Figure 2-4.

7. Pull out the prober side connector box and some long of extension cable 
(approximately 1.5 m) from the opening.

8. Set and fix two clear plastic plates to the fixture cover by using the hex nuts 
removed in the step 5. The plates close the excess opening and make the opening 
enough to pass the cable through.

9. Close the fixture cover.

10. Connect the 16493J interlock cable from the B1506A mainframe to the interlock 
circuit installed in the probe station.

WARNING For using the prober system cable safely

Never connect the interlock cable to the test fixture.

Never leave and use the test fixture in the condition that the clear plastic plates 
are removed from its fixture cover.

Pour utiliser le système de sonde en toute sécurité

Ne jamais connecter le câble de verrouillage au montage d'essai.

Ne jamais ôter les plaques en plastique transparent du couvercle d'appareil.

Thermocouple
Use thermocouple to monitor temperature. The B1506A is furnished with two 
thermocouples. For the setup image, see “Accessories for Connecting a DUT” on 
page 2-28.

1. Connect the thermocouple to the K Thermocouple terminal.

2. Secure the end of the thermocouple to the place for monitoring temperature.
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Thermal Plate
3. The test fixture can be equipped with the Thermal Plate for controlling 

temperature of DUT. For the setup image, see “Accessories for Connecting a 
DUT” on page 2-28.

1. Set the blank silicon plate on the DUT stage of the test fixture.

2. Place the Thermal Plate on the silicon plate.

3. Connect the cable from the Thermal Plate to the Thermal Plate connector on the 
test fixture.

4. Put your DUT on the Thermal Plate. The device size should be smaller than 
approximately 160 mm (W)  160 mm (D)  100 mm (H).

5. Connect your DUT as described in “Accessories for Connecting a DUT” on 
page 2-28. Or see “Connecting Other Type of Device” on page 2-25 for 
performing the gate charge measurement.

6. Set the thermocouple if it is used. See “Thermocouple” on page 2-32.

7. Connect the cable from the temperature controller to the Thermal Plate 
connector on the test fixture rear panel.

8. Close the fixture cover and perform measurement.

For the Thermal Plate, contact inTEST Corporation.

Thermostream
The test fixture can be equipped with the Thermostream for controlling temperature 
of DUT. For the setup image, see the following figure. The B1506A-T01 thermal 
test enclosure is needed to set the Thermostream on the test fixture. 

Fixture cover

Enclosure cover

Thermal test enclosure Test fixture

Left side wire Right side wire

Interlock switch
under the wire head

Interlock switch
under the wire head
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1. If you use the thermocouple, connect it to the K Thermocouple terminal.

2. Face the terminals on the enclosure rear panel to the fixture output terminals, 
and firmly connect them until no gap is shown between them.

3. Unscrew and remove the enclosure cover.

4. Put your DUT in the enclosure. The device size should be smaller than 
approximately 260 mm (W)  180 mm (D)  120 mm (H).

If you use the socket module, attach it directly to the terminals in the enclosure.

5. Refer to “Accessories for Connecting a DUT” on page 2-28 and connect your 
DUT properly. Do not leave the unused test leads inside the enclosure.

If you use the socket module, set your DUT on the socket.

If you use the thermocouple, secure the end of the thermocouple to the place for 
monitoring temperature.

6. Set and fix the enclosure cover by screws so that the openings are not made 
between the enclosure body and the cover especially around the slit labeled 
“Thermocouple”.

If you use the thermocouple, pass it through the slit. If two thermocouples are 
used, adjust them so that they do not overlap together.

7. Set the Thermostream on the enclosure cover.

Adjust the nozzle of the Thermostream so that it fits the cover horizontally and 
so that the openings are not made between them.

Connect the purge air tube from the Thermostream to the Purge air inlet at the 
enclosure side back.

8. Set the left side wire head in the slit of the test fixture interlock switch and ram it 
down.

9. Set the right side wire head in the slit of the test fixture interlock switch and ram 
it down.

10. Leave the fixture cover open and perform measurement.

For the Thermostream, contact inTEST Corporation.

WARNING Activating the Thermostream may cause low or high temperature of -50 °C to 
+250 °C on the enclosure front panel, the cover, and the left and right 
protection panels. To prevent yourself from getting injury, confirm that they 
are in the safe temperature range before touching the enclosure.
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L'activation du flux thermique peut entraîner une basse ou haute température 
de -50 °C à +250 °C sur le panneau de protection avant, le couvercle et les 
panneaux de protection à gauche et à droite. Pour éviter de vous blesser, 
confirmez qu'ils sont dans la plage de température de sécurité avant de toucher 
le boîtier.

WARNING While the enclosure wire heads (To Slit) are rammed down into the slits of the 
test fixture interlock switches, hazardous voltage, instrument maximum output 
voltage may appear at the measurement terminals.

Pendant que les têtes de fil d'enceinte (à fente) sont enfoncés dans les fentes des 
commutateurs d'interverrouillage de mélange d'essai, une tension dangereuse, 
une tension de sortie maximale d'instrument peut apparaître aux bornes de 
mesure.

CAUTION Do not expose the back of the enclosure to the condensation. Wetting the connection 
cables or connectors may cause the instrument damage.

CAUTION If you use the socket module, confirm its allowable temperature range and use it 
within the range.

CAUTION Purge air inlet

To prevent condensation, connect the Thermostream purge air tube here.

Entrée de purge d'air 

Pour empêcher toute formation de condensation, connectez le tube de purge d'air 
Thermostream ici.
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Maintenance
Maintenance should be performed periodically to keep the instrument in good 
condition. 

Cleaning 
Before performing cleaning, turn off the instrument, and disconnect power cord 
from the rear panel. Use a dry cloth to clean the external case parts. 

To prevent electrical shock, do not perform cleaning when the instrument is turned 
on, and do not use a wet cloth.

Self-test and Diagnosis
This instrument provides the following functions to check the operation. Perform 
the following functions as necessary. Open the measurement terminals to perform 
self-test, self-calibration, or diagnosis.

• Self-test

• Self-calibration

• Diagnosis

If problems arise, contact Keysight Technologies.

NOTE Interlock Open/Close test and High Voltage LED test

Interlock function limits the maximum output voltage to ± 42 V when the 
measurement terminal is touchable. For safety, this function must be checked before 
using the instrument after power on at least once a day by performing the diagnosis.

Calibration
Calibration and adjustments must be performed periodically so that the instruments 
satisfy the specifications, and keep a good condition. It is recommended to perform 
the calibration once a year at least. For the calibration and adjustments, contact 
Keysight Technologies. Trained service personnel will perform the calibration and 
adjustments. 
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Before Shipping to Service Center
Before shipping this instrument to service center, you have to do following:

• “To Make Backup”

• “To Check Module Slots”

• “To Collect Equipment and Accessories”

To Make Backup
If the internal solid state drive (SSD) is failed, you will lose all data stored in the 
SSD. So it is important to make backup constantly.

Before shipping the instrument to the service center, make backup of data in the 
SSD. And keep the backup media in trust. You may need to perform data recovery 
of the instrument returned from the service center.

If the SSD is replaced, the instrument will be returned with the latest revision of the 
software.

To Check Module Slots
Do not remove the plug-in module from the mainframe. The instrument must be 
shipped with all modules. The module cannot be repaired or calibrated without the 
mainframe.

If a module is removed and installed, the specifications are not guaranteed. The 
specifications are guaranteed after the calibration is performed at Keysight 
Technologies service center.

To Collect Equipment and Accessories
The mainframe, test fixture, and all connection cables are required for servicing and 
must be shipped to the service center. For details, contact the service center.

WARNING To prevent electrical shock, turn off the instrument and remove the power cord 
before removing the connection cables.

Mettez la machine hors tension pour fixer le connecteur ou pour retirer le 
connecteur de l’unité centrale.
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This chapter describes how to measure the power devices by using Keysight 
B1506A and Keysight Easy Test Navigator Software, and consists of the following 
sections:

• How To Perform Datasheet Characterization

• How To Perform I/V Measurement

• How To Perform Capacitance Measurement 1

• How To Perform Gate Charge Measurement 1

• How To Calculate Power Loss 1

• How To Monitor/Control Temperature Under Measurement

NOTE If Easy Test Navigator does not run

Launch “Keysight Connection Expert” by using the icon on Windows taskbar. And 
check the USB0 connection status displayed in “Instrument I/O on this PC” area.

USB0 connection status display example:

USB0
+ B1500A(USB0::2391::1::0001::0::INSTR)

+ agb1500a
+ UsbDevice1

If “agb1500A” and “UsbDevice1” are not listed, add them by using a dialog box 
which is opened by right-clicking on B1500A(USB0:: . . ::INSTR)  and 
selecting “Add VISA Alias” from the menu. For more information, see Connectivity 
Guide opened from the Help menu on the Connection Expert window.

NOTE This chapter may contain the information different from the instrument’s actual 
screen image and operation. For the reference information of GUI, see Chapter 4.

1. Available for the B1506A-H21/H51/H71.
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How To Perform Datasheet Characterization
This section describes how to perform measurement on device parameters and 
characteristics using the datasheet characterization software. This section consists of 
the following sub-sections:

• Preparing Measurement

• Executing Measurement

The datasheet characterization software provides a simple operation environment in 
a familiar datasheet-like format that can specify measurement items and 
measurement conditions, perform measurement, and displays measurement results.

NOTE For using the B1506A-H20/H50/H70, ignore the description about the capacitance 
measurement, the gate charge measurement, and the power loss calculation.

Figure 3-1 Datasheet Characterization Software
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Preparing Measurement

WARNING Set the instrument output off before connecting or disconnecting connection 
wire.

Press the mainframe front panel Stop key to set the source output off. And 
confirm that the mainframe front panel High Voltage indicator is not lit.

WARNING To prevent electrical shock and DUT damage, do not connect or disconnect the 
DUT while the instrument is applying voltage or current.

When you touch the DUT after measurement, devise a countermeasure of 
residual charge and heat to prevent electrical shock and burn. Use glove and 
any tool. Also have enough time for discharge and radiation.

Step 1. Before starting the procedure, prepare accessories used for connecting your device 
under test (DUT). See the following section depending on the accessory.

• “3-pin Inline Package Socket Module” on page 2-19

• “Curve Tracer Test Adapter Socket Module” on page 2-20

• “Universal Socket Module Kit” on page 2-21

• “Gate Charge Socket Adapter” on page 2-24

• “Accessories for Connecting a DUT” on page 2-28

NOTE If you would like to monitor/control temperature during measurement, perform the 
required connection and operation. “How To Monitor/Control Temperature Under 
Measurement” on page 3-51.

Step 2. Turn the instrument on.

Step 3. Measure the calibration data for capacitance measurement.

NOTE The capacitance measurement software keeps the last measured calibration data. If 
the connection for the capacitance measurement is same as when the last calibration 
data was measured, this step can be skipped.

1. Connect the accessory used for DUT connection to the test fixture. Do not 
connect DUT at this time.

2. On the software palette, click Capacitance Measurement icon . The 
Capacitance Measurement software (Figure 3-3) opens.
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3. Click Start Calibration... button on the toolbar to measure the calibration data.

Follow the instruction on the dialog box and measure the open and short calibration 
data.

Step 4. Measure the calibration data for gate charge measurement.

NOTE The gate charge measurement software keeps the last measured calibration data. If 
the connection for the gate charge measurement is same as when the last calibration 
data was measured, this step can be skipped.

1. Remove the accessory and attach the gate charge socket adapter to the test 
fixture. Do not connect DUT at this time.

2. On the software palette, click Gate Charge Measurement icon . The Gate 
Charge Measurement software (Figure 3-4) opens.

3. Click Start Calibration... button on the toolbar to measure the calibration data.

Follow the instruction on the dialog box and measure the open and short calibration 
data.

Executing Measurement
Perform the measurement as the following steps:

NOTE The following steps show the measurement example that uses the MOSFET as 
DUT.

Step 1. On the software palette, click Datasheet Characterization icon . The Datasheet 
Characterization software (Figure 3-1) opens.

Step 2. Select the device type of DUT, and load the corresponding template.

A template is a setup and measurement data file only for this software. It is called as 
ETN DS file.
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1. From the Device Type drop-down list on the upper work area, select the device 
type of DUT.

This example selects MOSFET.

2. Click New Datasheet button .

Step 3. Enter the information for device identification.

You can enter the following information for device identification of DUT at 
Identification area on upper work area:

Part Number Part number of DUT

Sample ID Device ID of DUT

Description Device description or any additional information.

Operator Operator information

Measurement 
Instrument Measurement instrument information

Step 4. Specify the maximum ratings of DUT

Confirm the maximum rating parameters and parameter values set in the Maximum 
Ratings area, and edit them if needed.

The specified maximum rating values are used to limit the values of measurement 
conditions in the Characteristics Parameters area and Characteristics Graphs area.
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Symbol Symbol of rating parameter

You can edit this by clicking on the text.

Parameter Rating parameter name

You can edit the name by clicking on the text.

Test Condition Conditions for rating parameter

You can edit the condition by clicking on the text. To close the 
expanded editing fields, click the Close button .

Value Maximum rating value

You can edit the maximum rating value by clicking on the 
value. To close the expanded editing fields, click the Close 
button .

Note Note

You can add any text for remarks by clicking the field.

Step 5. Select characteristics measurement items to be measured and enter measurement 
conditions

Characteristics Parameters area shows the pre-defined characteristics parameters. 
Each parameter corresponds to a measurement item.



3-8 B1506A User’s Guide, Edition 7

How To Perform Measurement
How To Perform Datasheet Characterization

1. Mark the check box at left side of row to select the characteristics parameter to 
be measured.

2. The following column of each characteristics parameter line shows the 
following conditions. Confirm the conditions and enter the conditions.

Measurement 
Priority Click the button on the right-hand side of the check box, 

if necessary. You can change the priority of the execution 
for the measurement.

: 1st priority
: 2nd priority
: 3rd priority

Symbol Symbol of characteristics parameter.

You can edit this by clicking on the text.

Parameter Name of characteristics parameter.

You can edit the name by clicking on the text.

Test Conditions Conditions for characteristics parameter.

You can edit the condition by clicking on the text. To 
close the expanded editing fields, click the Close 
button .

Min. Lower limit of expected range of characteristics 
parameter.

You can enter the value by clicking on the value.

If lower limit is unavailable, the field is not effective.

Act. Measured value of characteristics parameter.

If a measured value is out of expected range, which is 
from Min. to Max., a measured value is displayed in red 
italics.

Max. Upper limit of expected range of characteristics 
parameter.

You can enter the value by clicking on the value.

If upper limit is unavailable, the field is not effective.
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Note Remarks.

You can enter the value by clicking on the field.

NOTE To measure same measurement item under the different conditions

If you would like to measure same measurement item under the different conditions, 
do as following instruction:

1. To select a characteristics parameter to be measured, click on the corresponding 
line.

2. Click Duplicate button  on the toolbar.

The a duplicate line of selected characteristics parameter is added under the 
selected line.

3. Change the conditions on a duplicate line.

Step 6. Select characteristics graph to be measured

Characteristics Graphs area shows the pre-defined characteristics graphs. Each 
characteristics graph corresponds to a measurement item.
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1. Mark the check box at upper left of graph to select the characteristics graph to be 
measured.

2. Click the button on the right-hand side of the check box, if necessary. You can 
change the priority of the execution for the measurement with similar uses as the 
setting of the measurement priority in the Characteristics Parameters area.

3. To change the maximum or minimum value of the X and Y-axis, click on the 
value.

If an X or Y-axis corresponds to voltage or current output value, the minimum 
and maximum values also specify the output range on measurement.

4. You can change the title of characteristics graph, the labels of X and Y-axis by 
clicking on them.

Step 7. Click the Start Measurement tool button  to start measurement.

The Connection dialog opens. Then, sets up and connect the DUT for the I/V 
measurement and the capacitance measurement.
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1. Connect the accessory used for DUT connection to the test fixture.

2. Connect your DUT by using the accessory.

3. Close the test fixture cover.

4. Click the OK button. The marked measurement items related to the I/V and 
capacitance measurement are executed. 

For the execution order of the measurement items, see “Execution Order of 
Measurement Items” on page 4-15.

During measurement, you can stop the measurement by clicking the Stop 
Measurement tool button . 

During the measurement execution, the measured values of each measurement item 
are updated on Act. column of corresponding line at Characteristics Parameters or 
on the corresponding characteristics graph at Characteristics Graphs.

Step 8. After all measurements by the I/V measurement software and the capacitance 
measurement software are completed, the Connection dialog opens. Then, change 
the DUT connection setup to that for the gate charge measurement.

1. Open the test fixture cover and remove the accessory from the test fixture.

2. Attach the gate charge socket adapter to the test fixture.
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3. Set your DUT on the gate charge socket adapter.

4. Close the test fixture cover.

5. Click the OK button.The measurement for the selected gate charge measurement 
items is started.

For the execution order of the measurement items, see “Execution Order of 
Measurement Items” on page 4-15.

Step 9. After all measurements are completed, the setup data and the measurement data are 
automatically stored in the ETN DS file. The ETD DS file is the setup and 
measurement data file only for the datasheet characterization software. 
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How To Perform I/V Measurement
This section describes how to perform a measurement using the I/V measurement 
software and consists of the following sub-sections:

• Preparing Measurement

• Executing Measurement

• Monitoring Voltage/Current Waveforms

• Setting Parameter

Figure 3-2 I/V Measurement Software
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Preparing Measurement

WARNING Set the instrument output off before connecting or disconnecting connection 
wire.

Press the mainframe front panel Stop key to set the source output off. And 
confirm that the mainframe front panel High Voltage indicator is not lit.

WARNING To prevent electrical shock and DUT damage, do not connect or disconnect the 
DUT while the instrument is applying voltage or current.

When you touch the DUT after measurement, devise a countermeasure of 
residual charge and heat to prevent electrical shock and burn. Use glove and 
any tool. Also have enough time for discharge and radiation.

Step 1. Before starting the procedure, prepare an accessory used for connecting your device 
under test (DUT). See the following section depending on the accessory.

• “3-pin Inline Package Socket Module” on page 2-19

• “Curve Tracer Test Adapter Socket Module” on page 2-20

• “Universal Socket Module Kit” on page 2-21

• “Accessories for Connecting a DUT” on page 2-28

Step 2. Turn the instrument on. After that, connect your DUT to the test fixture by using the 
accessory.

If your DUT is diode, connect a cathode terminal of your DUT to the 
Collector/Drain terminal of test fixture and a anode terminal of your DUT to the 
Emitter/Source terminal of test fixture.

NOTE If you would like to monitor/control temperature during measurement, perform the 
required connection and operation. See “How To Monitor/Control Temperature 
Under Measurement” on page 3-51.
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Executing Measurement

NOTE This section explains the procedure using an example that selects MOSFET as a 
device type of DUT and ID-VDS as a measurement item.

Execute a measurement as follows:

Step 1. On the software palette, click the I/V Measurement icon . The I/V Measurement 
Software (Figure 3-2) opens.

Step 2. At the Setup area in work area, select a device type and measurement item to be 
measured.

• Device Type

From the Device Type drop-down list, select a device type.

This example selects MOSFET.

• Measurement Item

From the radio buttons located on the right of a Device Type selection, which is 
MOSFET in this example, select a measurement item to be measured.

This example selects ID-VDS.

For information on the available device types and measurement items, see Table 3-1 
on page 3-23

By selecting a device type and measurement item, the setup items displayed in the 
Setup area are automatically switched.
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Step 3. Enter or select the setup conditions for the gate of MOSFET in Gate/Base Voltage 
Pulse Step at the center of Setup area.

• Selecting Step Mode

From the Step Mode drop-down list, select a step mode of pulse voltage output.

LinearSingle Outputs voltage level changes from the Start value to the 
Stop value at equal intervals.

ListSingle Specify the output voltages of each step in the List.
Each step voltage in the List will be output in order from top 
to bottom.

This example selects the ListSingle.

• To change step values

Click the value in the List and you can change it to new value.
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• To insert new step value

Select the step value immediately after where you want to insert new step value 
and click the Insert button .

• To change an output order of step values

Click the Move Down and the Move Up buttons to move down or up an 
order of the selected step value.

• To delete a step value

Click the Delete button  to delete the selected step value.

By clicking the Details button, the area expands to set more detail conditions.

For more information on setting items, see “Setup” on page 4-58.

Step 4. Enter or select the setup conditions for the drain of MOSFET in Drain/Collector 
Voltage Pulse Sweep at the right side of Setup area.

Select or specify a sweep mode, a sweep start value, a sweep stop value, and a 
voltage compliance.

• Sweep Mode

Select a sweep mode from the Sweep Mode drop-down list.

LinearSingle One-way linear sweep from the Start (sweep start value) to 
the Stop (sweep stop value).

LogSingle One-way logarithmic sweep from the Start (sweep start 
value) to the Stop (sweep stop value). 

LinearDouble Linear-sweep from the Start (sweep start value) to the Stop 
(sweep stop value) and then return linear-sweep from the 
Stop to the Start.
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LogDouble Logarithmic-sweep from the Start (sweep start value) to the 
Stop (sweep stop value) and then return logarithmic-sweep 
from the Stop to the Start.

• Start、Stop

Enter the sweep start value in the Start and the sweep stop value in the Stop.

• Voltage Compliance

Enter the voltage compliance value in the Voltage Compliance.

If the output voltage of measurement unit connected to a drain terminal is more 
than this value, a measurement unit stops the output.

By clicking the Details button, the area expands to set more detail conditions.

For more information on setting items, see “Setup” on page 4-58.

Step 5. Enter the setup conditions for the pulse output in General settings at the left side of 
Setup area.

Auto Period Automatic adjustment for the pulse period.
To enable this function, mark the check box.

Pulse Period Pulse period.
However, if the Auto Period function is enabled, the pulse 
period is automatically adjusted to a minimum period 
corresponding to the pulse width.
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Step 6. Click the Connections tab to display Connections area.

At Connections area, you can confirm a measurement circuit.

Also, you can select a gate resistor/drain resistor that may be effective to suppress a 
device oscillation during measurement.

• Base/Gate Resistor

You can select a gate resistor from this drop-down list.

A gate resistor may be effective to suppress a device oscillation during large 
current measurement.

NOTE You can select a gate resistor only if a measurement resource is MCSMU.

In this example, which selects MOSFET as a device type and ID-VDS as a 
measurement item, the default measurement resource is MCSMU and you can select 
a gate resistor.

• Collector/Drain Resistor

You can select a drain resistor from this drop-down list.

A drain resistor may be effective to suppress a over current during a break-down 
measurement.

NOTE You can select a drain resistor only if a measurement resource is HVSMU.



3-20 B1506A User’s Guide, Edition 7

How To Perform Measurement
How To Perform I/V Measurement

In this example, which selects MOSFET as a device type and ID-VDS as a 
measurement item, the default measurement resource is UHCU and a drain resistor 
is fixed to 0 .

Step 7. Click the Start Measurement tool button  to start a measurement.

Or, click the Repeat Measurement tool button  to repeat a measurement.

After starting a measurement, you can stop a measurement by clicking the Stop 
Measurement tool button .

Step 8. Click the Characteristics tab to display the Characteristics area.

After a measurement is completed, a measured I/V characteristics curve is displayed 
on the Characteristics area. This example shows an ID-VDS characteristics curve.

For the operation on the graph display, see “Displaying and Operating Graph” on 
page 3-57.
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Monitoring Voltage/Current Waveforms
he I/V measurement software can monitor both voltage and current waveforms for 
the measurement channels at the specified measurement point on the characteristic 
trace when the measurement is in the pulse mode operation.

Step 1. Click the Characteristics tab to display the Characteristics area.

Step 2. Click the Oscilloscope View  button to display the Oscilloscope View area.

Step 3. Execute the I/V measurement according to the steps described in “Executing 
Measurement” on page 3-15.

Step 4. Move the trace marker on the Characteristics graph to specify the observation point. 

Step 5. Click the Start Measurement tool button  to start a measurement.

Or, click the Repeat Measurement tool button  to repeat a measurement.

After starting a measurement, you can stop a measurement by clicking the Stop 
Measurement tool button .
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After measuring the specified point, the observation point on the characteristics 
graph is identified by a monitor marker (green frame), and the time domain 
waveform(s) is displayed on this area.

In the case of the repeat measurement, you can move the trace marker to change the 
observation point during the measurement. After measuring the changed point, the 
monitor maker moves to the point and the waveforms are updated.

Step 6. Mark the check boxes for the voltage or current data names the measurement 
channels that you want to monitor.
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Setting Parameter
Table 3-1 Available Device Types and Measurement Items

Device Type Measurement
Item Description

MOSFET ID-VDS ID-VDS output characteristics

ID-VGS ID-VGS transmission characteristics

RDS-ID RDS (Drain to Source resistance) - ID characteristics

VGS(th) Gate to Source Threshold voltage

VDS-VGS VDS-VGS characteristics

RDS-VGS RDS (Drain to Source resistance) - VGS characteristics

IDSS Drain leak current - VDS characteristics

IGSS Gate leak current - VGS characteristics

IS-VSD Forward current of body diode - VSD characteristics

IGBT IC-VCE IC-VCE output characteristics

IC-VGE IC-VGE transmission characteristics

VGE(th) Gate to Emitter Threshold voltage

VCE-VGE VCE-VGE characteristics

VCE(sat) VCE(sat) (Collector to Emitter saturation voltage) - IC 
characteristics

ICES Collector leak current - VCE characteristics

IGES Gate leak current - VGE characteristics

IF-VF Forward characteristics of free wheel diode

Diode IF-VF Forward bias current - voltage characteristics

IR-VR Reverse bias current - voltage characteristics
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Generic2T Conduction Conduction resistance characteristics

Isolation Isolation characteristics

Generic Free setup on the measurement units connection and 
measurement conditions.

Device Type Measurement
Item Description
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How To Perform Capacitance Measurement
This section describes how to perform a measurement using the capacitance 
measurement software which is available for the B1506A-H21/H51/H71. 

This section consists of the following sub-sections:

• Preparing Measurement

• Executing Measurement

• Setting Parameter

Figure 3-3 Capacitance Measurement Software
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Preparing Measurement

WARNING Set the instrument output off before connecting or disconnecting connection 
wire.

Press the mainframe front panel Stop key to set the source output off. And 
confirm that the mainframe front panel High Voltage indicator is not lit.

WARNING To prevent electrical shock and DUT damage, do not connect or disconnect the 
DUT while the instrument is applying voltage or current.

When you touch the DUT after measurement, devise a countermeasure of 
residual charge and heat to prevent electrical shock and burn. Use glove and 
any tool. Also have enough time for discharge and radiation.

Step 1. Before starting the procedure, prepare an accessory used for connecting your device 
under test (DUT). See the following section depending on the accessory.

• “3-pin Inline Package Socket Module” on page 2-19

• “Curve Tracer Test Adapter Socket Module” on page 2-20

• “Universal Socket Module Kit” on page 2-21

• “Accessories for Connecting a DUT” on page 2-28

Step 2. Turn the instrument on.

NOTE If you would like to monitor/control temperature during measurement, perform the 
required connection and operation. For more information, see “How To 
Monitor/Control Temperature Under Measurement” on page 3-51.
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Executing Measurement

NOTE This section explains the procedure using an example that selects MOSFET as a 
device type of DUT and Ciss, Coss, Crss as a measurement item.

Execute a measurement as follows:

Step 1. On the software palette, click the Capacitance Measurement icon . The 
Capacitance Measurement software (Figure 3-3) opens.

Step 2. At the Setup area in work area, select a device type of your DUT and a measurement 
item to be measured.

• Device Type

Select a device type from the Device Type drop-down list.

This example selects MOSFET.

• Measurement Item

From the radio buttons located on the right of a Device Type selection, which is 
MOSFET in this example, select a measurement item to be measured.

This example selects Ciss, Coss, Crss.

 For information on the available device types and measurement items, see Table 3-2 
on page 3-30

By selecting a device type and measurement item, the setup items displayed in the 
Setup area are automatically switched.

Step 3. Enter the measurement frequency in the Frequency of General settings located at the 
left part of Setup area.



3-28 B1506A User’s Guide, Edition 7

How To Perform Measurement
How To Perform Capacitance Measurement

By clicking the Details button, the area expands to set more detail conditions.

For more information on setting items, see “Setup” on page 4-92.

Step 4. Enter the bias voltage value in the Bias of Base/Gate Voltage Bias at the center of 
Setup area.

Step 5. Enter or select the voltage sweep conditions in the Collector/Drain Voltage Sweep at 
the right of Setup area.

Start Enter a start voltage value of sweep.

Stop Enter a stop voltage value of sweep.

Sweep Mode Select a sweep mode.

LinearSingle One-way linear sweep from the Start to the 
Stop.

LogSingle One-way logarithmic sweep from the Start 
to the Stop.

LinearDouble Linear-sweep from the Start to the Stop and 
then return linear-sweep from the Stop to 
the Start.

LogDouble Logarithmic-sweep from the Start to the 
Stop and then return logarithmic-sweep 
from the Stop to the Start.

By clicking the Details button, the area expands to set more detail conditions.

For more information on setting items, see “Setup” on page 4-92.

Step 6. Click the Start Calibration... button in the toolbar to measure the calibration data of 
measurement path.
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Follow the instruction displayed on the dialog box to measure the open and short 
calibration data.

If you have measured and saved the calibration data of measurement path, click the 
Select Calibration Data... button in the toolbar to select and load the stored 
calibration data.

Step 7. Connect your DUT. And click the Start Measurement button  to start a 
measurement.

You can stop the measurement by clicking the Stop Measurement button  
during a measurement execution.

NOTE If your DUT is diode, connect the cathode of your DUT to the Collector/Drain 
terminal of the test fixture and the anode of your DUT to the Emitter/Source 
terminal of the test fixture.

Step 8. Click the Characteristics tab to display the Characteristics area.

After a measurement is completed, a measured capacitance characteristics curve is 
displayed on the Characteristics area. This example shows the Ciss, Coss, and Crss, 
characteristics curves.
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For the operation on the graph display, see “Displaying and Operating Graph” on 
page 3-57.

Setting Parameters
Table 3-2 Available Device Types and Measurement Items

Device Type Measurement 
Item Description

MOSFET Ciss Ciss (Input capacitance) - Vds characteristics

Coss Coss (Output capacitance) - Vds characteristics

Crss Crss (Feedback capacitance) - Vds characteristics

Ciss, Coss, Crss Ciss, Coss, and Crss characteristics

Cgs Cgs (Gate to Source capacitance) - Vds characteristics

Cds Cds (Drain to Source capacitance) - Vds characteristics

Cgd Cgd (Gate to Drain capacitance) - Vds characteristics

Cgs, Cds, Cgd Cgs, Cds, and Cgd characteristics

Rg Rg (Gate resistance) - Vgs characteristics

Cox Cox (Gate oxide film capacitance) - Vgs characteristics

IGBT Cies Cies (Input capacitance) - Vce characteristics

Coes Coes (Output capacitance) - Vce characteristics

Cres Cres (Feedback capacitance) - Vce characteristics

Cies, Coes, Cres Cies, Coes, and Cres characteristics

Cge Cge (Gate to Emitter capacitance) - Vce characteristics

Cce Cce (Collector to Emitter capacitance) - Vce characteristics

Cgc Cgc (Gate to Collector capacitance) - Vce characteristics

Cge, Cce, Cgc Cge, Cce, and Cgc characteristics

Rg Rg (Gate resistance) - Vge characteristics
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Diode CT Total capacitance at reverse bias to bias voltage 
characteristics

Generic Sweep Voltage 
Between 
Terminal 2-3 

Cp-G model capacitance between Collector/Drain terminal 
and Emitter/Source terminal to Vce/Vds characteristics

Sweep Voltage 
Between 
Terminal 1-3 

Cs-Rs model capacitance between Base/Gate terminal and 
Emitter/Source terminal to Vbe/Vgs characteristics

Device Type Measurement 
Item Description
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How To Perform Gate Charge Measurement
This section describes how to perform a measurement using the gate charge 
measurement software which is available for the B1506A-H21/H51/H71. 

This section consists of the following sub-sections:

• Preparing Measurement

• Executing Measurement

Figure 3-4 Gate Charge Measurement Software
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Preparing Measurement

WARNING Set the instrument output off before connecting or disconnecting connection 
wire.

Press the mainframe front panel Stop key to set the source output off. And 
confirm that the mainframe front panel High Voltage indicator is not lit.

WARNING To prevent electrical shock and DUT damage, do not connect or disconnect the 
DUT while the instrument is applying voltage or current.

When you touch the DUT after measurement, devise a countermeasure of 
residual charge and heat to prevent electrical shock and burn. Use glove and 
any tool. Also have enough time for discharge and radiation.

Step 1. Before starting the procedure, prepare the gate charge socket adapter. See “Gate 
Charge Socket Adapter” on page 2-24.

Step 2. Turn the instrument on.

NOTE If you would like to monitor/control temperature during measurement, perform the 
required connection and operation. For more information, see “How To 
Monitor/Control Temperature Under Measurement” on page 3-51.



3-34 B1506A User’s Guide, Edition 7

How To Perform Measurement
How To Perform Gate Charge Measurement

Executing Measurement
Execute a measurement as follows:

Step 1. On the software palette, click the Gate Charge Measurement icon . The Gate 
Charge Measurement software (Figure 3-4) opens.

Step 2. Enter the measurement conditions at the Condition area.

Drain Specify the drive conditions for the drain of your device under 
test (DUT).

• Vds(off)

Enter the voltage to force between drain and source of DUT 
at the off-state.

• Id(on)

Enter the drain current to force to DUT at the on-state if the 
constant current load (Current Load) is used.

If the constant current load is not used, the drain current at 
the on-state is determined by the Vds(off), the resistance of 
resistive load, and the on-state resistance/saturation voltage. 
For the current output range of measurement resource, the 
minimum range that includes Id(on) is automatically 
selected.

Gate Specify the gate drive conditions of DUT.

• Vgs(off)

Enter the gate-source voltage that turns the DUT to the 
off-state.

• Vgs(on)

Enter the gate-source voltage that turns the DUT to the 
complete on-state.
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• Ig

Enter the limit value of gate current.

This setting effects the switching time. The larger limit 
causes the shorter switching time and the smaller limit 
causes the longer switching time.

Current Load Mark the check box if the constant current load is used.

Specify the gate drive conditions of the constant current load 
transistor so that the constant current load transistor forces the 
current as same as Id(on) specified in the Drain.

If you do not use the constant current load but use the resistive 
load, unmark the Current Load check box.

• LoadVgs(off)

Enter the gate-source voltage that turns the constant current 
load transistor to the off-state.

• LoadVgs(on)

Enter the gate-source voltage that turns the constant current 
load transistor to the complete on-state.

Step 3. Click the Start Calibration... button in the toolbar to measure the calibration data of 
measurement path.

Follow the instruction displayed on the dialog box to measure the open and short 
calibration data.

If you have measured and saved the calibration data of measurement path, click the 
Select Calibration Data... button in the toolbar to select and load the stored 
calibration data.

Step 4. Connect your DUT. And click the Start Measurement button  to start a 
measurement.
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You can stop the measurement by clicking the Stop Measurement button  
during a measurement execution.

Step 5. Click the Gate Charge Characteristics tab to display the Gate Charge Characteristics 
area.

After a measurement is completed, a measured gate charge characteristics curve and 
extracted parameters are displayed on the Gate Charge Characteristics area.

The left side shows the measured gate charge characteristics curve and the right side 
shows the extracted parameters.

Step 6. Displaying the gate charge characteristics curve

• To select the gate charge characteristics curve to be displayed

Mark the check box corresponding to the gate charge characteristics to display 
the characteristics curve.
You can select the multiple gate charge characteristics.
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By the radio buttons at the top of graph, you can select the line type of 
characteristics curve from Line, Dot, or (Line & Dot).

JESD24-2 (Derived) Shows the approximation straight line of gate charge 
characteristics that measured under conditions of Vds(off) 
and Ig(on) specified in “Drain”.

Vgs-Qg (H.C.) Shows the gate charge characteristics that measured under 
the condition of Id(on) specified in “Drain”.

Vgs-Qg (H.V.) Shows the gate charge characteristics that measured under 
the condition of Vds(off) specified in “Drain”.

JESD24-2 (H.C.) Shows the approximation straight line of Vgs-Qg(H.C.) 
gate charge characteristics. The approximation is calculated 
on sloops (S1, S2, and S3) defined in JEDEC Standard 
JESD24-2.

JESD24-2 (H.C.) Shows the approximation straight line of Vgs-Qg(H.V.) 
gate charge characteristics. The approximation is calculated 
on sloops (S1, S2, and S3) defined in JEDEC Standard 
JESD24-2.

Vds-Qg (H.C.) Shows the relationship between the drain-source voltage 
and gate charge when the Vgs-Qg(H.C.) is measured.

Vds-Qg (H.V.) Shows the relationship between the drain-source voltage 
and gate charge when the Vgs-Qg(H.V.) is measured.
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• Extracted Parameter Display

Enter the threshold voltage of DUT in the Vgs(th) at the upper of parameter 
display area.

The gate charge parameter values that extracted from the specified threshold 
voltage Vgs(th), and JESD24-2(Derived), JESD24-2(H.C.), and 
JESD24-2(H.V) are displayed in this area.

To show the gate charge parameters from JESD24-2(Derived), click the Derived 
tab.
To show the gate charge parameters from JESD24-2(H.C.), click the High 
Current tab.
To show the gate charge parameters from JESD24-2(H.V.), click the High 
Voltage tab.

The following gate charge parameters are displayed:

Vgs(pl) Gate plateau voltage
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Qgs Gate - source charge
Gate charge for slope S1 defined in JEDEC Standard 
JESD24-2.

Qgd Gate - drain charge
Gate charge for slope S3 defined in JEDEC Standard 
JESD24-2.

Qg(th) Gate-source charge at threshold
Gate charge from Vgs(off) to Vgs(th).

Qg(on) Gate-source charge in on-state
Gate charge from Vgs(off) to Vgs(on).

C1 Qgs/{Vgs(pl)−Vgs(off)}
Equivalent capacitance for slope S1 defined in JEDEC 
Standard JESD24-2

C2 {Qgs(on)−Qgs− Qgd}/{Vgs(on)−Vgs(pl)}
Equivalent capacitance for slope S2 defined in JEDEC 
Standard JESD24-2.

S1 Slope S1 defined in JEDEC Standard JESD24-2

S2 Slope S2 defined in JEDEC Standard JESD24-2

For more information on the operation for graph display, see “Displaying and 
Operating Graph” on page 3-57.
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How To Calculate Power Loss
This section describes how to calculate the power loss at a switching device using 
the power loss calculation software which is available for the 
B1506A-H21/H51/H71. 

This section consists of the following sub-sections:

• Calculating Power Loss

• Extracted Parameters By Power Loss Calculation

The power loss calculation software calculates the power loss from the drive 
conditions and the device characteristics parameters of DUT.

There are the following two ways to specify the parameters for calculation:

• Specify the parameter values from the datasheet of DUT.

If you want to calculate the power loss of DUT at the different drive conditions 
or there are the parameters that are not specified in the datasheet, you may 
specify the predicted values.

• Measure the switching device by the I/V measurement software, capacitance 
measurement software, and gate charge measurement software at your desired 
drive conditions and store the measurement data. Then, the power loss 
calculation software read the stored measurement data and extract the required 
drive conditions and characteristics parameters for power loss calculation.

This section explains the procedure that specify the measurement data file of DUT.
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Figure 3-5 Power Loss Calculation Software
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Calculating Power Loss
Step 1. Prepare the measurement data

The power loss calculation software uses the following measurement data files to 
calculate the power loss. So, measure the DUT at your desired drive conditions and 
save the measured data.

• Measurement data file of I/V measurement software

Prepare a measurement data file that measured either one of the following 
measurement item.

For MOSFET device type,

• ID-VDS

• RDS-ID

• VDS-VGS

• RDS-VGS

For IGBT device type,

• IC-VCE

• VCE(sat)

• VCE-VGE

• Measurement data file of capacitance measurement software

Prepare the measurement data files that measured the following measurement 
items.

For MOSFET device type,

• Rg

• Ciss, Coss, Crss (Coss or Crss)

For IGBT device type,

• Rg

• Cies, Coes, Cres (Coes or Cres)

• Measurement data file of gate charge measurement software
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Prepare a measurement data file that measured any measurement item.

Step 2. On the software palette, click the Power Loss Calculation icon . The Power Loss 
Calculation software (Figure 3-5) opens.

Step 3. Select the assumed load type to calculate the power loss in the Conditions area on 
the work area.

Inductive Inductive load

Resistive Resistive load

Step 4. At the Inputs area in work area, select a device type.

From the Device Type drop-down list, select a device type.

This example selects MOSFET.

Step 5. Specify the measurement data files to be used for power loss calculation and load 
them.
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1. Specify the measurement data file of the I/V measurement software to load.

a. Click the Output Characteristics tab at the right of work area to display the 
Output Characteristics area.

b. Click the Load Measurement Data button  at the upper-left corner of the 
Output Characteristics area.

After the dialog box opens, specify the measurement data of I/V 
measurement software.

The characteristics graph of the loaded measurement item is displayed.

2. Specify the Rg measurement data file of the capacitance measurement software 
to load.

a. Click the Gate Resistance tab to display the Gate Resistance area.

b. Click the Load Measurement Data button  at the upper-left corner of the 
Gate Resistance area.

After the dialog box opens, specify the Rg measurement data of capacitance 
measurement software.

The loaded Rg characteristics graph is displayed.

3. Specify the “Ciss, Coss, Crss” measurement data file of the capacitance 
measurement software to load.
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a. Click the Capacitance tab to display the Capacitance area.

b. Click the Load Measurement Data button  at the upper-left corner of the 
Capacitance area.

After the dialog box opens, specify the “Ciss, Coss, Crss” measurement data 
of capacitance measurement software.

The loaded “Ciss, Coss, Crss” characteristics graph is displayed.

4. Specify the measurement data file of the gate charge measurement software to 
load.

a. Click the Gate Charge tab to display the Gate Charge area.

b. Click the Load Measurement Data button  at the upper-left corner of the 
Gate Charge area.

After the dialog box opens, specify the measurement data of gate charge 
measurement software.

The gate charge characteristics graph of the loaded measurement item is 
displayed.

For the drive conditions and the device parameters for power loss calculation that 
extracted from the loaded measurement data, see “Extracted Parameters By Power 
Loss Calculation” on page 3-49”.
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You can confirm or change the drive conditions for power loss calculation by 
clicking the Drive Conditions tab at the left of work area.
Also, you can confirm or change the device parameters for power loss calculation by 
clicking the Device Parameters tab.

Step 6. Select a drive condition or device parameter to be swept and specify the sweep 
condition.

If you select a drive condition parameter to be swept, click the Drive Condition tab 
and mark the check box of the desired drive parameter.

If you select a device parameter to be swept, click the Device Parameters tab and 
mark the check box of the desired device parameter.

This example select a switching frequency to be swept.

1. Click the Drive Conditions tab and mark the check box of the Switching 
Frequency parameter to select.

2. Specify the sweep condition in the Value column.

Start Sweep start value

Stop Sweep stop value

Sweep Mode Sweep mode
Log (logarithmic sweep) or Linear (linear sweep)
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Number of 
Step Number of sweep steps

Step 7. Specify the drive conditions that are not extracted from the loaded measurement 
data.

1. Click the Drive Conditions tab at the left of work area to display the Drive 
Conditions area.

2. Specify the following drive conditions that are not extracted from the 
measurement data.

Switching 
Frequency Switching frequency

In this example, this parameter already specified by Step.4.

Rg(ext) Gate input resistance in the external drive circuit 

Irms, D Irms: Effective drain current (the root mean square of the 
load current)
D: Duty cycle. 

Specify Irms or D. 
The relation between Irms and D is Irms = Id  D1/2.

Step 8. Click the Start button  of toolbar to start the power loss calculation.

Step 9. After the calculation is completed, the list of calculated values and the trand chart 
are displayed as shown below.
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• List of Calculated Results

The following calculated data are displayed in list format.

Index Index number of sweep step.

Sweep Parameter Sweep parameter and its step values.

In this example, F values are listed as the sweep 
parameter.

Conduction Loss Calculated conduction loss

Coss (or Coes) Loss 
Calculated output capacitance loss

Switching Loss Calculated switching loss

Driving Loss Calculated driving loss

Total Power Loss Sum total of the conduction loss, switching loss, and 
driving loss.

For the calculation formula for each power loss, see “Results” on page 4-152.

• Trend Chart

The sweep parameter is assigned to X-axis, and the conduction loss, output 
capacitance loss, switching loss, and driving loss are assigned to Y-axis and 
accumulated in this order.

You can change the minimum and maximum values on the X and Y-axises by 
clicking the value.
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Extracted Parameters By Power Loss Calculation
Table 3-3 Measurement Data and Extracted Drive Conditions and Device Parameters for 

Power Loss Calculation (MOSFET)

Measurement Data Extracted 
Drive 

Conditions

Extracted 
Device 

ParametersMeasurement Software Measurement Item

I/V Measurement ID-VDS, RDS-ID, 
RDS-VGS, or 
VDS-VGS

Rds(on)a

a. Extracted from Vgs(on)

Capacitance Measurement Rg Rgb

b. Extracted from Vgs(off)

Crss Qswc

c. Extracted from Vgs(off) and Vds(off)

Gate Charge Measurement Any measurement 
items

Vgs(on), 
Vgs(off), 
Id,
Vds

Qg(on),
Qg(off),
Qsw,
Vgs(pl)
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Table 3-4 Measurement Data and Extracted Drive Conditions and Device Parameters for 
Power Loss Calculation (IGBT)

Measurement Data Extracted 
Drive 

Conditions

Extracted 
Device 

ParametersMeasurement Software Measurement Item

I/V Measurement IC-VCE, VCE(sat), 
or VCE-VGE

Vce(sat)a

a. Extracted from Vge(on)

Capacitance Measurement Rg Rgb

b. Extracted from Vge(off)

Cres Qswc

c. Extracted from Vge(off) and Vce(off)

Gate Charge Measurement Any measurement 
items

Vge(on), 
Vge(off), 
Ic,
Vce

Qg(on),
Qg(off),
Qsw,
Vgs(pl)



B1506A User’s Guide, Edition 7 3-51

How To Perform Measurement
How To Monitor/Control Temperature Under Measurement

How To Monitor/Control Temperature Under 
Measurement
The thermal monitor/control software provides the following functions:

• Thermal monitor using the thermocouple

• Thermal control using the thermostream

• Synchronized measurement execution with the thermal conditions

These functions enable the automated measurement execution under the multiple 
temperature conditions.

This section describes how to monitor the temperature and execute the measurement 
synchronized with the specified thermal conditions using the thermal 
monitor/control software and consists of the following sub-sections:

• Preparing the Measurement

• Thermal Monitor/Control During Measurement

NOTE This section uses the example that monitors the temperature of DUT controlled by 
thermostream and executes the measurement synchronized with the thermal 
conditions.

Preparing the Measurement
Step 1. Before starting the procedure, prepare an accessory used for connecting your device 

under test (DUT). See the following section depending on the accessory. Also 
prepare the thermocouple and the thermostream.

• “3-pin Inline Package Socket Module” on page 2-19

• “Curve Tracer Test Adapter Socket Module” on page 2-20

• “Universal Socket Module Kit” on page 2-21

• “Accessories for Connecting a DUT” on page 2-28

• “Thermocouple” on page 2-32

• “Thermostream” on page 2-33
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Step 2. Turn the instrument on. After that, connect your DUT to the test fixture by using the 
accessory.

Figure 3-6 Thermal Monitor/Control Software

Thermal Monitor/Control During Measurement
Step 1. On the software palette, click the Thermal Monitor/Control icon . The Thermal 

Monitor/Control software (Figure 3-6) opens.

Step 2. Specify the conditions of thermal monitor at the Thermometer of Configuration area 
in the work area.

This example uses the thermocouple connected to the B1506A to monitor the 
temperature, so specify at the Thermometer of B1506A.

Reading Time Span Thermal reading interval

Channel 1 Mark the check box if you would like to enable the thermal 
monitor for the thermocouple connected to the channel 1 
of K Thermocouple terminal on the test fixture.
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Channel 2 Mark the check box if you would like to enable the thermal 
monitor for the thermocouple connected to the channel 2 
of K Thermocouple terminal on the test fixture is enabled.

Step 3. Specify the conditions of thermo-trigger function

The thermo-trigger function executes the thermo-trigger list, which consists of the 
steps for watching on establishment of thermal condition and the steps for thermal 
control, sequentially.

If the thermo-trigger function is under execution, the measurement application waits 
the establishment of thermal condition and then executes the measurement.

This example set the following thermo-trigger steps:

a. Wait until the temperature of the B1506A thermometer channel 1 is 25 °C  1 
C. 
If the thermal condition is established, wait for 5 seconds and then output the 
measurement trigger to the measurement software.

Wait for the measurement completion by the measurement software.
If the measurement is completed, proceed to the next thermo-trigger step.

b. Wait until the temperature of the B1506A thermometer channel 1 is 30 C  1 
C. 
If the thermal condition is established, wait for 5 seconds and then output the 
measurement trigger to the measurement software.

Wait for the measurement completion by the measurement software.
If the measurement is completed, proceed to the next thermo-trigger step.

c. End of the thermo-trigger step.

Example of Thermo-trigger Steps

1. Click the Insert Control button at the bottom of the window.
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2. The line for a thermo-trigger step is inserted in the Thermo-Trigger. 
Specify the condition.

a. Select the target temperature by the drop-down list of second column.

This example selects the Channel1.

You can selects the followings by this drop-down list:

Channel1 The temperature monitored by B1506A 
thermometer channel 1

Channel2 The temperature monitored by B1506A 
thermometer channel 2

Channel1_2 Differences between the temperature 
monitored by B1506A thermometer channel 1 
and channel 2 (Channel 1 - Channel 2)

ThermoStream Air The temperature of air blowing from the 
thermostream (when using the thermostream)

ThermoStream DUT The temperature monitored by the DUT 
thermometer of thermostream (when using 
the thermostream)
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b. Specify the thermal condition.

Center Center value of thermal condition.
This example specified as 25.

Radius Allowable range from the center value for the thermal 
condition.
This example specifies as 1.

Delay Delay time after establishment of thermal condition to 
execute the specified action.
This example specifies as 5 (s).

c. Selects the action after establishment of thermal condition from the Action 
drop-down list.

This example selects the TRIGGER, which outputs the measurement trigger.

You can select the following actions by this drop-down list:

TRIGGER Outputs the measurement trigger.

NOP Does nothing and proceed to the next step.

END Terminates the thermo-trigger list execution.

3. Click the Duplicate button at the bottom of the window to copy the line of 
thermo-trigger step and add the copied line to the Thermo-Trigger.

4. Specify the thermal condition of the copied thermo-trigger line.
This example changes the condition of Center to 30 °C.

Step 4. Opens the measurement software that will synchronized with the thermo-trigger 
function and setup the measurement condition on it.

After the measurement setup is completed, leave the software to be opened.

Step 5. Click the Start button  of the menu bar on the thermal monitor/control software to 
start the thermo-trigger function.

The thermal monitor/control software executes the first thermo-trigger step and 
waits for the establishment of thermal condition.

Step 6. Click the Start button  of the menu bar on the measurement software to start the 
measurement.

The measurement software waits for the measurement trigger from the thermal 
monitor/control software.
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Step 7. Control the thermostream so that the temperature is 25 °C  1 C, which is the first 
thermal condition.

If the thermal condition is established, the thermal monitor/control software outputs 
the measurement trigger to the measurement software.

After receiving the measurement trigger, the measurement software starts the 
measurement.

Step 8. When the measurement is completed, the measurement software outputs the signal 
of the measurement completion to the thermal monitor/control software. 
And then, the measurement software waits for the next measurement trigger from 
the thermal monitor/control software.

When the thermal monitor/control software receives the signals of measurement 
completion, the thermal monitor/control software executes the next thermo-trigger 
step and waits for the establishment of thermal condition.

Step 9. Control the thermostream so that the temperature is 30 °C  1 C, which is the next 
thermal condition.

If the thermal condition is established, the thermal monitor/control software outputs 
the measurement trigger to the measurement software.

After receiving the measurement trigger, the measurement software starts the 
measurement under the different thermal condition.
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Displaying and Operating Graph
This section describes the common graph operation within the measurement 
softwares and consists of the followings:

• How To Select and Display Characteristics Curve

• How To Use the Marker

How To Select and Display Characteristics Curve
Step 1. Select the characteristics curves to display.

The check boxes for the available characteristics are displayed at the upper left on 
the graph area.
Mark the check boxes for the desired characteristics to display.

You can select the multiple characteristics to display.

Step 2. Select the line type of curve.
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By the radio buttons at the top of graph area, you can select the line type of curve 
from the Line, Dot, or Line&Dot.

Step 3. Change the minimum and maximum values of X and Y-axises

If the auto scale mode button  is selected, the X and Y-axises of the graph are 
automatically changing to fit the measured data during measurement execution.

If the fixed scale mode button is selected and the auto-scale button is 
clicked, the X and Y-axises of the graph are changed to fit the measured data.

Or, you can change the minimum and maximum values of X and Y-axises by 
clicking the value.
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How To Use the Marker
You can use the domain marker and/or trace marker to read the value on the curve.

The following table shows the measurement softwares and their furnished marker 
function.

Marker Description Applied Software

Domain Marker Vertical line marker.
The marker moves in the 
direction of X and you can read 
the X-axis value of the marker 
and Y-axis values of the 
intersections of marker and 
characteristics curves.

I/V measurement,
Capacitance measurement,
Gate charge measurement

Trace Marker Circle marker.
The marker moves on a 
characteristics curve and you 
can read the X and Y-axis 
values of the marker.

I/V measurement,
Capacitance measurement, 
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Using the domain marker
Step 1. If the trace marker is displayed, click the trace marker mode button  to change to 

the domain marker mode .

Step 2. Marker A (Vertical line) is displayed.

To move the marker, use the rotary nob or mouse.

The MARKER(A): at the upper left of graph area shows the X-axis value of marker A 
and the Y-axis value of the intersection of the marker and each characteristics curve 
is displayed at the right of characteristics curve name.
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Step 3. If the check box at the left of the MARKER(B): is marked, the marker B (vertical dot 
line) is displayed.

The following information is displayed at the top of graph area:

MARKER(B): X-axis value of marker B

() X-axis value of marker B - X-axis value of marker A

The Y-axis values of the intersection of the markers and each characteristics curve, 
and the differences of Y-axis values between the mark A interaction and the mark B 
interaction (B-A) are displayed at the right of characteristics curve name.
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Using the trace marker
Step 1. If the domain marker is displayed, click the domain marker mode button  to 

change to the trace marker mode .

Step 2. The trace marker (circle) is displayed.

You can move the trace marker on the characteristics curve using the rotary nob or 
mouse.

The MARKER: at the upper left of graph shows the X-axis value of the marker and 
the Y-axis value is displayed at the right of the characteristics curve name.
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Keysight Easy Test Navigator software provides dedicated measurement software 
for power device characterization. It supports various types of measurement tasks 
with ease-of-use and simple operation.

This chapter describes reference information of the Keysight Easy Test Navigator 
software, and covers the following topics.

• “Software Palette”

• “Datasheet Characterization Software”

• “I/V Measurement Software”

• “Capacitance Measurement Software” 1

• “Gate Charge Measurement Software” 1

• “Power Loss Calculation Software” 1

• “Thermal Monitor/Control Software”

For how to perform the measurements, see Chapter 3, “How To Perform 
Measurement.”

NOTE The actual screen image on the B1506A may be different from the image shown in 
this chapter.

1. Available for the B1506A-H21/H51/H71.
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Software Palette
The software palette provides a complete list of the B1506A's measurement 
software and also allows this software to be launched. The software palette lists 
icons with the measurement software names. You can start a measurement software 
by clicking an icon or a software name, or by pressing a softkey corresponding to 
the software. Seven softkeys are available for this purpose at the right next to the 
LCD of this instrument.

The software palette is displayed in fullscreen mode after powering up the B1506A. 
The software palette can be minimized to access the Windows desktop.

The following shows the icons and texts displayed on the software palette, and 
actions by clicking them.

Datasheet 
Characterization

Starts the datasheet characterization software. See 
“Datasheet Characterization Software” on page 
4-5.

I/V Measurement Starts the I/V measurement software. See “I/V 
Measurement Software” on page 4-56.

Capacitance 
Measurement

Available for the B1506A-H21/H51/H71.
Starts the capacitance measurement software. See 
“Capacitance Measurement Software” on page 
4-90. 

Gate Charge 
Measurement

Available for the B1506A-H21/H51/H71.
Starts the gate charge measurement Software. See 
“Gate Charge Measurement Software” on page 
4-118. 

Power Loss 
Calculation

Available for the B1506A-H21/H51/H71.
Starts the power loss calculation software. See 
“Power Loss Calculation Software” on page 
4-142. 
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Thermal 
Monitor/Control

Starts the thermal monitor/control software. See 
“Thermal Monitor/Control Software” on page 
4-163.

Minimize Minimizes the software palette. This is useful 
when you access the Windows desktop. When 
you click the icon on the taskbar, the software 
palette appears again.

Exit Exits the software palette and opened 
measurement software. This button is displayed if 
you move the mouse pointer over the upper right 
corner.

When you use the EasyEXPERT software or you 
update the Easy Test Navigator software, use this 
button to exit the Easy Test Navigator software in 
advance.
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Datasheet Characterization Software
The datasheet characterization software measures various characteristics parameters 
and graphs of the I/V characteristics, capacitance characteristics, and gate charge 
characteristics described on a device datasheet. This software has the following 
features.

• A simple operating environment that can measure a range of device parameters 
and characteristics using a familiar datasheet-like format

• To enter measurement conditions in a datasheet-like format

• To set sweep output start/stop by using graph minimum/maximum 

• To display measured parameters and characteristics in a datasheet-like 
format

• To automatically compare measurement results with expected values

• Minimal software learning curve for device characterization using the following 
templates installed with the software

• MOSFET

• IGBT

• BJT

• Diode

• Component

A template is a setup and measurement data file only for this software. It is 
called as ETN DS file.

• To effectively get the data not covered by the manufacturer's datasheet

For details of the templates furnished with this software, see “Parameters Defined in 
Furnished Templates” on page 4-39. And, for how to create an ETN DS file to be 
fitted to real devices, see “Creating Custom File” on page 4-54.

NOTE For using the B1506A-H20/H50/H70, ignore the description about the capacitance 
measurement, the gate charge measurement, and the power loss calculation.
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GUI Overview
The GUI (Graphical User Interface) of the datasheet characterization software is 
comprised of the following areas.

Figure 4-1 Datasheet Characterization Software GUI

1. Work Area (See p. 4-7.)

This area provides the functions to set the measurement conditions and observe 
the measurement results. This is separated to the following areas.

a. Identification (See p. 4-7.)

b. Maximum Ratings (See p. 4-10.)

c. Characteristics Parameters (See p. 4-11.)

d. Characteristics Graphs (See p. 4-12.)

2. Automatic Data Save (See p. 4-16.)

3

a

b

d

1
c

2
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This area provides the functions regarding the automatic saving of the ETN DS 
files. The ETN DS file can have the setup data and measurement data, and it is 
only for this software.

3. Operating Tools

• Toolbar (See p. 4-18.)

This provides the functions that are very frequently used in the button 
format.

• Main Menu (See p. 4-23.)

This provides the functions needed for various operations in the menu 
format.

For the dialog boxes displayed during this software operation, see “Dialog Boxes” 
on page 4-29.

For the files handled by this software, see “Summary of Files” on page 4-36.

Work Area
In this area, set the measurement conditions and observe the measurement results. 
This is separated to the following areas.

• Identification (See p. 4-7.)

• Maximum Ratings (See p. 4-10.)

• Characteristics Parameters (See p. 4-11.)

• Characteristics Graphs (See p. 4-12.)

Identification
This is an area to select the device type of the device under test (DUT) and enter the 
identification information for the DUT.

This area can be hidden or shown by clicking the line of  Identification.

Figure 4-2 Identification

a b

c
d
e
f
g

h
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a. Device Type

Lists the following device types. Select the device type of the DUT from them.

• MOSFET

MOSFET is selected. For details of the measurement items, see “MOSFET 
Template” on page 4-39.

• IGBT

IGBT is selected. For details of the measurement items, see “IGBT 
Template” on page 4-44.

• BJT

BJT is selected. For details of the measurement items, see “BJT Template” 
on page 4-49.

• Diode

Diode is selected. For details of the measurement items, see “Diode 
Template” on page 4-52.

• Component

Displays a pop-up menu for selecting a component type appears as shown 
below. Click this menu and select on from the displayed component types.

NOTE To create a ETN DS file for a device type other than the above types, enter an 
arbitrary device type name into the Device Type field and save it as a new file.

b. New Datasheet button

Creates a new ETN DS file using the selected template.

Reads a furnished template specified by the device type selection, opens new 
ETN DS file (measurement conditions and measurement data), and shows the 
measurement conditions and measurement data defined in the template in the in 
the Maximum Ratings, Characteristics Parameters, and Characteristics Graphs 
areas.
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c. Part Number

Enter a par number of your DUT. It is stored to the present ETN DS file.

d. Sample ID

Enter a Device ID to identify your DUT. It is stored to the present ETN DS file.

e. Description

Enter a device description and so on. It is stored to the present ETN DS file.

f. Operator

Enter operator information. It is stored to the present ETN DS file.

g. Measurement Instrument

Enter measurement instrument information. It is stored to the present ETN DS 
file.

h. Device Circuit Symbol

Displays the device circuit symbol corresponding to the selected device type. If 
you click over this field, the following pop-up menu is displayed.

System Picture 
Displays the default circuit symbol.

Import Picture 
Opens the Open Picture dialog box used to display a 
specified image file.

Clear Picture Clears the present picture.
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Maximum Ratings
This is an area to set up the maximum ratings of your DUT. The entered maximum 
rating values are used as the limits for the measurement conditions of the 
characteristics measurement items.

You can change the column order in this table by dragging a column header.

This area can be hidden or shown by clicking the line of  Maximum Ratings.

Figure 4-3 Maximum Ratings

a. Symbol

Symbol of a rating parameter. You can edit this by clicking on the text.

b. Parameter

Name of a rating parameter. You can edit this by clicking on the text.

c. Test Condition

Applicable condition for a rating parameter. You can edit this by clicking on the 
text. To close the expanded edition fields, click the Close button .

d. Value

Rating value. You can edit this by clicking on the text. To close the expanded 
edition fields, click the Close button .

e. Unit

Shows a unit for the rating value.

f. Note

Enter a remark for the rating value. It is stored to the present ETN DS file.

a b c d e f
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Characteristics Parameters
This is an area to set up the characteristics parameter measurements. A line has the 
measurement conditions for a characteristics parameter. 

To select a characteristics parameter, click on the blank space (excepting edition 
fields) of its row. The selected row is highlighted.

You can change the column order in this table by dragging a column header.

This area can be hidden or shown by clicking the line of  Characteristics 
Parameters.

Figure 4-4 Characteristics Parameters

a. Check box

Mark this for a characteristics parameter to be measured.

b. Measurement Priority

You can set the priority of the measurement execution for each measurement 
item. As default, all items are set to 1st priority. Click the button on the 
right-hand side of the check box to select the priority level.

: 1st priority
: 2nd priority
: 3rd priority

For the execution order of the measurement items, see “Execution Order of 
Measurement Items” on page 4-15.

c. Symbol

Symbol of a characteristics parameter. You can edit this by clicking on the text.

d. Parameter

a b c d e f g h i j
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Name of a characteristics parameter. You can edit this by clicking on the text.

e. Test Conditions

Measurement condition values to measure a characteristics parameter. You can 
edit this by clicking on the text. To close the expanded edition fields, click the 
Close button .

f. Min.

Lower limit value of the expected range for the measured characteristics 
parameter value. Leave a blank if there is no lower limit.

g. Act.

Shows an actual measured value of a characteristics parameter.

The measured value is displayed in red italic type if it is out of the expected 
range from “Min.” to “Max.”.

h. Max.

Upper limit value of the expected range for the measured characteristics 
parameter value. Leave a blank if there is no upper limit.

i. Unit

Unit for a characteristics parameter.

j. Note

Enter a remark for the characteristics parameter value. It is stored to the present 
ETN DS file.

Characteristics Graphs
This is an area to set up the measurements for obtaining the characteristics graphs. 
Set the measurement conditions on each graph.

To select a characteristics graph, click on the graph. The outer frame of the selected 
graph is highlighted.

This area can be hidden or shown by clicking the line of  Characteristics Graphs.
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Figure 4-5 Characteristics Graphs

a. Check box

Mark this for a characteristics graph to be measured.

b. Measurement Priority

You can set the priority of the measurement execution for each measurement 
item. As default, all items are set to 1st priority. Click the button on the 
right-hand side of the check box to select the priority level.

: 1st priority
: 2nd priority
: 3rd priority

For the execution order of the measurement items, see “Execution Order of 
Measurement Items” on page 4-15.

c. Graph tool button

Shows or hides the graph tools at the top of the graph.

d. Graph tools

You can do below using the graph tools.

• Trace Representation

You can select one from the following trace representations.

a

c

e

d

b
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The curves can be represented as Line, Dot, or combination (Line & Dot). 
Select any trace representation using the radio buttons shown in the bottom 
part of the graph.

• Line

Plots a line between two measurement points.

• Dot

Represents the measurement points by dots.

• Line & Dot

Represents the measurement points by dots and plots a line between two 
measurement points.

• Trace label button

Shows or hides labels to distinguish multiple traces on the graph.

• X/Y-axes scales

You can select scales for the X and Y-axes from the following.

• Linear

Linear scale

• PositiveLog

Logarithm scale for positive data

• NegativeLog

Logarithm scale for negative data

e. Graph

Shows the measured characteristics graph.

You can change the minimum and maximum values on the X and Y-axes by 
clicking on the values.

For X and Y-axes of the voltage or current output values, enter the minimum and 
maximum values on X and Y-axes to specify the measurement range.
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Execution Order of Measurement Items
After starting the measurement, the marked measurement items are executed in the 
following order, depending on the measurement priority setting, the kind of 
measurement, the location of the measurement item, and need of the adapter 
changing.

1. Measurement Items related to I/V or Capacitance Measurement

a. 1st Priority Measurement items

1. Measurement Items in the Characteristics Parameters area are executed 
in the order from top to bottom.

2. Measurement items in the Characteristics Graphs area are executed in 
the order of top left, top right, left on second row, right on second row, ..., 
bottom left, and bottom right.

b. 2nd Priority Measurement Items

1. Measurement Items in the Characteristics Parameters area are executed 
in the order from top to bottom.

2. Measurement items in the Characteristics Graphs area are executed in 
the order of top left, top right, left on second row, right on second row, ..., 
bottom left, and bottom right.

c. 3rd Priority Measurement Items

1. Measurement Items in the Characteristics Parameters area are executed 
in the order from top to bottom.

2. Measurement items in the Characteristics Graphs area are executed in 
the order of top left, top right, left on second row, right on second row, ..., 
bottom left, and bottom right.

2. (Changing operation of the adapter)

3. Measurement Items related to Gate Charge Measurement

a. 1st Priority Measurement items

1. Measurement Items in the Characteristics Parameters area are executed 
in the order from top to bottom.

2. Measurement items in the Characteristics Graphs area are executed in 
the order of top left, top right, left on second row, right on second row, ..., 
bottom left, and bottom right.
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b. 2nd Priority Measurement Items

1. Measurement Items in the Characteristics Parameters area are executed 
in the order from top to bottom.

2. Measurement items in the Characteristics Graphs area are executed in 
the order of top left, top right, left on second row, right on second row, ..., 
bottom left, and bottom right.

c. 3rd Priority Measurement Items

1. Measurement Items in the Characteristics Parameters area are executed 
in the order from top to bottom.

2. Measurement items in the Characteristics Graphs area are executed in 
the order of top left, top right, left on second row, right on second row, ..., 
bottom left, and bottom right.

Automatic Data Save
This area sets the automatic saving for all setup data including the measurement 
conditions and all measurement data. These data are automatically saved to a new 
ETN DS file in the specified folder at the end of the measurement.

The Data folder and Recent data fields can be shown or hidden by clicking the line 
of  Automatic Data Save.

Figure 4-6 Automatic Data Save

Device ID Enter device ID string to the Device ID field. The maximum 10 
recently-entered device IDs can be kept as history, and you can 
also select one from the history list.

The entered device ID is automatically saved to the ETN DS 
file at the end of the measurement.

You can also change the device ID in the latest ETN DS file 
after the measurement here. To change it, change the device ID 
in the Device ID field, and then click the Apply button .

Comment Enter a comment string to the Comment field.

The entered comment is automatically saved to the ETN DS file 
at the end of the measurement.
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You can also change the comment in the latest ETN DS file 
after the measurement here. To change it, change the comment 
in the Comment field, and then click the Apply button .

Data The Data field shows the latest auto-saved or last-opened ETN 
DS file name. You can do the following operations.

• Open the ETN DS file by clicking the Open button .

• Rename the ETN DS file by clicking the ETN DS file name.

• Delete the ETN DS file by clicking the Delete button .

Data folder Shows the absolute path of the auto-saved ETN DS file To 
change this, click the Browse button to open the folder selection 
dialog box. Select your desired folder in the dialog box.

For the initial setting of the data folder, see “Summary of Files” 
on page 4-88.

Recent data Shows up to 10 auto-saved ETN DS files that were 
automatically saved recently, in the hyper-link format. Clicking 
the hyper-link opens the selected ETN DS file This destroys the 
presently-editing data.

If the number of the auto-saved ETN DS files is over ten, this 
field shows “more...”. Clicking this opens the file selection 
dialog box. Select a ETN DS file to open.
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Toolbar

Figure 4-7 Toolbar

The toolbar has five tool button groups. The following shows the tool buttons in the 
tool button groups.

File tool button group

Open Opens the Open File dialog box used to open a specified ETN 
DS file. All present setup data and measurement data are 
cleared by opening the file.

Save Saves the present setup data and measurement data as the same 
file name.

Print Prints the present setup data and measurement data to the 
specified printer in the datasheet format, or to a document file 
in the XPS or PDF format.

Exit Exits the datasheet characterization software. Unsaved data is 
destroyed.

Edit tool button group

Cut Moves the selected text to the clipboard.

Copy Copies the selected text to the clipboard.

Paste Pastes the text from the clipboard to the insertion point.

On-screen 
keyboard

Displays the on-screen keyboard.
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Measurement tool button group

Start without 
data cleared

Starts to measure the marked measurement items in sequence. 
At the starting point, the existing measurement data for the all 
measurement items is cleared. During the measurement, the 
measurement status indicator on the front panel lights up.

Start with data 
cleared

Starts to measure the marked measurement items in sequence. 
At the starting point, the existing measurement data for the 
marked measurement items is cleared, but the measurement 
data for the unmarked items is retained. If the measurement is 
aborted, the measurement data acquired before aborting is 
retained. During the measurement, the measurement status 
indicator on the front panel lights up.

NOTE The above two Start buttons are switched depending on the 
setting of the Start Options described below.

Stop 
Measurement

Stops the measurement.

You can also use the Measurement > Stop menu or the Stop 
key on the front panel to stop the measurement.

Start Options Displays the following menu items to set the option for the 
Start tool button.

• Without data cleared

• With data cleared

Setup tool button group

All Check/
Uncheck

This button indicates three statuses whether all of the 
measurement items (characteristics parameters and graphs) 
are objects to be measured.

This status shows that all measurement items are not objects 
to be measured. If clicking this button under this status, the 
check boxes of all measurement items are marked to set to 
objects to be measured.

This status shows that some measurement items are objects to 
be measured. If clicking this button under this status, the 
check boxes of all measurement items are marked to set to 
objects to be measured.
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This status shows that all measurement items are objects to be 
measured. If clicking this button under this status, the check 
boxes of all measurement items are unmarked to set to no 
objects to be measured.

Setup Launches one of the following software corresponding to the 
highlighted (selected) measurement item of Characteristics 
Parameters or Characteristics Graphs and displays its setup 
and measurement data.

• “I/V Measurement Software”

• “Capacitance Measurement Software”

• “Gate Charge Measurement Software”

On this software, you can change typical measurement 
conditions and perform measurement for this item.

Saving data on this software will send the data to the 
datasheet characterization software GUI, too. It does not save 
the ETN DS file.

Add Maximum 
Rating

Opens the Maximum Rating Properties dialog box (page 
4-30). Setting up the new item’s properties adds it to the 
Maximum Ratings.

Add 
Characteristics 
Parameter

Opens the Open Data dialog box. And selecting the original 
data file for the new item opens the Characteristics Parameter 
Properties dialog box (page 4-30). Setting up the new item’s 
properties adds it to the Characteristics Parameters.

Add 
Characteristics 
Graph

Opens the Open Data dialog box. And selecting the original 
data file for the new item opens the Characteristics Graph 
Properties dialog box (page 4-33). Setting up the new item’s 
properties adds it to the Characteristics Graphs.

Import Imports data in a measurement data file created by other 
measurement software to the setup and measurement data of 
the measurement item highlighted (selected) in the 
Characteristics Parameter area or Characteristic Graphs area.

It is useful when you need to import the existing data to a new 
additional measurement item or replace the setup and 
measurement data with the existing data.
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Duplicate Makes a duplicate of the measurement item highlighted 
(selected) in the Characteristics Parameters area or 
Characteristics Graphs area. 
The duplicated item is placed after the highlighted item.

It is useful when you need to measure the same characteristics 
parameter with multiple conditions.

Move Up Moves the highlighted (selected) item upward.

Move Down Moves the highlighted (selected) item downward.

Properties If an item of the Maximum Ratings is highlighted (selected), 
opens the Maximum Rating Properties dialog box (page 4-30) 
with its properties.

If an item of the Characteristics Parameters is highlighted 
(selected), opens the Characteristics Parameter Properties 
dialog box (page 4-30) with its properties.

If an item of the Characteristics Graphs is highlighted 
(selected), opens the Characteristics Graph Properties dialog 
box (page 4-33) with its properties.

Edit Setup Launches one of the following software corresponding to the 
highlighted (selected) measurement item of Characteristics 
Parameters or Characteristics Graphs and displays its setup 
and measurement data.

• “I/V Measurement Software”

• “Capacitance Measurement Software”

• “Gate Charge Measurement Software”

On this software, you can change all measurement conditions 
and perform measurement for this item.

Saving data on this software will send the data to the 
datasheet characterization software GUI, too. It does not save 
the ETN DS file.

Recycle Restores the deleted item from the recycle bin.
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Delete Deletes the measurement item highlighted (selected) in the 
Characteristics Parameters area or Characteristics Graphs 
area.

View tool button group

Page Up Scrolls up.

Page Down Scrolls down.

Go to Palette Displays the software palette in fullscreen mode.
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Main Menu

Figure 4-8 Main Menu

The following describes the functions of the main menu.

File Menu Displays the following menu items to operate the ETN DS file. For the file types 
and extensions, see “Summary of Files” on page 4-36.

New Clears all present setup data and measurement data to start from 
initial setting.

Open... Opens the Open File dialog box used to open a specified ETN 
DS file. All present setup data and measurement data are 
cleared by opening the file.

Save Saves the present setup data and measurement data as the same 
file name.

Save As... Opens the Save Data File dialog box used to save the present 
setup data and measurement data as the specified file.

You can also save the data in a XPS (XML Paper Specification) 
format (.xps file) or a tab-separated values format (.txt file).

Print... Prints the present setup data and measurement data to the 
specified printer in the datasheet format, or to a document file in 
the XPS format.

To print to an XPS file, select the Microsoft XPS Document 
Writer as a printer in the Print dialog box.

If the PDF Writer/Printer is available, you can also print the 
present setup data and measurement data to a document file in 
the PDF format.

Change Device 
ID... Changes the device ID recorded in the ETN DS file

This opens the Change Device ID dialog box, and changes the 
device ID recorded in the selected ETN DS file(s). See “Change 
Device ID dialog box” on page 4-29.

Report... Opens the Datasheet Reporter (page 4-35).
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Collects the measurement data for all of the Characteristics 
Parameters measurement items included in one or more ETN 
DS files and saves it in a tab-separated values format (.txt file).

Data of one ETN DS file is arranged in a row. Each row 
contains the Device ID, the ETN DS file name, and the 
measurement data for all of the Characteristics Parameters 
measurement items included in the file.

Recent Setup Files 
Lists a maximum of 10 names of the ETN DS files that were 
recently edited, as menu items. You can easily open a ETN DS 
file by using them.

Exit Exits the datasheet characterization software. Unsaved data is 
destroyed.

Edit Menu Displays the following menu items to edit the setup.

Cut Moves the selected text to the clipboard.

Copy Copies the selected text to the clipboard.

Paste Pastes the text from the clipboard to the insertion point.

On-screen 
keyboard... Displays the on-screen keyboard.

View Menu Displays the following menu items for the display setting.

Go to Palette Displays the software palette in fullscreen mode.

Page Displays the following menu items used the page scrolling.

Up Scrolls up.

Down Scrolls down.

Main Window Displays the following menu item.

Fullscreen Changes the display style of the main 
window.

If this is marked, the main window does not 
have the titlebar and is displayed in 
fullscreen mode.

If this is unmarked, the main window has 
the titlebar and is displayed in the regular 
window style.
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This is initially marked.

Color Settings... Opens the Color Setting dialog box to set the color for parts in 
this software. See “Color Setting dialog box” on page 4-29.

Measurement 
Menu

Displays the following menu items for controlling the measurement.

Start with data 
cleared Starts to measure the marked measurement items in sequence. 

At the starting point, the existing measurement data for the all 
measurement items is cleared. During the measurement, the 
measurement status indicator on the front panel lights up.

Start without data 
cleared Starts to measure the marked measurement items in sequence. 

At the starting point, the existing measurement data for the 
marked measurement items is cleared, but the measurement 
data for the unmarked items is retained. If the measurement is 
aborted, the measurement data acquired before aborting is 
retained. During the measurement, the measurement status 
indicator on the front panel lights up.

Stop Stops the measurement.

You can also use the Stop Measurement button  on the toolbar 
or the Stop key on the front panel to stop the measurement.

Options Sets the measurement execution option.

• Stop if an actual value is out of range

While this option has been checked, the measurement stops 
automatically if the measurement result (Act.) is out of the 
range from Min. to Max. for a Characteristics Parameters 
item. Measurements for the next items are not performed.

Setup Menu Displays the following menu items for setting up the measurement items.

Check All Marks the check boxes of all characteristics parameters and 
graphs to measure all of them.

Uncheck All Unmarks the check boxes of all characteristics parameters and 
graphs to not measure all of them.

Setup Launches one of the following software corresponding to the 
highlighted (selected) measurement item of Characteristics 
Parameters or Characteristics Graphs and displays its setup and 
measurement data.
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• “I/V Measurement Software”

• “Capacitance Measurement Software”

• “Gate Charge Measurement Software”

On this software, you can change typical measurement 
conditions and perform measurement for this item.

Saving data on this software will send the data to the datasheet 
characterization software GUI, too. It does not save the ETN 
DS file.

Add Adds new items by using the following sub-menu.

• Maximum Rating

Opens the Maximum Rating Properties dialog box (page 
4-30). Setting up the new item’s properties adds it to the 
Maximum Ratings.

• Characteristics Parameter

Opens the Open Data dialog box. And selecting the original 
data file for the new item opens the Characteristics 
Parameter Properties dialog box (page 4-30). Setting up the 
new item’s properties adds it to the Characteristics 
Parameters.

• Characteristics Graph

Opens the Open Data dialog box. And selecting the original 
data file for the new item opens the Characteristics Graph 
Properties dialog box (page 4-33). Setting up the new item’s 
properties adds it to the Characteristics Graphs.

Import Imports data in a measurement data file created by the 
following measurement software to the setup and measurement 
data of the measurement item highlighted (selected) in the 
Characteristics Parameter area or Characteristic Graphs area.

• “I/V Measurement Software”

• “Capacitance Measurement Software”

• “Gate Charge Measurement Software”

Data import can be done as follows.

1. Highlight (select) the target measurement item.
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2. Select Setup > Import menu.

The Open Data dialog box opens.
As the initial importing folder, the initial saving folder of 
the measurement software related to the highlighted item is 
opened.

3. Select a measurement data file to import the setup and 
measurement data corresponding to the highlighted item.

As above, the existing the setup and measurement data for the 
highlighted item are cleared, and the setup and measurement 
data are imported from the specified measurement data file.

It is useful when you need to import the existing data to a new 
additional measurement item or replace the setup and 
measurement data with the existing data.

Duplicate Makes a duplicate of the measurement item highlighted 
(selected) in the Characteristics Parameters area or 
Characteristics Graphs area.

Duplicate can be done as follows.

1. Highlight (select) the target measurement item.

2. Select Setup > Duplicate menu.
The duplicated item is placed after the highlighted item.

It is useful when you need to measure the same characteristics 
parameter with multiple conditions.

Move Up Moves the highlighted (selected) item upward.

Move Down Moves the highlighted (selected) item downward.

Properties If an item of the Maximum Ratings is highlighted (selected), 
opens the Maximum Rating Properties dialog box (page 4-30) 
with its properties.

If an item of the Characteristics Parameters is highlighted 
(selected), opens the Characteristics Parameter Properties 
dialog box (page 4-30) with its properties.

If an item of the Characteristics Graphs is highlighted 
(selected), opens the Characteristics Graph Properties dialog 
box (page 4-33) with its properties.
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Edit Setup Launches one of the following software corresponding to the 
highlighted (selected) measurement item of Characteristics 
Parameters or Characteristics Graphs and displays its setup and 
measurement data.

• “I/V Measurement Software”

• “Capacitance Measurement Software”

• “Gate Charge Measurement Software”

On this software, you can change all measurement conditions 
and perform measurement for this item.

Saving data on this software will send the data to the datasheet 
characterization software GUI, too. It does not save the ETN 
DS file.

Recycle Restores the deleted item from the recycle bin.

Delete Deletes the measurement item highlighted (selected) in the 
Characteristics Parameters area or Characteristics Graphs area.

Configuration Menu Displays the following menu item to administrate the configuration of the built-in 
modules in the mainframe and test fixture.

Module... Opens the Module Configuration dialog box. See “Module 
Configuration Dialog Box” on page 4-183.

Help Menu Displays the following menu item.

About... Opens the about box. See “About box” on page 4-35.
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Dialog Boxes

Change Device ID dialog box
This dialog box is used to change the device ID in all selected ETN DS files at once.

This dialog box is opened by selecting the main menu File > Change Device ID....

Device ID field Enter a new device ID. You can also select it from the history.

Add... button Opens the file selection dialog box to select the ETN DS file(s) 
that you want to change the device ID. The selected ETN DS 
files are displayed into the list.

Remove button Excludes the selected ETN DS file from the list.

Execute button Changes the device ID.

Close button Closes this dialog box.

Color Setting dialog box
This dialog box is used to set colors of the following parts in this software. The 
setting in the Color Setting dialog box is saved as a user setting.

• Window Background

• Graph Background

• Graph Axis

• Graph Grid

• Graph Text

• Trace

This dialog box is opened by selecting the main menu View > Color Settings....

Clicking the color pattern opens the dialog box for selecting a color.

Apply button Applies the present setting to the graph.

Reset button Resets to the default setting.

OK button Applies the present setting to the graph, and closes this dialog 
box.

Cancel button Closes this dialog box without applying the present setting.
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Maximum Rating Properties dialog box
This dialog box is used to display and edit the properties of the item (rating 
parameter) highlighted (selected) in the Maximum Ratings.

Parameter Sets the following properties corresponding to the display/entry 
fields in the Maximum Ratings.

Symbol Symbol to identify the rating parameter

Parameter Name or description

Value Sets the maximum rating value (Point) or 
the allowable range (Range).

Unit Unit

Note Note or comment

Test Conditions Sets the condition corresponding to the Test Conditions field in 
the Maximum Ratings. Sets the applicable condition for the 
rating parameter by the Text, Parameter, or Range format.

Text Specify the applicable condition by text.

Parameter Specify the applicable condition name, the 
applicable value, and the unit.

Range Specify the applicable condition name, the 
applicable range, and the unit.

OK button Applies the present setting, and closes this dialog box.

Cancel button Closes this dialog box without applying the present setting.

Characteristics Parameter Properties dialog box
This dialog box is used to display and edit the properties of the item (measurement 
parameter) highlighted (selected) in the Characteristics Parameters.

Parameter Specifies the measurement data file of the software used for this 
parameter measurement, and sets the properties corresponding 
to the display/entry fields in the Characteristics Parameters.

Data File Name of the measurement data file

Symbol Symbol to identify the measurement 
parameter

Parameter Name or description
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Domain, Value Associates the measurement parameter 
(Act., measurement result value) with the 
variable used in the measurement software. 
See “Value and Domain” on page 4-31.

Minimum, 
Maximum Minimum value (Min.) and maximum 

value (Max.)

See “Minimum and Maximum” on page 
4-32.

Unit Unit

Note Note or comment

Test Conditions Defines the setup parameters corresponding to the Test 
Conditions field in the Characteristics Parameters. Multiple 
parameters can be set.

Symbol Symbol to identify the setup parameter

Parameter Name or description

Value Setup value

Unit Unit

Rating Symbol Maximum rating

Selects the maximum rating applied to this 
setup parameter from the drop down menu 
(optional).

Setup, Gain, 
Offset Associates this setup parameter with the 

setup item used in the measurement 
software. See “Setup, Gain, and Offset” on 
page 4-32.

To add/delete/up/down the setup parameter, use the buttons 
located in the upper right portion of the dialog box.

OK button Applies the present setting, and closes this dialog box.

Cancel button Closes this dialog box without applying the present setting.

Value and Domain. 
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These fields are used to associate the measurement parameter (Act., measurement 
result value) with the variable used in the measurement software.

Value Variable corresponding to the measurement parameter

Domain Variable other than the one set to Value. For example, set the 
variable used for the sweep output.

Measurement result of the parameter is the Act. value given by the following 
formula. And it is displayed in the Act. field in the Characteristics Parameters.

Act. = Data × Gain + Offset

Where, Data, Gain, and Offset are the following values.

• Data: Actual measurement value given by the variable set to the Value field

• Gain: Value of the Gain field right next to the Value field

• Offset: Value of the Offset field right next to the Gain field

The variable set to the Domain field is used if an exception occurs during the 
measurement. For example, it is used for extracting the last effective data if the 
sweep stops automatically when measuring the parameter given by the sweep 
measurement results.

Minimum and Maximum. 
These fields are used to set the minimum and maximum values of the measurement 
parameter. They are corresponding to the Min. and Max. fields in the Characteristics 
Parameters. If the field is blank, the minimum/maximum value is not set.

There is the Setup field (optional) right next to these fields. This field is used to 
associate the Minimum/Maximum field with the setup item used in the measurement 
software. If the Setup field is set, the A value given by the following formula is set to 
the setup item. Where, Gain/Offset is the value of the Gain/Offset field located 
below the Setup field.

A = Minimum × Gain + Offset or Maximum × Gain + Offset

Setup, Gain, and Offset. 
The Setup field (optional) is used to associate the setup parameter (Value field of 
Test Conditions) with the setup item used in the measurement software. If the Setup 
field is set, the A value given by the following formula is set to the setup item. 
Where, Gain/Offset is the value of the Gain/Offset field located below the Setup 
field.

A = Value × Gain + Offset
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Characteristics Graph Properties dialog box
This dialog box is used to display and edit the properties of the item (sweep 
measurement graph) highlighted (selected) in the Characteristics Graphs.

Data Specifies the measurement data file of the software used for this 
sweep measurement, and specifies the data plotted on the graph.

Data File Name of the measurement data file

X, Y Associates the X-Y data with the variables 
used in the measurement software. See “X 
and Y” on page 4-33. 

Data Aliases This function is effective for the graph 
which contains multiple traces. It can 
replace the variable name part (Key) of the 
trace label with the other string (Value).

For example on the ID-VDS graph, each 
trace has the label like VGS = x V. In this 
condition, if VGS is set to the Key field and 
Vg is set to the Value field, the label is 
changed to Vg = x V. 

To add/delete/up/down the Data Aliases, use the buttons located 
in the upper right portion of the Key/Value setup table.

Graph Sets the graph properties.

Title Title of the graph

Axes Sets the label and the unit of the X-axis and 
the Y-axis. See “Axes” on page 4-34. 

Scope Sets the graph scale. See “Scope” on page 
4-34. 

OK button Applies the present setting, and closes this dialog box.

Cancel button Closes this dialog box without applying the present setting.

X and Y. 
These fields are used to associate the X-Y data with the variables used in the 
measurement software.

X Variable corresponding to the X-axis data

Y Variable corresponding to the Y-axis data
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X-Y data is given by the following formula, and is plotted on the graph.

X or Y = Data × Gain + Offset

Where, Data, Gain, and Offset are the following values.

• Data: Measurement data given by the variable set to the X or Y field

• Gain: Value of the Gain field right next to the X or Y field

• Offset: Value of the Offset field right next to the Gain field

Axes. 
These fields are used to set the label and the unit of the X-axis and the Y-axis.

X Symbol for the X-axis

Y Symbol for the Y-axis

Description Name or description of the axis

Unit Unit of the X-axis or Y-axis data

The Description value is used for the label. If this field is blank, the symbol is used 
for the label.

Scope. 
These fields are used to set the graph scale of the X-axis and the Y-axis.

• Scale

Specifies the linear scale (Linear), the positive log scale (PositiveLog), or the 
negative log scale (NegativeLog).

There is the Setup field (optional) right next to this field. This field is used to 
associate the Scale field with the setup item used in the measurement software.

• Range: Minimum and Maximum

These fields are used to set the minimum and maximum values of the graph 
axes.

There is the Setup field (optional) right next to these fields. This field is used to 
associate the Minimum/Maximum field with the setup item used in the 
measurement software. If the Setup field is set, the A value given by the 
following formula is set to the setup item. Where, Gain/Offset is the value of the 
Gain/Offset field located below the Setup field.

A = Minimum × Gain + Offset or Maximum × Gain + Offset
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• Range: Rating Symbol (optional)

Selects the maximum rating applied to the value set to the Minimum/Maximum 
field from the drop down menu.

Datasheet Reporter
Datasheet Reporter provides the function to collect the measurement data for all of 
the Characteristics Parameters measurement items included in one or more ETN DS 
files and save it in a tab-separated values format (.txt file).

Add... Opens the Please select the file to open dialog box. The ETN 
DS files under this function must be added to the list of the 
Datasheet Reporter.

Remove Removes the highlighted (selected) ETN DS files from the list 
of the Datasheet Reporter.

Execute Opens the Please select the file to save dialog box. The 
Datasheet Reporter applies this function to all ETN DS files in 
the list.

Close Closes the Datasheet Reporter.

The created text file consists of one header line and multiple data lines. One data 
line is corresponding to one ETN DS file and contains the Device ID, the ETN DS 
file name, and the measurement data for all of the Characteristics Parameters 
measurement items included in the ETN DS file.

About box
The about box displays the model number, the software revision number, download 
URL for software updating, and so on.

This dialog box is opened by selecting the main menu Help > About....
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Summary of Files
The following shows the summary of the files handled by the datasheet 
characterization software.

Table 4-1 Summary of Files

File Type Description Extension Folder as Initial Setting

ETN DS file File only for this software. This has the 
measurement conditions and 
measurement data for all measurement 
items including the device ID and 
comment. 

The measurement conditions and 
measurement data are automatically 
saved to this file in the specified folder 
at the end of the measurement. And, 
you can also save this using the File 
menu anytime.

*.pda-ds.zip C:\Users\<user name>\
Documents\Keysight\Seri
esB150x\PowerDeviceAn
alyzer\Datasheet\DataSto
re
(You can change this)

Text output file This has the measurement conditions 
and measurement data for all 
measurement items including the 
device ID and comment in the text 
format. 

You can save this using the File menu 
anytime.

*.txt (You can specify the 
folder when saving the 
data)

I/V 
Measurement 
Data File

For importing. This is a measurement 
data file created by the I/V 
measurement software, and has the 
setup data and measurement data for 
the I/V measurement. 

*.pda-iv.txt C:\Users\<user name>\
Documents\Keysight\Seri
esB150x\PowerDeviceAn
alyzer\IV\DataStore
(You can change this)
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File name of ETN DS File on Auto-saving
An auto-saved ETN DS file is named as follows:

<DeviceID>_<TEMP>_<TIME>.pda-ds.zip

<DeviceID>:  Device ID

<TEMP>:  Temperature

<TIME>:  Time stamp on auto-saving

Example)
Device-1_@Ch1=30degC_Ch2=30degC_2014-10-30_18-56-55.pda-ds.zip

And, the file name is decided according to the following rule.

1. <TEMP> is the characters of the available thermometer identifiers and the 
thermometer readings. To enable thermometers, use the Thermal 
Monitor/Control Software. See “Thermal Monitor/Control Software” on page 
4-163.

@<thermometer>=<reading>degC

Capacitance 
Measurement 
Data File

For importing. This is a measurement 
data file created by the capacitance 
measurement software, and has the 
setup data and measurement data for 
the capacitance measurement. 

*.pda-cap.txt C:\Users\<user name>\
Documents\Keysight\
SeriesB150x\PowerDevic
eAnalyzer\DeviceCapacit
ance\DataStore
(You can change this)

Gate Charge 
Measurement 
Data File

For importing. This is a measurement 
data file created by the gate charge 
measurement software, and has the 
setup data and measurement data for 
the gate charge measurement. 

*.pda-qg.txt C:\Users\<user name>\
Documents\Keysight\
SeriesB150x\PowerDevic
eAnalyzer\GateCharge\D
ataStore
(You can change this)

XPS output file Output file in XPSa format *.xps (You can specify the 
folder when printing this 
file)

a. XPS (XML Paper Specification) is the standard document format on Windows.

File Type Description Extension Folder as Initial Setting
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• <thermometer>: An identifier of the available thermometer

Ch1 Channel 1 thermometer of B1506A

Ch2 Channel 2 thermometer of B1506A

Air Thermometer on the air outlet port of the thermostream

DUT Thermometer on the DUT port of the thermostream

• <reading>: A reading value of the thermometer in degrees centigrade

If multiple thermometers are available, the temperature information is 
concatenated by an underscore (_). The @ is attached only at the beginning 
of the temperature information. 

Example) @Ch1=25degC_Ch2=75degC_Air=100degC

2. <TIME> is the characters of year, month, day, hour, minute, and second. The 
time stamp representation depends on the time setting on Windows. And, an 
invalid character is replaced with an underscore (_).

Example 1) 2014-10-30_18-56-55
Example 2) 30-10-2014_6-56-55_PM

3. If the file name duplicates the existing file name, the serial number from 2 
enclosed by brackets is concatenated before the file extension.

Example)
Device-1_@Ch1=30degC_Ch2=30degC_2014-10-30_18-56-55(3).pda-ds.zip



B1506A User’s Guide, Edition 7 4-39

GUI Reference
Datasheet Characterization Software

Parameters Defined in Furnished Templates
This section provides the maximum ratings and characteristics measurement items 
defined in the representative templates furnished with this software.

MOSFET Template
The section shows the maximum ratings and characteristics measurement items 
defined in the template for the MOSFET devices using some tables.

The following table shows the maximum rating parameters defined in this template.

Table 4-2 Maximum Ratings

The following table shows the characteristics parameters that are defined in this 
template.

You can specify values to the parameters described in the Conditions column of the 
following table, as the measurement conditions. And, the rating parameter described 
in the Ratings column is used as the limit for the measurement conditions.

Table 4-3 Characteristics Parameters

Parameter Symbol

Drain to Source Voltage VDSS

Gate to Source Voltage VGSS

Pulsed Drain Current IDM

Pulsed Body Diode Current ISM

Parameter Symbol Conditions Ratings

Drain to Source Breakdown 
Voltage

BVDSS ID IDM

VGS VGSS

Drain Leakage Current IDSS VDS VDSS

VGS VGSS

Gate Leakage Current IGSS VGS VGSS

VDS VDSS
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Gate Leakage Current (-) a IGSS(-) VGS VGSS

VDS VDSS

Gate to Source Threshold Voltage b VGS(th) ID IDM

Gate to Source Threshold Voltage 
(Constant Drain to Source Voltage)

VGS(th) VDS VDSS

ID IDM

Transconductancec gfs VDS VDSS

ID IDM

Drain to Source On Resistance RDS(on) VGS VGSS

ID IDM

PulseWidth

Drain to Source On Voltage VDS(on) VGS VGSS

ID IDM

PulseWidth

Body Diode Forward Voltage VSD IS ISM

VGS VGSS

Gate Resistance Rg VGS VGSS

f

Input Capacitance Ciss VDS VDSS

VGS VGSS

f

Output Capacitance Coss VDS VDSS

VGS VGSS

f

Parameter Symbol Conditions Ratings
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The following table shows the characteristics graphs that are defined in this 
template.

Reverse Transfer Capacitance Crss VDS VDSS

VGS VGSS

f

Total Gate Charge Qg Vds VDSS

Vgs(on) VGSS

Vgs(off) VGSS

Id IDM

Gate to Source Charge Qgs Vds VDSS

Vgs(on) VGSS

Vgs(off) VGSS

Id IDM

Gate to Drain Charge Qgd Vds VDSS

Vgs(on) VGSS

Vgs(off) VGSS

Id IDM

Gate to Source Plateau Voltage Vgs(pl) Vds VDSS

Vgs(on) VGSS

Vgs(off) VGSS

Id IDM

a. This is a measurement with a negative voltage.
b. The same voltage is forced to between the drain-source terminals and 

the gate-source terminals at the measurement.
c. Available for the B1506A-H20/H21.

Parameter Symbol Conditions Ratings
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The X and Y in the Symbol column show the measurement data specified as the X 
and Y-axes data on the graph. And, the rating parameters in the X and Y of the 
Ratings column are used as the limit for the measurement conditions.

Table 4-4 Characteristics Graphs

The following describes about the symbols in the Conditions column of Table 4-3 
on page 4-39 and in the Symbols column of Table 4-4 on page 4-42.

Table 4-5 Glossary of MOSFET Template

Characteristics
Symbols Ratings

X Y X Y

Output Characteristics VDS ID VDSS IDM

Transfer Characteristics VGS ID VGSS IDM

Drain to Source Resistance vs. Drain 
Current

ID RDS IDM

Drain to Source Resistance vs. Gate to 
Source Voltage

VGS RDS VGSS

Drain to Source Voltage vs. Gate to Source 
Voltage

VGS VDS VGSS VDSS

Body Diode Forward Characteristics VSD IS VDSS ISM

Capacitances vs. Drain to Source Voltage VDS Ciss, 
Coss, 
Crss

VDSS

Gate Charge Characteristics Qg Vgs VGSS

Symbol Description

VGS Gate-source voltage

VDS Drain-source voltage

ID Drain current

PulseWidth Pulse width of drain current/voltage

f AC signal frequency
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IS Body diode forward current (source current)

VSD Body diode forward voltage (source-drain voltage)

RDS Drain-source resistance

Ciss Input capacitance

Coss Output capacitance

Crss Reverse transfer capacitance

Qg Gate charge

Vgs Gate-source voltage (gate charge measurement)

Vgs(on) Gate-source “On-state” voltage (gate charge measurement)

Vgs(off) Gate-source “Off-state” voltage (gate charge measurement)

Vds Drain-source “Off-state” voltage (gate charge measurement)

Id Drain “On-state” current (gate charge measurement)

Symbol Description
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IGBT Template
The section shows the maximum ratings and characteristics measurement items 
defined in the template for the IGBT devices using some tables.

The following table shows the maximum rating parameters defined in this template.

Table 4-6 Maximum Ratings

The following table shows the characteristics parameters that are defined in this 
template.

You can specify values to the parameters described in the Conditions column of the 
following table, as the measurement conditions. And, the rating parameter described 
in the Ratings column is used as the limit for the measurement conditions.

Table 4-7 Characteristics Parameters

Parameter Symbol

Collector to Emitter Voltage VCES

Gate to Emitter Voltage VGES

Pulsed Collector Current ICM

Pulsed Freewheeling Diode Current IFM

Parameter Symbol Conditions Ratings

Collector to Emitter Breakdown 
Voltage

BVCES IC ICM

VGE VGES

Collector Leakage Current ICES VCE VCES

VGE VGES

Gate Leakage Current IGES VGE VGES

VCE VCES

Gate Leakage Current (-) a IGES(-) VGE VGES

VCE VCES

Gate to Emitter Threshold Voltageb VGE(th) IC ICM



B1506A User’s Guide, Edition 7 4-45

GUI Reference
Datasheet Characterization Software

Gate to Emitter Threshold Voltage 
(Constant Collector to Emitter 
Voltage)

VGE(th) VCE VCES

IC ICM

Collector to Emitter Saturation 
Voltage

VCE(sat) VGE VGES

IC ICM

PulseWidth

Transconductancec gfs VCE VCES

IC ICM

Freewheeling Diode Forward 
Voltage

VF IF IFM

VF VCES

Gate Resistance Rg VGE VGES

f

Input Capacitance Cies VCE VCES

VGE VGES

f

Output Capacitance Coes VCE VCES

VGE VGES

f

Reverse Transfer Capacitance Cres VCE VCES

VGE VGES

f

Total Gate Charge Qg Vce VCES

Vge(on) VGES

Vge(off) VGES

IC ICM

Parameter Symbol Conditions Ratings
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The following table shows the characteristics graphs that are defined in this 
template.

The X and Y in the Symbol column show the measurement data specified as the X 
and Y-axes data on the graph. And, the rating parameters in the X and Y of the 
Ratings column are used as the limit for the measurement conditions.

Gate to Emitter Charge Qge Vce VCES

Vge(on) VGES

Vge(off) VGES

Ic ICM

Gate to Collector Charge Qgc Vce VCES

Vge(on) VGES

Vge(off) VGES

Ic ICM

Gate to Emitter Plateau Voltage Vge(pl) Vce VCES

Vge(on) VGES

Vge(off) VGES

Ic ICM

a. This is a measurement with a negative voltage.
b. The same voltage is forced to between the collector-emitter terminals 

and the gate-emitter terminals at the measurement.
c. Available for the B1506A-H20/H21.

Parameter Symbol Conditions Ratings
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Table 4-8 Characteristics Graphs

The following describes about the symbols in the Conditions column of Table 4-7 
on page 4-44 and in the Symbols column of Table 4-8 on page 4-47.

Table 4-9 Glossary of IGBT Template

Characteristics
Symbols Ratings

X Y X Y

Output Characteristics VCE IC VCES ICM

Transfer Characteristics VGE IC VGES ICM

Collector to Emitter Voltage vs. Gate to 
Emitter Voltage

VCE VGE VCES VGES

Freewheeling Diode Forward 
Characteristics

VF IF VCES IFM

Capacitances vs. Collector to Emitter 
Voltage

VCE Cies, 
Coes, 
Cres

VCES

Gate Charge Characteristics Qg Vge VGES

Symbol Description

VGE Gate-emitter voltage

VCE Collector-emitter voltage

IC Collector current

PulseWidth Pulse width of collector current/voltage

f AC signal frequency

IF Free-wheel diode forward current

VF Free-wheel diode forward voltage

Cies Input capacitance

Coes Output capacitance
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Cres Reverse transfer capacitance

Qg Gate charge

Vge Gate-emitter voltage (gate charge measurement)

Vge(on) Gate-emitter “On-state” voltage (gate charge measurement)

Vge(off) Gate-emitter “Off-state” voltage (gate charge measurement)

Vce Collector-emitter “Off-state” voltage (gate charge measurement)

Ic Collector “On-state” current (gate charge measurement)

Symbol Description
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BJT Template
The section shows the maximum ratings and characteristics measurement items 
defined in the template for the BJT devices using some tables.

The following table shows the maximum rating parameters defined in this template.

Table 4-10 Maximum Ratings

The following table shows the characteristics parameters that are defined in this 
template.

You can specify values to the parameters described in the Conditions column of the 
following table, as the measurement conditions. And, the rating parameter described 
in the Ratings column is used as the limit for the measurement conditions.

Table 4-11 Characteristics Parameters

Parameter Symbol

Collector-Emitter Voltage VCEO

Collector-Base Voltage VCBO

Emitter-Base Voltage VEBO

Collector Current IC

Pulsed Collector Current ICM

Base Current IB

Total Power Dissipation PD

Operating Junction Temperature Tj

Parameter Symbol Conditions Ratings

Collector Cutoff Current ICEO VCE VCEO

IB IB

Emitter Cutoff Current IEBO VEB VEBO

IC IC
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The following table shows the characteristics graphs that are defined in this 
template.

The X and Y in the Symbol column show the measurement data specified as the X 
and Y-axes data on the graph. And, the rating parameters in the X and Y of the 
Ratings column are used as the limit for the measurement conditions.

Table 4-12 Characteristics Graphs

DC Current Gaina hFE VCE VCEO

IC ICM

Collector-Emitter Saturation 
Voltage

VCE(sat) IC ICM

IB IB

Base-Emitter Saturation Voltage VBE(sat) IC ICM

IB IB

Base-Emitter ON Voltagea VBE(on) VCE VCEO

IC ICM

Collector-Emitter Breakdown 
Voltage

V(BR)CEO IC IC

IB IB

Emitter-Base Breakdown Voltage V(BR)EBO IE IB

IC IC

a. Available for the B1506A-H20/H21.

Parameter Symbol Conditions Ratings

Characteristics
Symbols Ratings

X Y X Y

Output Characteristics VCE IC VCE
O

ICM

DC Current Gaina IC hFE ICM

Base-Emitter Voltagea IC VBE ICM
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The following describes about the symbols in the Conditions column of Table 4-11 
on page 4-49 and in the Symbols column of Table 4-12 on page 4-50.

Table 4-13 Glossary of BJT Template

a. Available for the B1506A-H20/H21.

Symbol Description

VBE Base-emitter voltage

VEB Emitter-base voltage

IB Base current

IE Emitter current

VCE Collector-emitter voltage

IC Collector current

hFE DC current amplification factor
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Diode Template
The section shows the maximum ratings and characteristics measurement items 
defined in the template for the diodes using some tables.

The following table shows the maximum rating parameters defined in this template.

Table 4-14 Maximum Ratings

The following table shows the characteristics parameters that are defined in this 
template.

You can specify values to the parameters described in the Conditions column of the 
following table, as the measurement conditions. And, the rating parameter described 
in the Ratings column is used as the limit for the measurement conditions.

Table 4-15 Characteristics Parameters

The following table shows the characteristics graphs that are defined in this 
template.

The X and Y in the Symbol column show the measurement data specified as the X 
and Y-axes data on the graph. And, the rating parameters in the X and Y of the 
Ratings column are used as the limit for the measurement conditions.

Parameter Symbol

Reverse Voltage VR

Pulsed Forward Current IFM

Parameter Symbol Conditions Ratings

DC Blocking Voltage VDC IR

Forward Voltage VF IF IFM

Reverse Current IR VR VR

Total Capacitance CT VR VR

f



B1506A User’s Guide, Edition 7 4-53

GUI Reference
Datasheet Characterization Software

Table 4-16 Characteristics Graphs

The following describes about the symbols in the Conditions column of Table 4-15 
on page 4-52 and in the Symbols column of Table 4-16 on page 4-53.

Table 4-17 Glossary of Diode Template

Characteristics
Symbols Ratings

X Y X Y

Forward Characteristics VF IF IFM

Reverse Characteristics VR IR VR

Capacitance VR CT VR

Symbol Description

IR Reverse current

IF Forward current

VR Reverse voltage

f AC signal frequency

VF Forward voltage

CT Total capacitance
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Creating Custom File
This section introduces a procedure and essentials to create a new ETN DS file to be 
fitted to specific devices.

1. After starting this software, select the type of your device and then click the New 
Datasheet button  in the Identification area.

This reads the data from the selected template, and provides the foundation for a 
new ETN DS file.

2. Create a new ETN DS file with an appropriate name using the main menu File > 
Save as.

For example, if you specify CustomMOSFET as a new name, 
CustomMOSFET.pda-ds.zip file is created.

3. Open the ETN DS file (for example, CustomMOSFET) using the main menu 
File > Open. Skip this step if you operate continuously.

4. Customize the measurement conditions and so on with referring to the 
“Customization Essentials” below.

5. After finishing all customization, save all setup data and measurement data to 
the ETN DS file using the main menu File > Save.

To use the ETN DS file as a template for evaluating same device model, it is 
recommended to manage it with keeping from changing. When evaluating each 
individual device, use a copy of the ETN DS file

NOTE During opening the ETN DS file, don’t use the Device Type and New Datasheet 
button . If they are used, it rewrites all data by the furnished template.

Customization Essentials
• Customizing in the Identification area

• Enter appropriate information to the fields.

• Customizing in the Maximum Ratings area

• Review the maximum rating values, and change them to values appropriate 
for your device.

• Customizing in the Characteristics Parameters and Characteristics Graphs areas



B1506A User’s Guide, Edition 7 4-55

GUI Reference
Datasheet Characterization Software

• Review the measurement items, and delete unnecessary items.
To do so, highlight (select) a measurement item, and then click the Delete 
button  on the toolbar (or select Delete from the Setup menu).

• Review the measurement items, and make duplicates of the measurement 
item if you need to measure the same characteristics parameter/graph with 
multiple conditions.
To do so, highlight (select) a measurement item, and then click the Duplicate 
button  on the toolbar (or select Duplicate from the Setup menu).

• For the characteristics parameters, change the parameter values of the Test 
Conditions to new preset values appropriate for your device.

For the characteristics graphs, change the minimum and maximum values on 
the voltage/current axes to new preset output values appropriate for your 
device.

• Review the detailed settings for each measurement item, and change them if 
necessary.
To do so, highlight (select) a measurement item, and then click the Setup 
button  on the toolbar (or select Setup from the Setup menu).

A measurement software related to the highlighted item is launched with the 
detailed settings for the item.

Review the detailed settings on the launched measurement software, adjust 
them with executing the measurement. The measurement result is 
automatically reflected onto the datasheet characterization software GUI.

If you change the settings without executing the measurement on the 
launched measurement software, save new settings to the present 
measurement data file. The new settings saved into the measurement data 
file are reflected to the ETN DS file when saving the ETN DS file.

• Conveniently save the ETN DS file

By saving the ETN DS file, the changes on the launched measurement software 
are reflected to the ETN DS file

• After finishing to adjust the settings of all measurement items, mark the check 
boxes of all measurement items, start the datasheet characterization 
measurement for all items, and then check all results.
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I/V Measurement Software
I/V Measurement Software provides:

• Voltage/current sweep/spot measurements

• DC/pulse outputs

• Linear/log sweep with both single (one-way) and double (round-trip) capability 
for the primary sweep source (similar to the collector supply of a conventional 
curve tracer)

• Linear/list sweep capability for the secondary sweep source (corresponding to 
the step generator of a conventional curve tracer)

• The ability to assign the primary sweep source or the secondary sweep source to 
either the collector/drain terminal or to the base/gate terminal.

• Intuitive and interactive sweep/spot measurement operation using rotary knob.

• Predefined templates for typical MOSFET, IGBT and Diode I/V measurements.

I/V Measurement Software supports Oscilloscope View function in the pulse mode 
operation. At the specified measurement point on the characteristic trace, this 
function can monitor both voltage and current waveforms for the measurement 
channels of all supported modules. Oscilloscope View supports the following 
modules:

• MCSMU

• HVSMU

• HCSMU

• UHCU
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GUI Overview
The GUI (Graphical User Interface) of the I/V measurement software is comprised 
of the following areas.

Figure 4-9 I/V Measurement Software GUI

1. Work Area (See p. 4-58.)

This area provides the functions to set the measurement conditions and observe 
the measurement results. This is separated to the following areas.

a. Setup (See p. 4-58.)

b. Characteristics (See p. 4-74.)

c. Connections (See p. 4-80.)

2. Automatic Data Save (See p. 4-82.)

This area provides the functions regarding the automatic saving of the 
measurement data files.

3. Operating Tools

• Toolbar (See p. 4-83.)

3

a

b
c

2

1
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This provides the functions that are very frequently used in the button 
format.

• Main Menu (See p. 4-85.)

This provides the functions needed for various operations in the menu 
format.

For the dialog boxes displayed during this software operation, see “Dialog Boxes” 
on page 4-87.

For the files handled by this software, see “Summary of Files” on page 4-88.

Work Area
In this area, set the measurement conditions and observe the measurement results. 
This is separated to the following areas.

• Setup (See p. 4-58.)

• Characteristics (See p. 4-74.)

• Connections (See p. 4-80.)

Setup
This is an area to select the device type and its measured I/V characteristics, and 
enter your measurement conditions.

Figure 4-10 Setup

Device Type Select the device type of your DUT from below.

• MOSFET

• IGBT

• BJT

• Diode

• Generic2T
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This is for two-terminal general devices.

• Generic

Select the Generic to execute more general measurements for device other than 
above types.

MOSFET You can select one of the following I/V characteristics measurements for 
“MOSFET” device type.

• ID-VDS

Creates new settings to measure the output characteristics.

• ID-VGS

Creates new settings to measure the transfer characteristics.

• VGS(th)

Creates new settings to measure the threshold voltage.

• RDS-ID

Creates new settings to measure the drain-source resistance characteristics for 
the drain current.

• VDS-VGS

Creates new settings to measure the drain-source voltage characteristics for the 
gate-source voltage.

• RDS-VGS

Creates new settings to measure the drain-source resistance characteristics for 
the gate-source voltage.

• IDSS

Creates new settings to measure the drain leak current characteristics for the 
drain-source voltage.

• IGSS

Creates new settings to measure the gate leak current characteristics for the 
gate-source voltage.

• IS-VSD

Creates new settings to measure the forward characteristics of the body diode for 
the source-drain voltage.
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IGBT You can select one of the following I/V characteristics measurements for “IGBT” 
device type.

• IC-VCE

Creates new settings to measure the output characteristics.

• IC-VGE

Creates new settings to measure the transfer characteristics.

• VGE(th)

Creates new settings to measure the threshold voltage.

• VCE-VGE

Creates new settings to measure the collector-emitter voltage characteristics for 
the gate-emitter voltage.

• VCE(sat)

Creates new settings to measure the collector-emitter saturation voltage 
characteristics for the collector current.

• ICES

Creates new settings to measure the collector leak current characteristics for the 
collector-emitter voltage.

• IGES

Creates new settings to measure the gate leak current characteristics for the 
gate-emitter voltage.

• IF-VF

Creates new settings to measure the free-wheel diode forward characteristics.

BJT You can select one of the following I/V characteristics measurements for “BJT” 
device type.

• IC-VCE

Creates new settings to measure the output characteristics.

• hFE

Creates new settings to measure the DC current amplification factor 
characteristics (hFE-IC).

• VBE(on)
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Creates new settings to measure the base-emitter ON voltage characteristics 
(VBE-IC).

• ICEO

Creates new settings to measure the collector leakage current characteristics for 
the collector-emitter voltage with the base open condition.

• ICES

Creates new settings to measure the collector leakage current characteristics for 
the collector-emitter voltage with the base-emitter short condition.

• IEBO

Creates new settings to measure the emitter leakage current characteristics for 
the emitter-base voltage with the collector open condition.

Diode You can select one of the following I/V characteristics measurements for “Diode” 
device type.

• IF-VF

Creates new settings to measure the forward bias characteristics.

• IR-VR

Creates new settings to measure the reverse bias characteristics.

Generic2T You can select one of the following I/V characteristics measurements for 
“Generic2T” device type.

• Conduction

Creates new settings to measure the conduction resistance characteristics.

• Isolation

Creates new settings to measure the isolation characteristics.

Generic Set your measurement conditions in “General settings” on page 4-61, “Gate/Base 
drive settings” on page 4-63, and “Drain/Collector drive settings” on page 4-64 for 
“Generic” device type.

General settings In this area, you can set the following measurement conditions for DC output 
measurement or pulse output measurement.

For DC output measurement:

• Trace Mode
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Quick Performs fast staircase sweep measurement using the fixed 
range mode.

Fine Performs accurate staircase sweep measurement using the 
auto ranging mode.

• For Quick trace mode:

• Step Time

Specify the period between steps for the staircase sweep.
Setting range: 500 s to 5 s

• Aperture

Specify the measurement time at each step for the staircase sweep.
Setting range: 2 s to 20 ms

• Hold Time

Specify the hold time of the sweep start voltage. At the sweep start point, the 
start voltage is forced for more than the specified time.
Setting range: 0 to 655.35 s

• For Fine trace mode:

• NPLC

Set the measurement time by specifying the number of power line cycles.
Setting range: 1 to 100

• Delay Time

Specify the wait time until starting measurement since starting output at each 
step of the staircase sweep.
Setting range: 0 to 65.535 s

• Hold Time

Specify the hold time of the sweep start voltage. At the sweep start point, the 
start voltage is forced for more than the specified time.
Setting range: 0 to 655.35 s

For pulse output measurement:

• Auto Period

Enable or disable the automatic adjustment for the pulse period. To enable this, 
mark the check box.

• Pulse Period
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Specify the pulse period.
Setting range: 5 ms to 5 s
If the Auto Period is enabled, this is automatically adjusted to minimum period 
corresponding to the pulse width.

• Aperture

Specify the measurement time at each pulse.
Setting range: 2 s to 20 ms

• Hold Time

Specify the hold time of the sweep start voltage. At the sweep start point, the 
start voltage is forced for more than the specified time.
Setting range: 0 to 655.35 s

The following parameter can be shown or hidden by clicking the line of  Details.

• Aperture

• Hold Time

Gate/Base drive 
settings

Set the output voltage/current to the gate/base terminal. One of the following types 
is automatically selected depending on the selected characteristics measurement. 
The selected type is displayed on the title of this terminal setting area as shown in 
the following figure.

For the setting items of the types, see below.

• Bias (See p. 4-64.)
Outputs the constant bias voltage/current.

• Pulse Bias (See p. 4-65.)
Outputs the voltage or current pulse that the peak output is constant.
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• Step (See p. 4-66.)
Outputs the constant voltage/current that the level is changed every time a sweep 
measurement is finished.

• Pulse Step (See p. 4-67.)
Outputs the voltage/current pulse that the peak level is changed every time a 
sweep measurement is finished.

• Staircase Sweep (See p. 4-68.)
Outputs the staircase-swept voltage/current.

• Pulse Sweep (See p. 4-70.)
Outputs the staircase-swept pulse voltage/current.

Drain/Collector 
drive settings

Set the output voltage/current to the drain/collector terminal. One of the following 
types is automatically selected depending on the selected characteristics 
measurement. The selected type is displayed on the title of this terminal setting area.

For the setting items of the types, see below.

• Bias (See p. 4-64.)
Outputs the constant bias voltage/current.

• Pulse Bias (See p. 4-65.)
Outputs the voltage or current pulse that the peak output is constant.

• Step (See p. 4-66.)
Outputs the constant voltage/current that the level is changed every time a sweep 
measurement is finished.

• Pulse Step (See p. 4-67.)
Outputs the voltage/current pulse that the peak level is changed every time a 
sweep measurement is finished.

• Staircase Sweep (See p. 4-68.)
Outputs the staircase-swept voltage/current.

• Pulse Sweep (See p. 4-70.)
Outputs the staircase-swept pulse voltage/current.

Bias The terminal outputs the constant voltage or current.

Set the following parameters.

• Source

Specify an output voltage/current value.

The following parameters can be shown or hidden by clicking the line of  Details.
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• Resource/Output Mode/Output Sequence

You can change the settings of this terminal using the pull-down menu. For 
details, see “Resource/Output Mode/Output Sequence” on page 4-71.

• Compliance

Specify a current/voltage compliance value.
If the output exceeds this, the sweep measurement is terminated.

• Voltage Compliance

Specify a voltage compliance value for UHCU.
To enable this, mark the check box.
If the output exceeds this, the sweep measurement is terminated.
Available for UHCU.

Pulse Bias The terminal outputs the voltage or current pulse that the peak output is constant.

Set the following parameters.

• Source

Specify a pulse peak voltage/current value.

The following parameters can be shown or hidden by clicking the line of  Details.

• Resource/Output Mode/Output Sequence

You can change the settings of this terminal using the pull-down menu. For 
details, see “Resource/Output Mode/Output Sequence” on page 4-71.

• Base

Specify a pulse base voltage/current value.

• Compliance

Specify a current/voltage compliance value.
If the output exceeds this, the sweep measurement is terminated.

• Voltage Compliance

Specify a voltage compliance value for UHCU.
To enable this, mark the check box.
If the output exceeds this, the sweep measurement is terminated.
Available for UHCU.

• Pulse Delay
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Specify a delay time from the beginning point of the pulse period to the raising 
point.

• Pulse Width

Specify a period of the pulse peak.

Step The terminal outputs the constant voltage or current that the level is changed every 
time a sweep measurement is finished.

Set the following parameters.

• Step Mode

Select one from the following level change operation.

• LinearSingle: Constant level is changed by a constant step value.

• ListSingle: Constant level is changed according to the listed levels.

• Start

Specify the first step value.
Available for the “LinearSingle” Step Mode.

• Stop

Specify the last step value.
Available for the “LinearSingle” Step Mode.

The following parameters can be shown or hidden by clicking the line of  Details.

• Resource/Output Mode/Output Sequence

You can change the settings of this terminal using the pull-down menu. For 
details, see “Resource/Output Mode/Output Sequence” on page 4-71.

• Number of Step

Specify the number of steps.
Available for the “LinearSingle” Step Mode.

• List

Create the list of the output levels.
Available for the “ListSingle” Step Mode.

To insert a new step entry before the selected step value, click the Insert 
button .

To move the selected step value up/down, click the Move button .
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To delete the selected step value, click the Delete button .

• Compliance

Specify a current/voltage compliance value.
If the output exceeds this, the sweep measurement is terminated.

• Power Compliance

Specify the power compliance value.
To enable this, mark the check box.
If the output exceeds this, the sweep measurement is terminated.
Not available for HVSMU.

• Voltage Compliance

Specify a voltage compliance value for UHCU.
To enable this, mark the check box.
If the output exceeds this, the sweep measurement is terminated.
Available for UHCU.

Pulse Step The terminal outputs the voltage or current pulse that the peak level is changed 
every time a sweep measurement is finished.

Set the following parameters.

• Step Mode

Select one from the following level change operations.

• LinearSingle: Peak level is changed by a constant step value.

• ListSingle: Peak level is changed according to the listed levels.

• Start

Specify the first pulse peak value.
Available for the “LinearSingle” Step Mode.

• Stop

Specify the last pulse peak value.
Available for the “LinearSingle” Step Mode.

• List

Create the list of the output levels.
Available for the “ListSingle” Step Mode.

To insert a new step entry before the selected step value, click the Insert 
button .
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To move the selected step value up/down, click the Move button .

To delete the selected step value, click the Delete button .

The following parameters can be shown or hidden by clicking the line of  Details.

• Resource/Output Mode/Output Sequence

You can change the settings of this terminal using the pull-down menu. For 
details, see “Resource/Output Mode/Output Sequence” on page 4-71.

• Base

Specify a pulse base voltage/current value.

• Number of Step

Specify the number of steps.
Available for the “LinearSingle” Step Mode.

• Compliance

Specify a current/voltage compliance value.
If the output exceeds this, the sweep measurement is terminated.

• Power Compliance

Specify the power compliance value.
To enable this, mark the check box.
If the output exceeds this, the sweep measurement is terminated.
Not available for HVSMU.

• Voltage Compliance

Specify a voltage compliance value for UHCU.
To enable this, mark the check box.
If the output exceeds this, the sweep measurement is terminated.
Available for UHCU.

• Pulse Delay

Specify a delay time from the beginning point of the pulse period to the raising 
point.

• Pulse Width

Specify a period of the pulse peak.

Staircase Sweep The terminal outputs the staircase-swept voltage/current.

Set the following parameters.
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• Sweep Mode

Select one from the following sweep modes.

• LinearSingle (Sweep from start to stop in a linear incremental step)

• LogSingle (Sweep from start to stop in a logarithmic incremental step)

• LinearDouble (Sweep from start to stop to start in a linear incremental step)

• LogDouble (Sweep from start to stop to start in a logarithmic incremental 
step)

• Sweep Polarity

Select one from the following polarity modes.

• Bipolar (Sweep for both positive and negative layers)

• Positive (Sweep for positive layer only)

• Negative (Sweep for negative layer only)

• Start

Specify the sweep start value.

• Stop

Specify the sweep stop value.

The following parameters can be shown or hidden by clicking the line of  Details.

• Resource/Output Mode/Output Sequence

You can change the settings of this terminal using the pull-down menu. For 
details, see “Resource/Output Mode/Output Sequence” on page 4-71.

• Number of Step

Specify the number of sweep steps from start to stop.

• Compliance

Specify a current/voltage compliance value.
If the output exceeds this, the sweep measurement is terminated.

• Power Compliance

Specify the power compliance value.
To enable this, mark the check box.
If the output exceeds this, the sweep measurement is terminated.
Not available for HVSMU.
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• Voltage Compliance

Specify a voltage compliance value for UHCU.
To enable this, mark the check box.
If the output exceeds this, the sweep measurement is terminated.
Available for UHCU.

Pulse Sweep The terminal outputs the staircase-swept pulse voltage/current.

Set the following parameters.

• Sweep Mode

Select one from the following sweep modes.

• LinearSingle (Sweep from start to stop in a linear incremental step)

• LogSingle (Sweep from start to stop in a logarithmic incremental step)

• LinearDouble (Sweep from start to stop to start in a linear incremental step)

• LogDouble (Sweep from start to stop to start in a logarithmic incremental 
step)

• Sweep Polarity

Select one from the following polarity modes.

• Bipolar (Sweep for both positive and negative layers)

• Positive (Sweep for positive layer only)

• Negative (Sweep for negative layer only)

• Start

Specify the sweep start value.

• Stop

Specify the sweep stop value.

The following parameters can be shown or hidden by clicking the line of  Details.

• Resource/Output Mode/Output Sequence

You can change the settings of this terminal using the pull-down menu. For 
details, see “Resource/Output Mode/Output Sequence” on page 4-71.

• Base

Specify a pulse base voltage/current value.
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• Number of Step

Specify the number of sweep steps from start to stop.

• Compliance

Specify a current/voltage compliance value.
If the output exceeds this, the sweep measurement is terminated.

• Power Compliance

Specify the power compliance value.
To enable this, mark the check box.
If the output exceeds this, the sweep measurement is terminated.
Not available for HVSMU.

• Voltage Compliance

Specify a voltage compliance value for UHCU.
To enable this, mark the check box.
If the output exceeds this, the sweep measurement is terminated.
Available for UHCU.

• Pulse Delay

Specify a delay time from the beginning point of the pulse period to the raising 
point.

• Pulse Width

Specify a period of the pulse peak.

Resource/Output 
Mode/Output 
Sequence

Depending on the selected characteristics measurement, the pre-defined output 
mode and sequence are automatically selected. If necessary, you can change the 
measurement resource, the output mode, and the output sequence. Table 4-18 shows 
the available alternatives for the gate/base terminal, and Table 4-19 shows the 
available alternatives for the drain/collector terminal.
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Table 4-18 Available Resource/Output Mode/Output Sequence for Gate/Base Terminal

Measurement Resource Output Mode Output Sequence

• MCSMU

MCSMU is 
connected to this 
terminal.

• MPSMU

MPSMU is 
connected to this 
terminal.

• V

Specifies the DC 
voltage output.

• VPulse

Specifies the pulse 
voltage output.

• I

Specifies the DC 
current output.

• IPulse

Specifies the pulse 
current output.

• Constant

Specifies the 
constant bias output 
sequence.

• Step

Specifies the step 
bias output sequence.

• Sweep

Specifies the sweep 
output sequence.
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Table 4-19 Available Resource/Output Mode/Output Sequence for Drain/Collector 
Terminal

The combinations of the Output Mode and Output Sequence decide the types as 
shown in the following table.

Measurement Resource Output Mode Output Sequence

• Open

No connection.
This terminal is 
opened.

• UHCU a

UHCU is connected 
to this terminal.

• HCSMU b

HCSMU is 
connected to this 
terminal.

• HVSMU

HVSMU is 
connected to this 
terminal.

• MPSMU

MPSMU is 
connected to this 
terminal.

a. Available for B1506A-H50/H70/H51/H71. 
b. Available for B1506A-H20/H21. 

• V c

Specifies the DC 
voltage output.

• VPulse

Specifies the pulse 
voltage output.

• I c

Specifies the DC 
current output.

• IPulse

Specifies the pulse 
current output.

c. Not available for UHCU.

• Constant

Specifies the 
constant bias output 
sequence.

• Step

Specifies the step 
bias output sequence.

• Sweep

Specifies the sweep 
output sequence.
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Characteristics
This page shows the graph of the specified I/V characteristics as the measurement 
result. To display this page, click the Characteristics tab.

Figure 4-11 Characteristics

Type Output Mode Output Sequence

Bias V or I Constant

Pulse Bias VPulse or IPulse Constant

Step V or I Step

Pulse Step VPulse or IPulse Step

Staircase Sweep V or I Sweep

Pulse Sweep VPulse or IPulse Sweep

a
b

c ebd f

g
h
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a. Displaying 
Characteristic 
Curves

The data for the X and Y-axes are assigned according to the I/V characteristics 
specified in the Setup.

If the graph has multiple characteristic curves for different measurement conditions, 
the measurement conditions are displayed on the graph with the check boxes. 
Marking the check box displays the characteristic curve for the measurement 
condition. You can mark multiple check boxes for the measurement conditions.

You can change the minimum and maximum values on the X and Y-axes by clicking 
the value.

If a status other than normal is detected during the measurement, the status 
information icon appears. Clicking this icon shows the measurement status details.

b. Markers This graph supports two kinds of markers: Domain marker and Trace marker. You 
can switch these markers by clicking the Marker button shown in the bottom part of 
the graph.

 : Marker button when the Domain marker is used.
 : Marker button when the Trace marker is used.

The Domain marker can read multiple characteristic values for the X-axis position.

The Domain marker supports two markers (A and B). Marker A is always available. 
To use the Marker B, mark the check box for the Marker B. The Marker B is a break 
line. To move the marker position, use the rotary knob or mouse.

The marker annotation on the graph has X-axis values for markers, and a difference 
value () between the Marker B and A (BA). And, each curve annotation has 
Y-axis values and difference values () between the Marker B and A (BA).

The Trace marker can read the characteristic value with tracing each characteristic 
curve. It is useful when you want to read the characteristic value on double sweep 
result.

The marker annotation on the graph has X-axis value for the marker. And, the traced 
curve annotation has Y-axis value.

c. Trace 
Representation

The curves can be represented as Line, Dot, or combination (Line & Dot). Select 
any trace representation using the radio buttons shown in the bottom part of the 
graph.

d. Reference 
Traces

You can register the presently-displayed curves as reference traces to compare with 
other measurement results on the graph. If you register them as reference traces, the 
reference traces are displayed as dimmed thin lines on the graph when you open 
other measurement data files or execute the next measurement. To register as the 
reference traces, click the Capture button  shown in the bottom part of the graph.
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You can register a maximum of 10 reference traces. The measurement data files 
registered as the reference traces are listed in the References field under the Capture 
button . You can show or hide the reference traces using the check boxes at the 
head of the measurement data file names. The References field can be shown or 
hidden by clicking the line of the  button on top of the graph. 

To remove unnecessary reference traces, select the measurement data file in the 
References field, and then click the Remove button . 

The registration of the reference traces is cleared when you exit the I/V 
measurement software.

e. Auto Scale Clicking the Auto Scale button  fits the measurement data at that time in the 
graph scale.

If the auto scale mode is selected by using the Scale mode button, the measurement 
data is automatically fit according to the progress of the measurement.

If the fixed scale mode is selected by using the Scale mode button, the scale is fixed 
until changing the scale manually or clicking the Auto Scale button. 

 : Scale mode button during selecting the auto scale mode.
 : Scale mode button during selecting the fixed scale mode.

f. Trace Labels The step values for the characteristic curves can be shown or hidden by clicking the 
Trace Label button .

In the case that multiple curves are displayed on the IV-VDS characteristic graph of 
MOSFET, IC-VCE characteristic graph of IGBT, and so on, the step value display is 
useful to identify which curve is for which step value.

g. X/Y Data You can select the data and scale for the X and Y-axes. As default, the data for the X 
and Y-axes are assigned according to the I/V characteristics specified in the Setup.

The X/Y data field can be shown or hidden by clicking the line of the  button on 
top of the graph.

Select one from the following scales.

• Linear

Linear scale

• PositiveLog

Logarithm scale for positive data
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• NegativeLog

Logarithm scale for negative data

Select data for X and Y-axes corresponding to the specified device type. The 
following shows data corresponding to the device type.

For MOSFET: 

• VDS: Drain-source voltage

• ID: Drain current

• RDS: Drain-source resistance

• VGS: Gate-source voltage

• IG: Gate current

• IS: Forward direction current of body diode (source current)

• VSD: Forward direction voltage of body diode (source-drain voltage)

• gfs: Transconductance

For IGBT:

• VCE: Collector-emitter voltage

• IC: Collector current

• VGE: Gate-emitter voltage

• IG: Gate current

• VF: Forward direction voltage of free-wheel diode

• IF: Forward direction current of free-wheel diode

• gfs: Transconductance

For BJT:

• VCE: Collector-emitter voltage

• IC: Collector current

• VBE: Base-emitter voltage

• IB: Base current

• hFE: DC current amplification factor

For Diode:
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• VF: Forward direction voltage

• IF: Forward direction current

• VR: Reverse direction voltage

• IR: Reverse direction current

For Generic2T:

• V: Voltage between terminals 2 and 3

• I: Terminal 2 current

• R: Resistance between terminals 2 and 3

• VGS: Voltage between terminals 1 and 3

• IG: Terminal 1 current

• RGS: Resistance between terminals 1 and 3

For Generic:

• VDS: Voltage between terminals 2 and 3

• ID: Terminal 2 current

• RDS: Resistance between terminals 2 and 3

• VGS: Voltage between terminals 1 and 3

• IG: Terminal 1 current

• RGS: Resistance between terminals 1 and 3

• VSD: Voltage between terminals 3 and 2

• IS: Terminal 3 current

h. Oscilloscope 
View

The Oscilloscope View area can be hidden or shown by clicking the column of  
Oscilloscope View. For details, see “Oscilloscope View” on page 4-78.

Oscilloscope View
When the measurement is in the pulse mode operation, the Oscilloscope View can 
monitor both voltage and current waveforms for the measurement channels of all 
supported modules, at the specified measurement point on the characteristic trace. 
Oscilloscope View supports the following modules:

• MCSMU

• HVSMU
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• HCSMU

• UHCU

To monitor the waveforms in the Oscilloscope View, you need to display this area 
before executing the measurement.

To display this area, clicking the column of  Oscilloscope View at the right top 
corner of the Characteristics area.

Figure 4-12 Oscilloscope View

a. Specifying 
Observation Point

To specify the observation point, use the trace marker on the left-hand 
characteristics graph. After measuring the specified point, the observation point on 
the characteristics graph is identified by a monitor marker (green frame), and the 
time domain waveform(s) is displayed on this area.

In the case of the repeat measurement, you can move the trace marker to change the 
observation point during the measurement. After measuring the changed point, the 
monitor maker moves to the point and the waveforms are updated.

b. Specifying 
Channel

This area can display voltage or current waveforms characteristics for multiple 
measurement channels. To display waveforms, mark the check boxes for the voltage 
or current data names of the measurement channels that you want to monitor.

c. Graph Scale and 
Offset

The following buttons are available for adjusting the graph scale.

 : Auto scale button for Y-axis

a

b d

c

e
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 : Auto scale button for X-axis

 : Scale mode button when the auto scale mode is selected

 : Scale mode button when the fixed scale mode is selected

Clicking the auto scale button fits the measurement data at that time in the graph 
scale.

In the auto scale mode, the measurement data is automatically fit according to the 
progress of the measurement.

In the fixed scale mode, the scale is fixed until changing the scale manually or 
clicking the auto scale button. 

The string left next to the auto scale button indicates the scale resolution and the 
minimum value of the graph. For example, [2 V/div 0 V] means the scale resolution 
2 V and the minimum value 0 V. Clicking the value allows to change the value.

d. Domain Markers 
and Trace 
Representation

On the graph, you can read values using the domain marker and change the trace 
representation. For details, see “b. Markers” on page 4-75, and “c. Trace 
Representation” on page 4-75.

e. Aperture Period The diaphanous green zone on the graph shows the period of the Aperture value set 
in the General settings.

Connections
This page shows the measurement circuit that is automatically connected according 
to your specified measurement conditions. To display this page, click the 
Connections tab.

Figure 4-13 Connections
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On the measurement circuit, the measurement terminals, the measurement 
resources, and the built-in capacitance and resistance are displayed. The following 
shows the relationship between the terminal numbers and the measurement 
terminals.

• 1: Base/Gate terminal

• 2: Collector/Drain terminal

• 3: Emitter/Source terminal

• 4: Guard terminal

NOTE If DUT is a diode, connect the cathode terminal to 2. Collector/Drain terminal, and 
the anode terminal to 3. Emitter/Source terminal.

If DUT is a 2-terminal general device, connect a terminal to 2. Collector/Drain 
terminal, and the another terminal to 3. Emitter/Source terminal.

Base/Gate 
Resistor

If the MCSMU is specified to the Base/Gate terminal as the measurement resource, 
you can select one from the following base/gate resistances.

• 0 

• 10 

• 100 

• 1 k

The base/gate resistance is effective to restrain the oscillation of DUT that occurs 
during the ultra high current measurement and so on.

Collector/Drain 
Resistor

If the MVSMU is specified to the Collector/Drain terminal as the measurement 
resource, you can select one from the following collector/drain resistances.

• 0 

• 100 k

The collector/drain resistance is effective to restrain the over current that occurs 
during the breakdown measurement and so on.
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Automatic Data Save
This area sets the automatic saving for the setup data and measurement data. These 
data are automatically saved to a new measurement data file in the specified folder 
at the end of the measurement.

The Data folder and Recent data fields can be shown or hidden by clicking the line 
of  Automatic Data Save.

Figure 4-14 Automatic Data Save

Device ID Enter device ID string to the Device ID field. The maximum 10 
recently-entered device IDs can be kept as history, and you can 
also select one from the history list.

The entered device ID is automatically saved to the 
measurement data file at the end of the measurement.

You can also change the device ID in the latest measurement 
data file after the measurement here. To change it, change the 
device ID in the Device ID field, and then click the Apply 
button .

Comment Enter a comment string to the Comment field.

The entered comment is automatically saved to the 
measurement data file at the end of the measurement.

You can also change the comment in the latest measurement 
data file after the measurement here. To change it, change the 
comment in the Comment field, and then click the Apply 
button .

Data The Data field shows the latest auto-saved or last-opened 
measurement data file name. You can do the following 
operations.

• Open the measurement data file by clicking the Open 
button .

• Rename the measurement data file by clicking the 
measurement data file name.
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• Delete the measurement data file by clicking the Delete 
button .

Data folder Shows the absolute path of the auto-saved measurement data 
file. To change this, click the Browse button to open the folder 
selection dialog box. Select your desired folder in the dialog 
box.

For the initial setting of the data folder, see “Summary of Files” 
on page 4-88.

Recent data Shows up to 10 auto-saved measurement data files that were 
automatically saved recently, in the hyper-link format. Clicking 
the hyper-link opens the selected measurement data file. This 
destroys the presently-editing data.

If the number of the auto-saved measurement data files is over 
ten, this field shows “more...”. Clicking this opens the file 
selection dialog box. Select a measurement data file to open.

Toolbar

Figure 4-15 Toolbar

The toolbar has four tool button groups. The following shows the tool buttons in the 
tool button groups.

File tool button group

Open Opens the Open File dialog box used to open a 
specified setup file or measurement data file. The 
present data is cleared by opening the file.

Save Saves the present data as the same file name.

Exit Exits the I/V measurement software. Unsaved data is 
destroyed.
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Edit tool button group

Cut Moves the selected text to the clipboard.

Copy Copies the selected text to the clipboard.

Paste Pastes the text from the clipboard to the insertion point.

On-screen 
keyboard

Displays the on-screen keyboard.

Measurement tool button group

Start 
Measurement

Starts a measurement. During the measurement, the 
measurement status indicator on the front panel lights 
up.

Repeat 
Measurement

Starts a repeat measurement. During the measurement, 
the measurement status indicator on the front panel 
lights up.
This allows you to observe the measurement result with 
changing the setup.

To stop the measurement, select the Measurement > 
Stop menu, click the Stop Measurement button  on 
the toolbar, or press the Stop key on the front panel.

Stop 
Measurement

Stops the measurement.

View tool button group

Go to Palette Displays the software palette in fullscreen mode.
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Main Menu

Figure 4-16 Main Menu

The following describes the functions of the main menu.

File Menu Displays the following menu items to operate the setup file and measurement data 
file. For the file types and extensions, see “Summary of Files” on page 4-88.

New Clears the present data to start from initial setting.

Open... Opens the Open File dialog box used to open a specified setup 
file or measurement data file. The present data is cleared by 
opening the file.

Save Saves the present data as the same file name.

Save Setup As... Opens the Save Data File dialog box used to save the present 
setup data as the specified setup file.

Save Data As... Opens the Save Data File dialog box used to save the present 
setup data and measurement data as the specified measurement 
data file.

Change Device 
ID... Changes the device ID recorded in the measurement data file.

This opens the Change Device ID dialog box, and changes the 
device ID recorded in the selected measurement data file(s). See 
“Change Device ID Dialog Box” on page 4-87.

Recent Setup Files 
Lists a maximum of 10 names of the setup files that were 
recently edited, as menu items. You can easily open a setup file 
by using them.

Exit Exits the I/V measurement software. Unsaved data is destroyed.

Edit Menu Displays the following menu items to edit the setup.

Cut Moves the selected text to the clipboard.

Copy Copies the selected text to the clipboard.

Paste Pastes the text from the clipboard to the insertion point.
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On-screen 
keyboard... Displays the on-screen keyboard.

View Menu Displays the following menu items for the display setting.

Go to Palette Displays the software palette in fullscreen mode.

Main Window Displays the following menu item.

Fullscreen Changes the display style of the main 
window.

If this is marked, the main window does not 
have the titlebar and is displayed in 
fullscreen mode.

If this is unmarked, the main window has 
the titlebar and is displayed in the regular 
window style.

This is initially marked.

Color Settings... Opens the Color Setting dialog box to set the color for parts in 
this software. See “Color Setting Dialog Box” on page 4-87.

Measurement 
Menu

Displays the following menu items for controlling the measurement.

Start Starts a measurement. During the measurement, the 
measurement status indicator on the front panel lights up.

Repeat Starts a repeat measurement. During the measurement, the 
measurement status indicator on the front panel lights up.
This allows you to observe the measurement result with 
changing the setup.

To stop the measurement, select the Measurement > Stop menu, 
click the Stop Measurement button  on the toolbar, or press 
the Stop key on the front panel.

Stop Stops the measurement.

Configuration 
Menu

Displays the following menu item to administrate the configuration of the built-in 
modules in the mainframe and test fixture.

Module... Opens the Module Configuration dialog box. See “Module 
Configuration Dialog Box” on page 4-183.

Help Menu Displays the following menu item.
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About... Opens the about box. See “About Box” on page 4-88.

Dialog Boxes

Change Device ID Dialog Box
The Change Device ID dialog box is used to change the device ID in all selected 
measurement data files at once.

This dialog box is opened by selecting the main menu File > Change Device ID....

Device ID field Enter a new device ID. You can also select it from the history.

Add... button Opens the file selection dialog box to select the measurement 
data file(s) that you want to change the device ID. The selected 
files are displayed into the list.

Remove button Excludes the selected measurement data file from the list.

Execute button Changes the device ID.

Close button Closes this dialog box.

Color Setting Dialog Box
The Color Setting dialog box is used to set colors of the following parts in this 
software. The setting in the Color Setting dialog box is saved as a user setting.

• Graph Background

• Graph Axis

• Graph Grid

• Graph Text

• Marker

• Trance

This dialog box is opened by selecting the main menu View > Color Settings....

Clicking the color pattern opens the dialog box for selecting a color.

Apply button Applies the present setting to the graph.

Reset button Resets to the default setting.

OK button Applies the present setting to the graph, and closes this dialog 
box.
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Cancel button Closes this dialog box without applying the present setting.

About Box
The about box displays the model number, the software revision number, download 
URL for software updating, and so on.

This dialog box is opened by selecting the main menu Help > About....

Summary of Files
The following shows the summary of the files handled by the I/V measurement 
software.

Table 4-20 Summary of Files

File name of Measurement Data File on Auto-saving
An auto-saved measurement data file is named as follows:

<DeviceID>_<TEMP>_<TIME>.pda-iv.txt

<DeviceID>:  Device ID

<TEMP>:  Temperature

<TIME>:  Time stamp on auto-saving

Example)
Device-1_@Ch1=30degC_Ch2=30degC_2014-10-30_18-56-55.pda-iv.txt

File Type Description Extension Folder as Initial Setting

Setup File This has the setup data only.

You can save this using the File menu 
anytime.

*.pda-iv (You can specify the folder 
when saving the data)

Measurement 
Data File

This has the setup data and 
measurement data including the device 
ID and comment. 

The setup data and measurement data 
are automatically saved to this file in 
the specified folder at the end of the 
measurement. And, you can also save 
this using the File menu anytime.

*.pda-iv.txt C:\Users\<user name>\
Documents\Keysight\Serie
sB150x\PowerDeviceAnal
yzer\IV\DataStore
(You can change this)
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And, the file name is decided according to the following rule.

1. <TEMP> is the characters of the available thermometer identifiers and the 
thermometer readings. To enable thermometers, use the Thermal 
Monitor/Control Software. See “Thermal Monitor/Control Software” on page 
4-163.

@<thermometer>=<reading>degC

• <thermometer>: An identifier of the available thermometer

Ch1 Channel 1 thermometer of B1506A

Ch2 Channel 2 thermometer of B1506A

Air Thermometer on the air outlet port of the thermostream

DUT Thermometer on the DUT port of the thermostream

• <reading>: A reading value of the thermometer in degrees centigrade

If multiple thermometers are available, the temperature information is 
concatenated by an underscore (_). The @ is attached only at the beginning 
of the temperature information. 

Example) @Ch1=25degC_Ch2=75degC_Air=100degC

2. <TIME> is the characters of year, month, day, hour, minute, and second. The 
time stamp representation depends on the time setting on Windows. And, an 
invalid character is replaced with an underscore (_).

Example 1) 2014-10-30_18-56-55
Example 2) 30-10-2014_6-56-55_PM

3. If the file name duplicates the existing file name, the serial number from 2 
enclosed by brackets is concatenated before the file extension.

Example)
Device-1_@Ch1=30degC_Ch2=30degC_2014-10-30_18-56-55(3).pda-iv.txt
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Capacitance Measurement Software
NOTE This software is available for the B1506A-H21/H51/H71.

Capacitance measurement software provides:

• Automated measurement circuit configuration for three-terminal device 
capacitance measurement (e.g. Ciss, Coss and Crss), with no need to manually 
modify any device connections

• With DC bias (sweep) control up to 3 kV for Collector/Drain terminal

• With DC bias (sweep) control up to 100 V for Base/Collector terminal

• Automated correction for every measurement path

• Stable measurements even if the low-side load capacitance changes due to a bias 
change (load adaptive gain-phase compensation)

• Predefined templates for typical capacitance measurements of both 
enhancement and depletion type MOSFETs, IGBTs and Diodes
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GUI Overview
The GUI (Graphical User Interface) of the capacitance measurement software is 
comprised of the following areas.

Figure 4-17 Capacitance Measurement Software GUI

1. Work Area (See p. 4-92.)

This area provides the functions to set the measurement conditions and observe 
the measurement results. This is separated to the following areas.

a. Setup (See p. 4-92.)

b. Characteristics (See p. 4-101.)

c. Connections (See p. 4-105.)

2. Automatic Data Save (See p. 4-108.)

This area provides the functions regarding the automatic saving of the 
measurement data files.

3. Operating Tools

• Toolbar (See p. 4-109.)

3

a

b
c

2

1
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This provides the functions that are very frequently used in the button 
format.

• Main Menu (See p. 4-111.)

This provides the functions needed for various operations in the menu 
format.

For the dialog boxes displayed during this software operation, see “Dialog Boxes” 
on page 4-113.

For the files handled by this software, see “Summary of Files” on page 4-116.

Work Area
In this area, set the measurement conditions and observe the measurement results. 
This is separated to the following areas.

• Setup (See p. 4-92.)

• Characteristics (See p. 4-101.)

• Connections (See p. 4-105.)

Setup
This is an area to select the device type and its measured parameters, and enter your 
measurement conditions.

Figure 4-18 Setup

Device Type Select the device type of your DUT from below.

• “MOSFET”

• “IGBT”

• “Diode”

• “Generic”

Select Generic to execute more general measurements for device other than 
above types.
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MOSFET You can select one of the following capacitance and resistance parameter 
measurements for “MOSFET” device type.

• Ciss, Coss, Crss

Creates new settings to measure the characteristics of the input capacitance, 
output capacitance, and reverse transfer capacitance for the drain-source voltage 
in order.

• Ciss

Creates new settings to measure the characteristics of the input capacitance for 
the drain-source voltage.

• Coss

Creates new settings to measure the characteristics of the output capacitance for 
the drain-source voltage.

• Crss

Creates new settings to measure the characteristics of the reverse transfer 
capacitance for the drain-source voltage.

• Cgs, Cds, Cgd

Creates new settings to measure the characteristics of the gate-source 
capacitance, drain-source capacitance, and gate-drain capacitance for the 
drain-source voltage in order.

• Cgs

Creates new settings to measure the characteristics of the gate-source 
capacitance for the drain-source voltage.

• Cds

Creates new settings to measure the characteristics of the drain-source 
capacitance for the drain-source voltage.

• Cgd

Creates new settings to measure the characteristics of the gate-drain capacitance 
for the drain-source voltage.

• Rg

Creates new settings to measure the characteristics of the gate resistance for the 
gate-source voltage.
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• Cox

Creates new settings to measure the characteristics of the gate oxide capacitance 
for the gate-source voltage.

IGBT You can select one of the following capacitance and resistance parameter 
measurements for “IGBT” device type.

• Cies, Coes, Cres

Creates new settings to measure the characteristics of the input capacitance, 
output capacitance, and reverse transfer capacitance for the collector-emitter 
voltage in order.

• Cies

Creates new settings to measure the characteristics of the input capacitance for 
the collector-emitter voltage.

• Coes

Creates new settings to measure the characteristics of the output capacitance for 
the collector-emitter voltage.

• Cres

Creates new settings to measure the characteristics of the reverse transfer 
capacitance for the collector-emitter voltage.

• Cge, Cce, Cgc

Creates new settings to measure the characteristics of the gate-emitter 
capacitance, collector-emitter capacitance, and gate-collector capacitance for the 
collector-emitter voltage in order.

• Cge

Creates new settings to measure the characteristics of the gate-emitter 
capacitance for the collector-emitter voltage.

• Cce

Creates new settings to measure the characteristics of the collector-emitter 
capacitance for the collector-emitter voltage.

• Cgc

Creates new settings to measure the characteristics of the gate-collector 
capacitance for the collector-emitter voltage.
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• Rg

Creates new settings to measure the characteristics of the gate resistance for the 
gate-emitter voltage.

Diode You can select the following capacitance parameter measurements for “Diode” 
device type.

• CT

Creates new settings to measure the characteristics of the total anode-cathode 
capacitance for the reverse bias voltage.

Generic You can select one of the following measurements for “Generic” device type.

• Sweep Voltage Between Terminal 2-3 (Collector-Emitter/Drain-Source Voltage 
Sweep Measurement)

Creates new settings to measure the Cp-G model capacitance between the 
collector/drain and the emitter/source terminals for the swept collector-emitter 
or drain-source voltage.

• Sweep Voltage Between Terminal 1-3 (Base-Emitter/Gate-Source Voltage 
Sweep Measurement)

Creates new settings to measure the Cs-Rs model capacitance between the 
base/gate and the emitter/source terminals for the swept base-emitter or 
gate-source voltage.

General settings In this area, you can set the following measurement conditions.

• Frequency

Specify the output frequency of the AC signal from MFCMU.
Setting range: 1 kHz to 1 MHz

• AC Level

Specify the output level of the AC signal from MFCMU.
Setting range: 0 to 250 mV

• N PLC

Specify the measurement time (integral time) in the number of power line cycle. 
Setting range: 1 to 100

• Phase Compensation

Specify one from the following phase compensation modes.
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• Auto

Uses the predefined phase compensation data.

• Adaptive

Compensates the phase at each measurement point before the measurement.

It is useful when you cannot measure in the Auto compensation mode by 
MFCMU oscillation.

The following parameter can be shown or hidden by clicking the line of  Details.

• AC Level

• N PLC

• Phase Compensation

Base/Gate drive 
settings

Specify the output settings for the base-collector or gate-source voltage. You can set 
them up depending on the types of the selected measurement: forcing the constant 
bias voltage or sweeping the bias voltage. 

Base/Gate Voltage Bias:

You can specify the following parameters to force the constant bias voltage.

• Bias

Specify the bias voltage.
Setting range: 100 V to +100 V

Base/Gate Voltage Sweep:

You can specify the following parameters to sweep the bias voltage.

• Start

Specify the sweep start value.
Setting range: 100 V to +100 V

• Stop

Specify the sweep stop value.
Setting range: 100 V to +100 V

• Sweep Mode

Select one from the following sweep modes.

• LinearSingle (Sweep from start to stop in a linear incremental step)

• LogSingle (Sweep from start to stop in a logarithmic incremental step)
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• LinearDouble (Sweep from start to stop to start in a linear incremental step)

• LogDouble (Sweep from start to stop to start in a logarithmic incremental 
step)

• Number of Step

Specify the number of sweep steps from start to stop.
Setting range: 1 to 1001

• Hold Time

Specify the hold time of the sweep start voltage. At the sweep start point, the 
start voltage is forced for more than the specified time.
Setting range: 0 to 655.35 s

• Delay Time

Specify the delay time of the measurement at each sweep step. The measurement 
is executed after waiting for more than the specified time at each sweep step.
Setting range: 0 to 65.535 s

• Zero Bias Time

Keeps 0 V at every terminal for more than the specified time after one sweep 
measurement.
Setting range: 0 to 99.9 s

In the measurement of the same capacitance parameter as shown in the 
following table, the characteristics results by the single measurement and the 
continuous measurement may have the difference depending on the bias voltage 
condition between the measurements. This parameter is used to cancel the 
dependence on the bias voltage condition in the continuous measurement.
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The following parameter can be shown or hidden by clicking the line of  Details.

• Number of Step

• Hold Time

• Delay Time

• Zero Bias Time

Collector/Drain 
drive settings

Specify the output settings for the collector-emitter or drain-source voltage. You can 
set them up depending on the types of the selected measurement: forcing the 
constant bias voltage or sweeping the bias voltage. 

Collector/Drain Voltage Bias:

You can specify the following parameters to force the constant bias voltage.

• Bias

Specify the bias voltage.
Setting range: 3000 V to +3000 V

Device Type Continuous 
Measurement Single Measurement

MOSFET • Ciss, Coss, Crss • Ciss

• Coss

• Crss

• Cgs, Cds, Cgd • Cgs

• Cds

• Cgd

IGBT • Cies, Coes, Cres • Cies

• Coes

• Cres

• Cge, Cce, Cgc • Cge

• Cce

• Cgc
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Collector/Drain Voltage Sweep:

You can specify the following parameters to sweep the bias voltage.

• Start

Specify the sweep start value.
Setting range: 3000 V to +3000 V

• Stop

Specify the sweep stop value.
Setting range: 3000 V to +3000 V

• Sweep Mode

Select one from the following sweep modes.

• LinearSingle (Sweep from start to stop in a linear incremental step)

• LogSingle (Sweep from start to stop in a logarithmic incremental step)

• LinearDouble (Sweep from start to stop to start in a linear incremental step)

• LogDouble (Sweep from start to stop to start in a logarithmic incremental 
step)

• Number of Step

Specify the number of sweep steps from start to stop.
Setting range: 1 to 1001

• Hold Time

Specify the hold time of the sweep start voltage. At the sweep start point, the 
start voltage is forced for more than the specified time.
Setting range: 0 to 655.35 s

• Delay Time

Specify the delay time of the measurement at each sweep step. The measurement 
is executed after waiting for more than the specified time at each sweep step.
Setting range: 0 to 65.535 s

• Zero Bias Time

Keeps 0 V at every terminal for more than the specified time after one sweep 
measurement.
Setting range: 0 to 99.9 s
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In the measurement of the same capacitance parameter as shown in the 
following table, the characteristics results by the single measurement and the 
continuous measurement may have the difference depending on the bias voltage 
condition between the measurements. This parameter is used to cancel the 
dependence on the bias voltage condition in the continuous measurement.

The following parameter can be shown or hidden by clicking the line of  Details.

• Number of Step

• Hold Time

• Delay Time

• Zero Bias Time

Device Type Continuous 
Measurement Single Measurement

MOSFET • Ciss, Coss, Crss • Ciss

• Coss

• Crss

• Cgs, Cds, Cgd • Cgs

• Cds

• Cgd

IGBT • Cies, Coes, Cres • Cies

• Coes

• Cres

• Cge, Cce, Cgc • Cge

• Cce

• Cgc
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Characteristics
This page shows the graph of the specified parameter characteristics as the 
measurement result. To display this page, click the Characteristics tab.

Figure 4-19 Characteristics

a. Displaying 
Characteristic 
Curves

The data for the X and Y-axes are assigned according to the parameter 
characteristics specified in the Setup.

If the graph has multiple characteristic curves for different measurement conditions, 
the measurement conditions are displayed on the graph with the check boxes. 
Marking the check box displays the characteristic curve for the measurement 
condition. You can mark multiple check boxes for the measurement conditions.

You can change the minimum and maximum values on the X and Y-axes by clicking 
the value.

b. Markers This graph supports two kinds of markers: Domain marker and Trace marker. You 
can switch these markers by clicking the Marker button shown in the bottom part of 
the graph.

 : Marker button when the Domain marker is used.
 : Marker button when the Trace marker is used.

The Domain marker can read multiple characteristic values for the X-axis position.

a
b

c ebd f

g
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The Domain marker supports two markers (A and B). Marker A is always available. 
To use the Marker B, mark the check box for the Marker B. The Marker B is a break 
line. To move the marker position, use the rotary knob or mouse.

The marker annotation on the graph has X-axis values for markers, and a difference 
value () between the Marker B and A (BA). And, each curve annotation has 
Y-axis values and difference values () between the Marker B and A (BA).

The Trace marker can read the characteristic value with tracing each characteristic 
curve. It is useful when you want to read the characteristic value on double sweep 
result.

The marker annotation on the graph has X-axis value for the marker. And, the traced 
curve annotation has Y-axis value.

c. Trace 
Representation

The curves can be represented as Line, Dot, or combination (Line & Dot). Select 
any trace representation using the radio buttons shown in the bottom part of the 
graph.

d. Reference 
Traces

You can register the presently-displayed curves as reference traces to compare with 
other measurement results on the graph. If you register them as reference traces, the 
reference traces are displayed as dimmed thin lines on the graph when you open 
other measurement data files or execute the next measurement. To register as the 
reference traces, click the Capture button  shown in the bottom part of the graph.

You can register a maximum of 10 reference traces. The measurement data files 
registered as the reference traces are listed in the References field under the Capture 
button . You can show or hide the reference traces using the check boxes at the 
head of the measurement data file names. The References field can be shown or 
hidden by clicking the line of the  button on top of the graph. 

To remove unnecessary reference traces, select the measurement data file in the 
References field, and then click the Remove button . 

The registration of the reference traces is cleared when you exit the capacitance 
measurement software.

e. Auto Scale Clicking the Auto Scale button  fits the measurement data at that time in the 
graph scale.

If the auto scale mode is selected by using the Scale mode button, the measurement 
data is automatically fit according to the progress of the measurement.

If the fixed scale mode is selected by using the Scale mode button, the scale is fixed 
until changing the scale manually or clicking the Auto Scale button. 
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 : Scale mode button during selecting the auto scale mode.
 : Scale mode button during selecting the fixed scale mode.

f. Trace Labels The step values for the characteristic curves can be shown or hidden by clicking the 
Trace Label button .

In the case that multiple curves (Ciss, Coss, and Crss of MOSFET, and so on) are 
displayed on the graph, the parameter name display is useful to identify which curve 
is for which parameter.

g. X/Y Data You can select the data and scale for the X and Y-axes. As default, the data for the X 
and Y-axes are assigned according to the parameter characteristics specified in the 
Setup.

The X/Y data field can be shown or hidden by clicking the line of the  button on 
top of the graph.

Select one from the following scales.

• Linear

Linear scale

• PositiveLog

Logarithm scale for positive data

• NegativeLog

Logarithm scale for negative data

Select data for X and Y-axes. The data corresponding to the parameter specified in 
the Setup is represented as Capacitance, Conductance, or Resistance.

For example, in the case of the Ciss measurement, Cp is represented as Capacitance 
and G is represented as Conductance. In like manner, in the case of the Rs 
measurement, Rs is represented as Resistance and Cs is represented as Capacitance. 

• Cp

Parallel capacitance on the Cp-G model

• G

Conductance on the Cp-G model

• Cs

Serial capacitance on the Cs-Rs model
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• Rs

Serial resistance on the Cs-Rs model

• Ls

Serial inductance on the Ls-Rs model

• Lp

Parallel inductance on the Lp-G model

• R

Resistance on the R-X (impedance) model

• X

Reactance on the R-X (impedance) model

• G

Conductance on the G-B (admittance) model

• B

Susceptance on the G-B (admittance) model

• VGS (for MOSFET)/VGE (for IGBT)

Gate-source voltage or base-emitter voltage

• IG

Gate or base current

• VDS (for MOSFET)/VCE (for IGBT)

Drain-source voltage or collect-emitter voltage

• ID (for MOSFET)/IC (for IGBT)

Drain or collector current
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Connections
This page shows the measurement circuit that is automatically connected according 
to your specified measurement conditions. To display this page, click the 
Connections tab.

Figure 4-20 Connections

a. Measurement 
Circuit

On the measurement circuit, the measurement terminals, the measurement 
resources, and the built-in capacitance and resistance are displayed. The following 
shows the relationship between the terminal numbers and the measurement 
terminals.

• 1: Base/Gate terminal

• 2: Collector/Drain terminal

• 3: Emitter/Source terminal

• 4: Guard terminal

NOTE If DUT is a diode, connect the cathode terminal to 2. Collector/Drain terminal, and 
the anode terminal to 3. Emitter/Source terminal.

In the case that the specified parameter characteristics has multiple measurements 
such as Ciss, Coss, and Crss measurements, the measurement circuits are 
respectively separated for the measurements by left-side tabs.

b. Details This area is hidden as default. You can show this area under the measurement circuit 
by clicking the line of  Details. 

a

b
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This area shows the connection status for the terminals in the table format. To edit 
the settings, mark the check box in this area. You can set up the connections by the 
combination of the following items.

• CMU High/Low

Select a combination of connections between the DUT terminals (1 to 3) and the 
CMU terminals (High and Low).

High Connects the DUT terminal to the High terminal of CMU.

Low Connects the DUT terminal to the Low terminal of CMU.

--- No connection

• AC Guard/AC Short

Select a combination of connections between the DUT terminals (1 to 3) and AC 
Guard terminal, or AC short connection between the DUT terminals 2 and 3.

Com. Connects the DUT terminal to the circuit common directly.

Floating Connects the DUT terminal to the selected bias source or 
the circuit common via the built-in capacitor.

2-Short-3 Shorts between DUT terminals 2 and 3 via the built-in 
capacitor.

--- No connection

• Bias

Select a combination of connections between the DUT terminals (1 to 3) and the 
DC bias source (SMU, CMU, or Common).

CMU Uses the bias source in the CMU that is connected.

SMU Connects the DUT terminal to an SMU as the bias source.

Com. Connects the DUT terminal to the circuit common.

--- No connection

• Guard

Select a connection between the DUT terminal 4 and AC Guard terminal.

Com. Connects the DUT terminal 4 to circuit common directly.

Floating Connects the DUT terminal 4 to the selected bias source or 
the circuit common via the built-in capacitor.
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The following table shows applicable connections between the DUT terminals and 
the measurement resources. The rightmost column shows the potential at the DUT 
terminal 4 when it is connected to the AC Guard terminal in the built-in capacitor 
(Floating connection). In the table, the blank cell means “same as above”.

Table 4-21 Applicable Connections

CMU High/Low AC Guard/AC Short Bias Guard

1 2 3 1 2 3 1 2 3 Floating

High --- Low --- Com. --- CMU Com. Com. AC Guard

SMU Com. Com. AC Guard

--- Floating --- CMU SMU Com. Terminal 2

SMU SMU Com. Terminal 2

--- 2-Short-3 CMU SMU Com. Terminal 2

SMU SMU Com. Terminal 2

High Low Low --- --- --- CMU Com. Com. AC Guard

SMU Com. Com. AC Guard

--- High Low Com. --- --- Com. SMU Com. AC Guard

Floating --- --- SMU SMU Com. AC Guard

SMU CMU Com. AC Guard

Low High --- --- --- Com. Com. SMU Com. AC Guard

SMU SMU Com. AC Guard

Com. CMU Com. AC Guard

SMU CMU Com. AC Guard

Low High Low --- --- --- Com. SMU Com. AC Guard

SMU SMU Com. AC Guard

Low High High --- --- --- Com. CMU CMU AC Guard
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Automatic Data Save
This area sets the automatic saving for the setup data and measurement data. These 
data are automatically saved to a new measurement data file in the specified folder 
at the end of the measurement.

The Data folder and Recent data fields can be shown or hidden by clicking the line 
of  Automatic Data Save.

Figure 4-21 Automatic Data Save

Device ID Enter device ID string to the Device ID field. The maximum 10 
recently-entered device IDs can be kept as history, and you can 
also select one from the history list.

The entered device ID is automatically saved to the 
measurement data file at the end of the measurement.

You can also change the device ID in the latest measurement 
data file after the measurement here. To change it, change the 
device ID in the Device ID field, and then click the Apply 
button .

Comment Enter a comment string to the Comment field.

The entered comment is automatically saved to the 
measurement data file at the end of the measurement.

You can also change the comment in the latest measurement 
data file after the measurement here. To change it, change the 
comment in the Comment field, and then click the Apply 
button .

Data The Data field shows the latest auto-saved or last-opened 
measurement data file name. You can do the following 
operations.

• Open the measurement data file by clicking the Open 
button .

• Rename the measurement data file by clicking the 
measurement data file name.

• Delete the measurement data file by clicking the Delete 
button .
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Data folder Shows the absolute path of the auto-saved measurement data 
file. To change this, click the Browse button to open the folder 
selection dialog box. Select your desired folder in the dialog 
box.

For the initial setting of the data folder, see “Summary of Files” 
on page 4-116.

Recent data Shows up to 10 auto-saved measurement data files that were 
automatically saved recently, in the hyper-link format. Clicking 
the hyper-link opens the selected measurement data file. This 
destroys the presently-editing data.

If the number of the auto-saved measurement data files is over 
ten, this field shows “more...”. Clicking this opens the file 
selection dialog box. Select a measurement data file to open.

Toolbar

Figure 4-22 Toolbar

The toolbar has five tool button groups. The following shows the tool buttons in the 
tool button groups.

File tool button group

Open Opens the Open File dialog box used to open a 
specified setup file or measurement data file. The 
present data is cleared by opening the file.

Save Saves the present data as the same file name.

Exit Exits the capacitance measurement software. Unsaved 
data is destroyed.

Edit tool button group

Cut Moves the selected text to the clipboard.
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Copy Copies the selected text to the clipboard.

Paste Pastes the text from the clipboard to the insertion point.

On-screen 
keyboard

Displays the on-screen keyboard.

Measurement tool button group

Start 
Measurement

Starts a measurement. During the measurement, the 
measurement status indicator on the front panel lights 
up.

To stop the measurement, select the Measurement > 
Stop menu, click the Stop Measurement button  on 
the toolbar, or press the Stop key on the front panel.

Stop 
Measurement

Stops the measurement.

View tool button group

Go to Palette Displays the software palette in fullscreen mode.

Calibration tool button group

Start Calibration... Opens the Calibration dialog box to get the calibration 
data. See “Calibration Dialog Box” on page 4-114.

Select Calibration 
Data...

Opens a dialog box for the file selection, and then 
applies the selected calibration data file to the 
measurement.



B1506A User’s Guide, Edition 7 4-111

GUI Reference
Capacitance Measurement Software

Main Menu

Figure 4-23 Main Menu

The following describes the functions of the main menu.

File Menu Displays the following menu items to operate the setup file and measurement data 
file. For the file types and extensions, see “Summary of Files” on page 4-116.

New Clears the present data to start from initial setting.

Open... Opens the Open File dialog box used to open a specified setup 
file or measurement data file. The present data is cleared by 
opening the file.

Save Saves the present data as the same file name.

Save Setup As... Opens the Save Data File dialog box used to save the present 
setup data as the specified setup file.

Save Data As... Opens the Save Data File dialog box used to save the present 
setup data and measurement data as the specified measurement 
data file.

Change Device 
ID... Changes the device ID recorded in the measurement data file.

This opens the Change Device ID dialog box, and changes the 
device ID recorded in the selected measurement data file(s). See 
“Change Device ID Dialog Box” on page 4-113.

Recent Setup Files 
Lists a maximum of 10 names of the setup files that were 
recently edited, as menu items. You can easily open a setup file 
by using them.

Exit Exits the capacitance measurement software. Unsaved data is 
destroyed.

Edit Menu Displays the following menu items to edit the setup.

Cut Moves the selected text to the clipboard.

Copy Copies the selected text to the clipboard.

Paste Pastes the text from the clipboard to the insertion point.
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On-screen 
keyboard... Displays the on-screen keyboard.

View Menu Displays the following menu items for the display setting.

Go to Palette Displays the software palette in fullscreen mode.

Main Window Displays the following menu item.

Fullscreen Changes the display style of the main 
window.

If this is marked, the main window does not 
have the titlebar and is displayed in 
fullscreen mode.

If this is unmarked, the main window has 
the titlebar and is displayed in the regular 
window style.

This is initially marked.

Color Settings... Opens the Color Setting dialog box to set the color for parts in 
this software. See “Color Setting Dialog Box” on page 4-114.

Calibration Menu Displays the following menu items for the calibration.

Start Opens the Calibration dialog box to get the calibration data. See 
“Calibration Dialog Box” on page 4-114.

Select Data Opens a dialog box for the file selection, and then applies the 
selected calibration data file to the measurement.

Load Factory 
Default Applies the factory default calibration data file to the 

measurement.

Measurement 
Menu

Displays the following menu items for controlling the measurement.

Start Starts a measurement. During the measurement, the 
measurement status indicator on the front panel lights up.

To stop the measurement, select the Measurement > Stop menu, 
click the Stop Measurement button  on the toolbar, or press 
the Stop key on the front panel.

Stop Stops the measurement.
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Configuration 
Menu

Displays the following menu item to administrate the configuration of the built-in 
modules in the mainframe and test fixture.

Module... Opens the Module Configuration dialog box. See “Module 
Configuration Dialog Box” on page 4-183.

Help Menu Displays the following menu item.

About... Opens the about box. See “About Box” on page 4-115.

Dialog Boxes

Change Device ID Dialog Box
The Change Device ID dialog box is used to change the device ID in all selected 
measurement data files at once.

This dialog box is opened by selecting the main menu File > Change Device ID....

Device ID field Enter a new device ID. You can also select it from the history.

Add... button Opens the file selection dialog box to select the measurement 
data file(s) that you want to change the device ID. The selected 
files are displayed into the list.

Remove button Excludes the selected measurement data file from the list.

Execute button Changes the device ID.

Close button Closes this dialog box.
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Color Setting Dialog Box
The Color Setting dialog box is used to set colors of the following parts in this 
software. The setting in the Color Setting dialog box is saved as a user setting.

• Graph Background

• Graph Axis

• Graph Grid

• Graph Text

• Marker

• Trace

• First

• Second

• Third

This dialog box is opened by selecting the main menu View > Color Settings....

Clicking the color pattern opens the dialog box for selecting a color.

Apply button Applies the present setting to the graph.

Reset button Resets to the default setting.

OK button Applies the present setting to the graph, and closes this dialog 
box.

Cancel button Closes this dialog box without applying the present setting.

Calibration Dialog Box
The Calibration dialog box is used to acquire the calibration data regarding the 
leakage conductance, parasitic capacitance, residual resistance, and inductance on 
the signal paths, and apply it to the measurement.

If you change the signal paths to DUT, you need to acquire the calibration data for 
the new paths.

The calibration data supports the situation that the signal paths in the test fixture are 
automatically switched.

This dialog box is opened by selecting the main menu Calibration > Start.
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Full Path Calibration Measurement 
Select to acquire the calibration data for all available signal 
paths.

Minimum Path Calibration Measurement 
Select to acquire the calibration data for the signal paths used in 
the present setup.
For signal paths except for them, the factory default calibration 
data is applied.

Start button Starts to acquire the calibration data. Open or short the 
capacitance measurement circuit according to instructions of 
the wizard.

Save and Apply 
button Saves the acquired calibration data to a file, and applies it to the 

measurement.

Cancel button Destroys the acquired calibration data and closes this dialog 
box.

About Box
The about box displays the model number, the software revision number, download 
URL for software updating, and so on.

This dialog box is opened by selecting the main menu Help > About....
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Summary of Files
The following shows the summary of the files handled by the capacitance 
measurement software.

Table 4-22 Summary of Files

File name of Measurement Data File on Auto-saving
An auto-saved measurement data file is named as follows:

<DeviceID>_<TEMP>_<TIME>.pda-cap.txt

<DeviceID>:  Device ID

<TEMP>:  Temperature

<TIME>:  Time stamp on auto-saving

Example)
Device-1_@Ch1=30degC_Ch2=30degC_2014-10-30_18-56-55.pda-cap.txt

File Type Description Extension Folder as Initial Setting

Setup File This has the setup data only.

You can save this using the File menu 
anytime.

*.pda-cap (You can specify the folder 
when saving the data)

Measurement 
Data File

This has the setup data and 
measurement data including the 
device ID and comment. 

The setup data and measurement data 
are automatically saved to this file in 
the specified folder at the end of the 
measurement. And, you can also save 
this using the File menu anytime.

*.pda-cap.txt C:\Users\<user name>\
Documents\Keysight\
SeriesB150x\PowerDevice
Analyzer\DeviceCapacitan
ce\DataStore
(You can change this)

Calibration Data 
File

Calibration data

This is automatically saved after the 
calibration execution.

*.pda-cap.cal C:\ProgramData\Keysight\
SeriesB150x\PowerDevice
Analyzer\DeviceCapacitan
ce\UserCalibrationData

Factory Default Calibration data

This is used when there is no user 
calibration data.

C:\ProgramData\Keysight\
SeriesB150x\PowerDevice
Analyzer\DeviceCapacitan
ce\CalibrationData
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And, the file name is decided according to the following rule.

1. <TEMP> is the characters of the available thermometer identifiers and the 
thermometer readings. To enable thermometers, use the Thermal 
Monitor/Control Software. See “Thermal Monitor/Control Software” on page 
4-163.

@<thermometer>=<reading>degC

• <thermometer>: An identifier of the available thermometer

Ch1 Channel 1 thermometer of B1506A

Ch2 Channel 2 thermometer of B1506A

Air Thermometer on the air outlet port of the thermostream

DUT Thermometer on the DUT port of the thermostream

• <reading>: A reading value of the thermometer in degrees centigrade

If multiple thermometers are available, the temperature information is 
concatenated by an underscore (_). The @ is attached only at the beginning 
of the temperature information. 

Example) @Ch1=25degC_Ch2=75degC_Air=100degC

2. <TIME> is the characters of year, month, day, hour, minute, and second. The 
time stamp representation depends on the time setting on Windows. And, an 
invalid character is replaced with an underscore (_).

Example 1) 2014-10-30_18-56-55
Example 2) 30-10-2014_6-56-55_PM

3. If the file name duplicates the existing file name, the serial number from 2 
enclosed by brackets is concatenated before the file extension.

Example)
Device-1_@Ch1=30degC_Ch2=30degC_2014-10-30_18-56-55(3).pda-cap.txt
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Gate Charge Measurement Software
NOTE This software is available for the B1506A-H21/H51/H71.

Gate charge measurement Software provides:

• Support for both constant current load mode and resistive load mode

• Correction of parasitic capacitance and residual resistance in the gate path

• Monitoring of gate and drain/collector voltage/ and current waveforms during 
the DUT turn-on period phase

• JESD24-2 compliant Qg curve, line fitting and parameter extraction
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GUI Overview
The GUI (Graphical User Interface) of the gate charge measurement software is 
comprised of the following areas.

Figure 4-24 Gate Charge Measurement Software GUI

1. Work Area (See p. 4-120.)

This area provides the functions to set the measurement conditions and observe 
the measurement results. This is separated to the following areas.

a. Conditions (See p. 4-120.)

b. Gate Charge Characteristics (See p. 4-123.)

c. Switching Waveform (See p. 4-127.)

2. Automatic Data Save (See p. 4-132.)

This area provides the functions regarding the automatic saving of the 
measurement data files.

3

a

b
c

2

1
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3. Operating Tools

• Toolbar (See p. 4-133.)

This provides the functions that are very frequently used in the button 
format.

• Main Menu (See p. 4-135.)

This provides the functions needed for various operations in the menu 
format.

For the dialog boxes displayed during this software operation, see “Dialog Boxes” 
on page 4-137.

For the files handled by this software, see “Summary of Files” on page 4-140.

Work Area
In this area, set the measurement conditions and observe the measurement results. 
This is separated to the following areas.

• Conditions (See p. 4-120.)

• Gate Charge Characteristics (See p. 4-123.)

• Switching Waveform (See p. 4-127.)

Conditions
This is an area to enter your measurement conditions. For the setting range of the 
condition parameters, see Table 4-23 on page 4-122.

This area can be hidden or shown by clicking the line of  Conditions.

Figure 4-25 Conditions

Drain Set the conditions for driving the drain of DUT. 

Vds(off) Enter a value of the drain-source voltage at the off-state.

Id(on) Enter a value of the drain current at the on-state when the 
constant current load is used.



B1506A User’s Guide, Edition 7 4-121

GUI Reference
Gate Charge Measurement Software

When the constant current load is not used, the on-state current 
is decided by the off-state voltage, resistance of the resistive 
load, and the on-state resistance/saturation voltage. For the 
current output range of the power supply, the minimum range 
including Id(on) is automatically selected. 

Gate Set the conditions for driving the gate of DUT.

Vgs(off) Enter a value of the gate-source voltage to change the DUT to 
the off-state.

Vgs(on) Enter a value of the gate-source voltage to completely change 
the DUT to the on-state.

Ig Enter a limit value of the gate current. This value impacts on the 
switching time. Large Ig shortens the switching time, and small 
Ig elongates it.

Current Load Mark the check box when you want to use the constant current load.

Set the conditions for driving the gate of the transistor for the constant current load, 
that is the source of the on-state current described in “Drain” on page 4-120.

When you use the resistive load (not use the constant current load), unmark the 
check box to disable the constant current load.

LoadVgs(off) Enter a value of the gate-source voltage to change the transistor 
for the constant current load to the off-state.

LoadVgs(on) Enter a value of the gate-source voltage to completely change 
the transistor for the constant current load to the on-state.

Before the gate charge measurement, DUT is completely changed to the on-state. 
During this situation, the gate-drain voltage of the transistor is searched from 
Vgs(off) to Vgs(on) so that the specified on-state current Id (on) flows. The 
transistor is driven by the searched gate-source voltage, and then the gate charge 
measurement is executed. Where, “DUT is completely changed to the on-state” 
means the state that the gate-source voltage of the DUT is set to the Vgs(on) entered 
for the gate drive condition.
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Table 4-23 Setting Range for Parameters

Setting Parameter
Setting Range

B1506A-H21 B1506A-H51 B1506A-H71

Vds(off) @High Voltage 0 V to +3000 V

Vds(off) @High Current -40 V to +40 V -60 V to +60 V

Id(on) max. 20 A 450 A 1100 A

Vgs(off) -30 V to +30 V

Vgs(on) -30 V to +30 V

Ig 1 A to 1 A

LoadVgs(off) -30 V to +30 V

LoadVgs(on) -30 V to +30 V
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Gate Charge Characteristics
This page shows the graph and extracted parameters of the gate charge 
characteristics as the measurement results. To display this page, click the Gate 
Charge Characteristics tab.

Figure 4-26 Gate Charge Characteristics

a. Displaying 
Characteristic 
Curves

This area can display multiple characteristics curves as shown in the following list. 
To display curves, mark the check boxes for the characteristics curves you want to 
display.

• JESD24-2 (Derived)

Shows the gate charge characteristics when the off-state voltage and the on-state 
current specified in “Drain” are applied.

• Vgs-Qg (H.C.)

Shows the gate charge characteristics when the on-state current specified in 
“Drain” is applied.

When the constant current load is not used, the on-state current is decided by the 
off-state voltage, resistance of the resistive load, on-state resistance, and the 
output voltage of UHCU/HCSMU.

• Vgs-Qg (H.V.)

a

c

d
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Shows the gate charge characteristics when the off-state voltage specified in 
“Drain” is applied.

• JESD24-2 (H.C.)

Shows an approximation straight line of Vgs-Qg (H.C.) gate charge 
characteristics. The approximation is calculated on sloops (S1, S2, and S3) 
defined in JEDEC Standard JESD24-2.

• JESD24-2 (H.V.)

Shows an approximation straight line of Vgs-Qg (H.V.) gate charge 
characteristics. The approximation is calculated on sloops (S1, S2, and S3) 
defined in JEDEC Standard JESD24-2.

• Vds-Qg (H.C.)

Shows the relationship between the drain-source voltage and gate charge when 
the Vgs-Qg (H.C.) is measured.

For HCSMU, the drain-source voltage is a voltage between the drain of the 
constant current load transistor and the source of DUT.

• Vds-Qg (H.V.)

Shows the relationship between the drain-source voltage and gate charge when 
the Vgs-Qg (H.V.) is measured.

• Id-Qg (H.C.)

Shows the relationship between the drain current and gate charge when the 
Vgs-Qg (H.C.) is measured.

• Id-Qg (H.V.)

Shows the relationship between the drain current and gate charge when the 
Vgs-Qg (H.V.) is measured.

b. Adjusting Scale The following buttons are available for adjusting the graph scale.

 : Auto scale button for Y-axis

 : Auto scale button for X-axis

 : Scale mode button when the auto scale mode is selected

 : Scale mode button when the fixed scale mode is selected

Clicking the auto scale button fits the measurement data at that time in the graph 
scale.
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In the auto scale mode, the measurement data is automatically fit according to the 
progress of the measurement.

In the fixed scale mode, the scale is fixed until changing the scale manually or 
clicking the auto scale button. 

The string left next to the auto scale button indicates the scale resolution and the 
minimum value of the graph. For example, [2 V/div 0 V] means the scale resolution 
2 V and the minimum value 0 V. Clicking the value allows to change the value.

c. Markers This graph supports two markers (A and B). Marker A is always available. To use 
the Marker B, mark the check box for the Marker B. The Marker B is a break line. 
To move the marker position, use the rotary knob or mouse.

The marker annotation on the graph has X-axis values for markers, and a difference 
value () between the Marker B and A (BA). And, each curve annotation has 
Y-axis values and difference values () between the Marker B and A (BA).

d. Trace 
Representation

The curves can be represented as Line, Dot, or combination (Line & Dot). Select 
any trace representation using the radio buttons shown in the bottom part of the 
graph.

e. Reference 
Traces

You can register the presently-displayed curves as reference traces to compare with 
other measurement results on the graph. If you register them as reference traces, the 
reference traces are displayed as dimmed thin lines on the graph when you open 
other measurement data files or execute the next measurement. To register as the 
reference traces, click the Capture button  shown in the bottom part of the graph.

You can register a maximum of 10 reference traces. The measurement data files 
registered as the reference traces are listed in the References field under the Capture 
button . You can show or hide the reference traces using the check boxes at the 
head of the measurement data file names. The References field can be hidden or 
shown by clicking the line of the  button on top of the graph. 

To remove unnecessary reference traces, select the measurement data file in the 
References field, and then click the Remove button . 

The registration of the reference traces is cleared when you exit the gate charge 
measurement software.

f. Parameters To extract and show the gate charge parameter values according to JESD24-2 
(Derived), JESD24-2 (H.C.), and JESD24-2 (H.V.) in this area, enter the threshold 
voltage Vgs(th) of the DUT. You can change the display contents by clicking the 
tabs.

Vgs(pl) Gate plateau voltage
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Qgs Gate-source charge
Gate charge for slope S1 according to JEDEC Standard 
JESD24-2

Qgd Gate-drain charge
Gate charge for slope S3 according to JEDEC Standard 
JESD24-2

Qg(th) Gate-source threshold charge
Gate charge from Vgs(off) to Vgs(th)

Qg(on) On-state gate-source charge
Gate charge from Vgs(off) to Vgs(on)

C1 Qgs/{Vgs(pl)-Vgs(off)}
Equivalent capacitance for S1 in JESD24-2

C2 {Qg(on)-Qgs-Qgd}/{Vgs(on)-Vgs(pl)}
Equivalent capacitance for S2 in JESD24-2

S1 S1 in JESD24-2

S2 S2 in JESD24-2

This area can be hidden or shown by clicking the column of  Parameters at the 
right side of the window.
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Switching Waveform
This page shows the switching waveforms of DUT to observe the switching 
behavior. And, you can also set detailed parameters before the measurement. To 
display this page, click the Switching Waveform tab.

The gate charge characteristics is calculated from the gate current and waveform 
data of the gate-source voltage obtained from the switching, and the calibration data.

There are the following switching modes.

• “High Current Switching Mode”

UHCU or HCSMU is used as a power supply to force the on-state current 
specified in “Drain” to DUT via the constant current load specified in “Current 
Load”.

And, the applied voltage is determined as follows, depending on the off-state 
voltage specified in “Drain”.

• If the off-state voltage is within the output voltage range of UHCU/HCSMU, 
they force the specified voltage. The maximum output voltage of UHCU is 
60 V and it of HCSMU is 20 V at 20 A range.

• If the off-state voltage exceeds the output voltage range of UHCU/HCSMU, 
UHCU forces 60 V and HCSMU forces 20 V.

If you don’t use the constant current load, the applied current is determined from 
the load resistance, on-state resistance of DUT, and the output voltage of the 
power supply.

• “High Voltage Switching Mode”

HVSMU is used as a power supply to force the off-state voltage specified in 
“Drain” to DUT.

This page has the graph area to display the time-domain switching waveforms and 
the advanced setup area to set the detailed parameters for the measurement in the 
above modes. To switch the mode, click the tab (High Current or High Voltage) on 
the left side.
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High Current Switching Mode

Figure 4-27 Switching Waveform (High Current Switching Mode)

a. Displaying 
Characteristic 
Curves

This area can display the following switching waveforms in the high current 
switching mode. To display switching waveform(s), mark the check boxes for the 
waveforms.

• Vds: Drain-source voltage waveform

• Id: Drain current waveform

• Vgs: Gate-source voltage waveform

• Ig: Gate current waveform

• LoadVgs: Gate-source voltage waveform of the current load

• LoadIg: Gate current waveform of the current load

b. Adjusting Scale The following buttons are available for adjusting the graph scale.

 : Auto scale button for Y-axis

 : Auto scale button for X-axis

 : Scale mode button when the auto scale mode is selected

 : Scale mode button when the fixed scale mode is selected

a

bc

d
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Clicking the auto scale button fits the measurement data at that time in the graph 
scale.

In the auto scale mode, the measurement data is automatically fit according to the 
progress of the measurement.

In the fixed scale mode, the scale is fixed until changing the scale manually or 
clicking the auto scale button. 

The string left next to the auto scale button indicates the scale resolution and the 
minimum value of the graph. For example, [2 V/div 0 V] means the scale resolution 
2 V and the minimum value 0 V. Clicking the value allows to change the value.

c. Other Graph 
Functions

On the graph, you can read values using the markers, change the trace 
representation, and use the reference traces. For details, see “c. Markers” on page 
4-125, “d. Trace Representation” on page 4-125, and “e. Reference Traces” on page 
4-125.

d. Advanced Setup This area is hidden as default. You can show this area under the graph area by 
clicking the line of  High Current Setup. 

This area shows the setup items on the measurement circuit and timing chart. To edit 
the setting values, mark the check box of the High Current Setup.

LoadIg Gate current limit for Current Load

Ig Gate current limit for DUT

Gate Resistor Gate resistance for DUT
(Same value is used between the both switching modes.)

Id(on) On-state drain current

LoadVgs Gate to-source voltage for Current Load adjusted to Id(on)

By marking the check box, you can overwrite the gate-source 
voltage of the current load that was adjusted according to the 
Id(on).

LoadVgs(off) Off-state gate-source voltage for Current Load

Vds(off) Off-state drain-source voltage

Vgs(stop) Stop value for Vgs

Vgs(start) Start value for Vgs

DelayVds Delay time from Current Load gating to off-state drain-source 
voltage application
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DelayVgs Delay time from off-state drain-source voltage application to 
start of Vgs swing

OnPeriod Period from start of Vgs swing to Vds zero

High Voltage Switching Mode

Figure 4-28 Switching Waveform (High Voltage Switching Mode)

a. Displaying 
Characteristic 
Curves

This area can display the following switching waveforms in the high voltage 
switching mode. To display switching waveform(s), mark the check boxes for the 
waveforms.

• Vds: Drain-source voltage waveform

• Id: Drain current waveform

• Vgs: Gate-source voltage waveform

• Ig: Gate current waveform

a

bc

d
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b. Adjusting Scale The following buttons are available for adjusting the graph scale.

 : Auto scale button for Y-axis

 : Auto scale button for X-axis

 : Scale mode button when the auto scale mode is selected

 : Scale mode button when the fixed scale mode is selected

Clicking the auto scale button fits the measurement data at that time in the graph 
scale.

In the auto scale mode, the measurement data is automatically fit according to the 
progress of the measurement.

In the fixed scale mode, the scale is fixed until changing the scale manually or 
clicking the auto scale button. 

The string left next to the auto scale button indicates the scale resolution and the 
minimum value of the graph. For example, [2 V/div 0 V] means the scale resolution 
2 V and the minimum value 0 V. Clicking the value allows to change the value.

c. Other Graph 
Functions

On the graph, you can read values using the markers, change the trace 
representation, and use the reference traces. For details, see “c. Markers” on page 
4-125, “d. Trace Representation” on page 4-125, and “e. Reference Traces” on page 
4-125.

d. Advanced Setup This area is hidden as default. You can show this area under the graph area by 
clicking the line of  High Voltage Setup. 

This area shows the setup items on the measurement circuit and timing chart. To edit 
the setting values, mark the check box of the High Voltage Setup.

Ig Gate current limit for DUT

Gate Resistor Gate resistance for DUT
(Same value is used between both switching modes.)

Vds(off) Off-state drain-source voltage

Vgs(stop) Stop value for Vgs

Vgs(start) Start value for Vgs

DelayVgs Delay time from off-state drain-source voltage application to 
start of Vgs swing

OnPeriod Period from start of Vgs swing to Vds zero
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Automatic Data Save
This area sets the automatic saving for the setup data and measurement data. These 
data are automatically saved to a new measurement data file in the specified folder 
at the end of the measurement.

The Data folder and Recent data fields can be shown or hidden by clicking the line 
of  Automatic Data Save.

Figure 4-29 Automatic Data Save

Device ID Enter device ID string to the Device ID field. The maximum 10 
recently-entered device IDs can be kept as history, and you can 
also select one from the history list.

The entered device ID is automatically saved to the 
measurement data file at the end of the measurement.

You can also change the device ID in the latest measurement 
data file after the measurement here. To change it, change the 
device ID in the Device ID field, and then click the Apply 
button .

Comment Enter a comment string to the Comment field.

The entered comment is automatically saved to the 
measurement data file at the end of the measurement.

You can also change the comment in the latest measurement 
data file after the measurement here. To change it, change the 
comment in the Comment field, and then click the Apply 
button .

Data The Data field shows the latest auto-saved or last-opened 
measurement data file name. You can do the following 
operations.

• Open the measurement data file by clicking the Open 
button .

• Rename the measurement data file by clicking the 
measurement data file name.

• Delete the measurement data file by clicking the Delete 
button .
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Data folder Shows the absolute path of the auto-saved measurement data 
file. To change this, click the Browse button to open the folder 
selection dialog box. Select your desired folder in the dialog 
box.

For the initial setting of the data folder, see “Summary of Files” 
on page 4-140.

Recent data Shows up to 10 auto-saved measurement data files that were 
automatically saved recently, in the hyper-link format. Clicking 
the hyper-link opens the selected measurement data file. This 
destroys the presently-editing data.

If the number of the auto-saved measurement data files is over 
ten, this field shows “more...”. Clicking this opens the file 
selection dialog box. Select a measurement data file to open.

Toolbar

Figure 4-30 Toolbar

The toolbar has five tool button groups. The following shows the tool buttons in the 
tool button groups.

File tool button group

Open Opens the Open File dialog box used to open a 
specified setup file or measurement data file. The 
present data is cleared by opening the file.

Save Saves the present data as the same file name.

Exit Exits the gate charge measurement software. Unsaved 
data is destroyed.

Edit tool button group

Cut Moves the selected text to the clipboard.
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Copy Copies the selected text to the clipboard.

Paste Pastes the text from the clipboard to the insertion point.

On-screen 
keyboard

Displays the on-screen keyboard.

Measurement tool button group

Start 
Measurement

Starts a measurement. During the measurement, the 
measurement status indicator on the front panel lights 
up.

To stop the repeat measurement, select the 
Measurement > Stop menu, click the Stop 
Measurement button  on the toolbar, or press the Stop 
key on the front panel.

Stop 
Measurement

Stops the measurement.

View tool button group

Go to Palette Displays the software palette in fullscreen mode.

Calibration tool button group

Start Calibration... Opens the Calibration dialog box to get the calibration 
data. See “Calibration Dialog Box” on page 4-138.

Select Calibration 
Data...

Opens a dialog box for the file selection, and then 
applies the selected calibration data file to the 
measurement.
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Main Menu

Figure 4-31 Main Menu

The following describes the functions of the main menu.

File Menu Displays the following menu items to operate the setup file and measurement data 
file. For the file types and extensions, see “Summary of Files” on page 4-140.

New Clears the present data to start from initial setting.

Open... Opens the Open File dialog box used to open a specified setup 
file or measurement data file. The present data is cleared by 
opening the file.

Save Saves the present data as the same file name.

Save Setup As... Opens the Save Data File dialog box used to save the present 
setup data as the specified setup file.

Save Data As... Opens the Save Data File dialog box used to save the present 
setup data and measurement data as the specified measurement 
data file.

Change Device 
ID... Changes the device ID recorded in the measurement data file.

This opens the Change Device ID dialog box, and changes the 
device ID recorded in the selected measurement data file(s). See 
“Change Device ID Dialog Box” on page 4-137.

Recent Setup Files 
Lists a maximum of 10 names of the setup files that were 
recently edited, as menu items. You can easily open a setup file 
by using them.

Exit Exits the gate charge measurement software. Unsaved data is 
destroyed.

Edit Menu Displays the following menu items to edit the setup.

Cut Moves the selected text to the clipboard.

Copy Copies the selected text to the clipboard.

Paste Pastes the text from the clipboard to the insertion point.
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On-screen 
keyboard... Displays the on-screen keyboard.

View Menu Displays the following menu items for the display setting.

Go to Palette Displays the software palette in fullscreen mode.

Main Window Displays the following menu item.

Fullscreen Changes the display style of the main 
window.

If this is marked, the main window does not 
have the titlebar and is displayed in 
fullscreen mode.

If this is unmarked, the main window has 
the titlebar and is displayed in the regular 
window style.

This is initially marked.

Color Settings... Opens the Color Setting dialog box to set the color for parts in 
this software. See “Color Setting Dialog Box” on page 4-137.

Calibration Menu Displays the following menu items for the calibration.

Start Opens the Calibration dialog box to get the calibration data. See 
“Calibration Dialog Box” on page 4-138.

Select Data Opens a dialog box for the file selection, and then applies the 
selected calibration data file to the measurement.

Load Factory 
Default Applies the factory default calibration data file to the 

measurement.

Measurement 
Menu

Displays the following menu items for controlling the measurement.

Start Starts a measurement. During the measurement, the 
measurement status indicator on the front panel lights up.

To stop the repeat measurement, select the Measurement > Stop 
menu, click the Stop Measurement button  on the toolbar, or 
press the Stop key on the front panel.

Stop Stops the measurement.
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Configuration 
Menu

Displays the following menu item to administrate the configuration of the built-in 
modules in the mainframe and test fixture.

Module... Opens the Module Configuration dialog box. See “Module 
Configuration Dialog Box” on page 4-183.

Help Menu Displays the following menu item.

About... Opens the about box. See “About Box” on page 4-139.

Dialog Boxes

Change Device ID Dialog Box
The Change Device ID dialog box is used to change the device ID in all selected 
measurement data files at once.

This dialog box is opened by selecting the main menu File > Change Device ID....

Device ID field Enter a new device ID. You can also select it from the history.

Add... button Opens the file selection dialog box to select the measurement 
data file(s) that you want to change the device ID. The selected 
files are displayed into the list.

Remove button Excludes the selected measurement data file from the list.

Execute button Changes the device ID.

Close button Closes this dialog box.

Color Setting Dialog Box
The Color Setting dialog box is used to set colors of the following parts in this 
software. The setting in the Color Setting dialog box is saved as a user setting.

• Graph Background

• Graph Axis

• Graph Grid

• Graph Text

• Marker
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• Gate Charge Characteristics

• JESD24-2 (H.C.)

• Vgs-Qg (H.C.)

• Vds-Qg (H.C.)

• Id-Qg (H.C.)

• JESD24-2 (H.V.)

• Vgs-Qg (H.V.)

• Vds-Qg (H.V.)

• Id-Qg (H.V.)

• JESD24-2 (Derived)

• Switching Waveform

• Vds

• Id

• Vgs

• Ig

• LoadVgs

• LoadIg

This dialog box is opened by selecting the main menu View > Color Settings....

Clicking the color pattern opens the dialog box for selecting a color.

Apply button Applies the present setting to the graph.

Reset button Resets to the default setting.

OK button Applies the present setting to the graph, and closes this dialog 
box.

Cancel button Closes this dialog box without applying the present setting.

Calibration Dialog Box
The Calibration dialog box is used to acquire the calibration data regarding the 
residual resistance and parasitic capacitance on the signal paths, and apply it to the 
measurement.
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If you change the signal paths to DUT, you need to acquire the calibration data for 
the new paths.

This dialog box is opened by selecting the main menu Calibration > Start.

Default Calibration 
tab

This page is used to acquire the calibration data for “Open” and “Short” of the DUT 
gate drive circuit under the predetermined measurement condition.

User Series 
Resistor Enter the value of the external series resistor to be not measured 

by the “Short” calibration.

The residual resistance measured by the “Short” calibration and 
this resistance value are used for the calibration. 

Measure button Starts to acquire the calibration data. Open or short the gate 
charge measurement circuit according to instructions of the 
wizard.

Save and Apply 
button Saves the acquired calibration data to a file, and applies it to the 

measurement.

Cancel button Destroys the acquired calibration data and closes this dialog 
box.

Advanced tab This page is used to acquire the calibration data for “Open” of the DUT gate drive 
circuit under the present setup.

Measure button Starts to acquire the calibration data. Open the gate charge 
measurement circuit according to instructions of the wizard.

Clear button Destroys the calibration data acquired on this tab page, and 
cancels to apply. The factory default calibration data is used for 
the “Open” calibration.

Close button Closes this dialog box.

About Box
The about box displays the model number, the software revision number, download 
URL for software updating, and so on.

This dialog box is opened by selecting the main menu Help > About....
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Summary of Files
The following shows the summary of the files handled by the gate charge 
measurement software.

Table 4-24 Summary of Files

File name of Measurement Data File on Auto-saving
An auto-saved measurement data file is named as follows:

<DeviceID>_<TEMP>_<TIME>.pda-qg.txt

<DeviceID>:  Device ID

<TEMP>:  Temperature

<TIME>:  Time stamp on auto-saving

Example)
Device-1_@Ch1=30degC_Ch2=30degC_2014-10-30_18-56-55.pda-qg.txt

File Type Description Extension Folder as Initial Setting

Setup File This has the setup data only.

You can save this using the File menu 
anytime.

*.pda-qg (You can specify the folder 
when saving the data)

Measurement 
Data File

This has the setup data and 
measurement data including the device 
ID and comment. 

The setup data and measurement data 
are automatically saved to this file in 
the specified folder at the end of the 
measurement. And, you can also save 
this using the File menu anytime.

*.pda-qg.txt C:\Users\<user name>\
Documents\Keysight\
SeriesB150x\PowerDevice
Analyzer\GateCharge\Data
Store
(You can change this)

Calibration Data 
File

Calibration data

This is automatically saved after the 
calibration execution.

*.pda-qg.cal C:\ProgramData\Keysight\
SeriesB150x\PowerDevice
Analyzer\GateCharge\User
CalibrationData

Factory Default Calibration data

This is used when there is no user 
calibration data.

C:\ProgramData\Keysight\
SeriesB150x\PowerDevice
Analyzer\GateCharge\Cali
brationData
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And, the file name is decided according to the following rule.

1. <TEMP> is the characters of the available thermometer identifiers and the 
thermometer readings. To enable thermometers, use the Thermal 
Monitor/Control Software. See “Thermal Monitor/Control Software” on page 
4-163.

@<thermometer>=<reading>degC

• <thermometer>: An identifier of the available thermometer

Ch1 Channel 1 thermometer of B1506A

Ch2 Channel 2 thermometer of B1506A

Air Thermometer on the air outlet port of the thermostream

DUT Thermometer on the DUT port of the thermostream

• <reading>: A reading value of the thermometer in degrees centigrade

If multiple thermometers are available, the temperature information is 
concatenated by an underscore (_). The @ is attached only at the beginning 
of the temperature information. 

Example) @Ch1=25degC_Ch2=75degC_Air=100degC

2. <TIME> is the characters of year, month, day, hour, minute, and second. The 
time stamp representation depends on the time setting on Windows. And, an 
invalid character is replaced with an underscore (_).

Example 1) 2014-10-30_18-56-55
Example 2) 30-10-2014_6-56-55_PM

3. If the file name duplicates the existing file name, the serial number from 2 
enclosed by brackets is concatenated before the file extension.

Example)
Device-1_@Ch1=30degC_Ch2=30degC_2014-10-30_18-56-55(3).pda-qg.txt
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Power Loss Calculation Software
NOTE This software is available for the B1506A-H21/H51/H71.

Power loss calculation software provides:

• Calculation of switching device power loss for:

• Hard switching mode

• Soft switching mode

• Inputs to characterize the following parameters:

• Gate resistance

• On resistance

• Gate charge

• Gate switching charge

• Equivalent output capacitance (energy related)

• Equivalent output capacitance (time related)

• Input parameter assistance using related measurement data including:

• Display of source measurement data

• Switching condition parameter input

• Support of parameter sweep for one parameter

• Power loss calculation results of:

• Total power loss

• Conductive power loss

• Driving power loss

• Switching power loss (inductive load)

• Graph representation of loss components for optional parameter sweep
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GUI Overview
The GUI (Graphical User Interface) of the Power loss calculation software is 
comprised of the following areas.

Figure 4-32 Power Loss Calculation Software GUI

1. Work Area (See p. 4-144.)

This area provides the functions to set the calculation conditions and observe the 
calculation results. This is separated to the following areas.

a. Conditions (See p. 4-144.)

b. Inputs (See p. 4-145.)

c. Results (See p. 4-152.)

2. Automatic Data Save (See p. 4-155.)

This area provides the functions regarding the automatic saving of the 
calculation data files.

3

a
b

c

2

1
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3. Operating Tools

• Toolbar (See p. 4-156.)

This provides the functions that are very frequently used in the button 
format.

• Main Menu (See p. 4-158.)

This provides the functions needed for various operations in the menu 
format.

For the dialog boxes displayed during this software operation, see “Dialog Boxes” 
on page 4-160.

For the files handled by this software, see “Summary of Files” on page 4-161.

Work Area
In this area, set the calculation conditions and observe the calculation results. This is 
separated to the following areas.

• Conditions (See p. 4-144.)

• Inputs (See p. 4-145.)

• Results (See p. 4-152.)

Conditions
This is an area to specify your assumption to calculate the power loss on your 
switching device.

This area can be shown or hidden by clicking the line of  Conditions.

Figure 4-33 Conditions

Load Type Select the assumed load type to calculate the power loss. You can select one from 
the following load types.

• Inductive: Inductive load

• Resistive: Resistive load
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Inputs
This is an area to specify the device type of your DUT, and driving condition and 
device characteristic parameters that are used as the input data for calculation. The 
driving condition parameters and device characteristic parameters are separated by 
tabs.

Other than manually entering the parameter values with referring the device data 
sheet, you can also enter them using existing measurement data files. This area is 
equipped with the functions to read existing measurement data files, display the 
characteristic curve graphs, and extract some parameter values from them. The 
following measurement data files are readable.

• I/V measurement data file

• Capacitance measurement data file

• Gate charge measurement data file

They are separated by tabs.

This area can be hidden or shown by clicking the line of  Inputs.

Figure 4-34 Inputs

a. Device Type Select the device type of your DUT from below.

• MOSFET

• IGBT

a

b

c d e f g h
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b. Sweep 
Parameter

Select one parameter that is swept to observe the loss changes for the changes of this 
parameter, from the driving condition parameters and device characteristic 
parameters. To select it, mark the check box of the parameter. As the default, the 
Switching Frequency parameter in the Driving parameters is selected.

Specify the following items for the selected parameter as the sweep parameter.

• Start

Specify the sweep start value.

• Stop

Specify the sweep stop value.

• Sweep Mode

Select one from the following sweep modes.

• Linear (Sweep from start to stop in a linear incremental step)

• Log (Sweep from start to stop in a logarithmic incremental step)

• Number of Step

Specify the number of sweep steps from start to stop.

c. Drive 
Conditions

Specify the driving condition parameter values.

For MOSFET:

• f: Switching Frequency

Specify the switching frequency.

• Vgs(on): Gate-source turn on Voltage

Specify the gate-source voltage required to turn the device on. 

• Vgs(off): Gate-source turn off Voltage

Specify the gate-source voltage required to turn the device off. 

• Id: Drain Current

Specify the On-state drain current.

• Vds: Drain-source Voltage

Specify the Off-state drain-source voltage.

• Rg(ext): External Gate Resistance

Specify the gate resistance included in the external driving circuit.
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• Irms: Effective Drain Current

Specify the effective drain current (the root mean square of the load current).

The effective drain current (Irms) is the product of the square root of the drain 
current (Id) and the duty cycle (D).

• D: Duty Cycle

Specify the duty cycle within the range from 0 to 1. 

For IGBT:

• f: Switching Frequency

Specify the switching frequency.

• Vge(on): Gate-Emitter turn on Voltage

Specify the gate-emitter voltage required to turn the device on. 

• Vge(off): Gate-Emitter turn off Voltage

Specify the gate-emitter voltage required to turn the device off. 

• Ic: Collector Current

Specify the On-state collector current.

• Vce: Collector-Emitter Voltage

Specify the Off-state collector-emitter voltage.

• Rg(ext): External Gate Resistance

Specify the gate resistance included in the external driving circuit.

• Irms: Effective Collector Current

Specify the effective collector current (the root mean square of the load current).

The effective collector current (Irms) is the product of the square root of the 
collector current (Ic) and the duty cycle (D).

• D: Duty Cycle

Specify the duty cycle within the range from 0 to 1. 

d. Device 
Parameters

Specify the device characteristic parameter values.

For MOSFET:

• Qg(on): Gate Charge at on
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Specify the On-state gate charge.
Qg(on)  Qg(off) is regarded as the gate charge required to turn the device on.

• Qg(off): Gate Charge at off

Specify the Off-state gate charge.
Qg(on)  Qg(off) is regarded as the gate charge required to turn the device on.

• Rg: Gate Resistance

Specify the gate resistance.

• Qsw: Gate Switching Charge (Crss)

Specify the required gate charge (Mirror Charge) so that the drain-source 
voltage is same as the gate-source voltage when the device state changes from 
Off to On.

• Vgs(pl): Gate Plateau Voltage

Specify the gate plateau voltage.

• Rds(on): On Resistance

Specify the On-state resistance.

For IGBT:

• Qg(on): Gate Charge at on

Specify the On-state gate charge.
Qg(on)  Qg(off) is regarded as the gate charge required to turn the device on.

• Qg(off): Gate Charge at off

Specify the Off-state gate charge.
Qg(on)  Qg(off) is regarded as the gate charge required to turn the device on.

• Rg: Gate Resistance

Specify the gate resistance.

• Qsw: Gate Switching Charge (Cres)

Specify the required gate charge (Mirror Charge) so that the collector-emitter 
voltage is same as the gate-emitter voltage when the device state changes from 
Off to On.

• Vge(pl): Gate Plateau Voltage

Specify the gate plateau voltage.

• Vce(sat): Saturation Voltage
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Specify the collector-emitter saturation voltage.

It is the saturation voltage when the collector current (Ic) carries under the Drive 
Condition settings.

e. Output 
Characteristics

Specify the measurement data file taken by the I/V measurement software. To read 
the file, click the Load Measurement Data button  in the top left corner. The file 
selection dialog box opens to read the file. The file name to be read is displayed next 
to the Load Measurement Data button. And, the output characteristic data is 
displayed on the graph.

You can change the minimum and maximum values on the X and Y-axes by clicking 
the value.

For MOSFET:

The measurement data file that has any of the following output characteristics is 
readable.

• ID-VDS

• RDS-ID

• VDS-VGS

• RDS-VGS

The following parameter value is extracted from the Vgs(on) parameter value 
specified in the Drive Conditions and the output characteristic data to be read.

• Device Parameters

• Rds(on): On Resistance

For IGBT:

The measurement data file that has any of the following output characteristics is 
readable.

• IC-VCE

• VCE(sat)

• VCE-VGE

The following parameter value is extracted from the Vge(on) parameter value 
specified in the Drive Conditions and the output characteristic data to be read.

• Device Parameters

• Vce(sat): Saturation Voltage
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f. Gate Resistance Specify the Rg characteristic measurement data file taken by the capacitance 
measurement software. To read the file, click the Load Measurement Data button  
in the top left corner. The file selection dialog box opens to read the file. The file 
name to be read is displayed next to the Load Measurement Data button. And, the 
Rg characteristic data is displayed on the graph.

You can change the minimum and maximum values on the X and Y-axes by clicking 
the value.

For MOSFET:

The following parameter value is extracted from the Vgs(off) parameter value 
specified in the Drive Conditions and the Rg characteristic data to be read.

• Device Parameters

• Rg: Gate Resistance

For IGBT:

The following parameter value is extracted from the Vge(off) parameter value 
specified in the Drive Conditions and the Rg characteristic data to be read.

• Device Parameters

• Rg: Gate Resistance

g. Capacitance Specify the measurement data file taken by the capacitance measurement software. 
To read the file, click the Load Measurement Data button  in the top left corner. 
The file selection dialog box opens to read the file. The file name to be read is 
displayed next to the Load Measurement Data button. And, the characteristic data is 
displayed on the graph.

You can change the minimum and maximum values on the X and Y-axes by clicking 
the value.

For MOSFET:

The measurement data file that has the following capacitance characteristics is 
readable.

• Ciss, Coss, Crss (Coss or Crss)

The Coss characteristics data is used to calculate the output capacitance loss.

The following parameter value is extracted from the Vgs(off) and Vds(off) 
parameter values specified in the Drive Conditions and the Crss characteristic data 
to be read.
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• Device Parameters

• Qsw: Gate Switching Charge

Charge when the Crss is charged from 0 V to Vds(off)-Vgs(off).

For IGBT:

The measurement data file that has the following capacitance characteristics is 
readable.

• Cies, Coes, Cres (Coes or Cres)

The Coes characteristics data is used to calculate the output capacitance loss.

The following parameter value is extracted from the Vge(off) and Vce(off) 
parameter values specified in the Drive Conditions and the Cres characteristic data 
to be read.

• Device Parameters

• Qsw: Gate Switching Charge

Charge when the Cres is charged from 0 V to Vds(off)-Vgs(off).

h. Gate Charge Specify the measurement data file taken by the gate charge measurement software. 
To read the file, click the Load Measurement Data button  in the top left corner. 
The file selection dialog box opens to read the file. The file name to be read is 
displayed next to the Load Measurement Data button. And, the gate charge 
characteristic data is displayed on the graph.

You can change the minimum and maximum values on the X and Y-axes by clicking 
the value.

The following parameter values are extracted from the gate charge characteristic 
data to be read.

For MOSFET:

• Drive Conditions

• Vgs(on): Gate-source turn on Voltage

• Vgs(off): Gate-source turn off Voltage

• Id: Drain Current

• Vds: Drain-source Voltage
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• Device Parameters

• Qg(on): Gate Charge at on

• Qg(off): Gate Charge at off

• Qsw: Gate Switching Charge (Crss)

• Vgs(pl): Gate Plateau Voltage

For IGBT:

• Drive Conditions

• Vge(on): Gate-source turn on Voltage

• Vge(off): Gate-source turn off Voltage

• Ic: Collector Current

• Vce: Collector-Emitter Voltage

• Device Parameters

• Qg(on): Gate Charge at on

• Qg(off): Gate Charge at off

• Qsw: Gate Switching Charge (Cres)

• Vge(pl): Gate Plateau Voltage

Results
This area shows the power loss data in the list and the trend chart formats, that was 
calculated along your parameter settings specified in the Inputs.

Figure 4-35 Results
a b
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a. List Shows the loss data for the swept parameter values as the calculation result in the 
list format.

• Index

Shows the index number of the sweep step.

• Sweep parameter

Shows the sweep parameter value specified in the Inputs.

• Conduction Loss

Shows the conduction loss as the calculation result.
This is calculated from the following expression.

For MOSFET:

For IGBT:

• Coss (or Coes) Loss

Shows the output capacitance loss as the calculation result.
This is calculated from the following expression.

For MOSFET:

For IGBT:

• Switching Loss

Shows the switching loss as the calculation result.
This is calculated from either of the following expressions.

Rds on  Irms
2



Vce sat 
Ic

------------------------- Irms
2



f Coss V vd 
a

b


a Rds on  Id on =
b Vds=

f Coes V vd 
a

b


a Vce sat =

b Vce=
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When the Load Type specified in the Conditions is “Inductive” (MOSFET):

When the Load Type is “Resistive” (MOSFET):

When the Load Type specified in the Conditions is “Inductive” (IGBT):

When the Load Type is “Resistive” (IGBT):

• Driving Loss

Shows the driving loss as the calculation result.
This is calculated from the following expression.

For MOSFET:

For IGBT:

• Total Loss

Shows the total sum of the conduction loss, output capacitance loss, switching 
loss, and driving loss.

b. Trend Chart Shows the loss data for the swept parameter values as the calculation result in the 
trend chart format. Where, the sweep parameter is assigned to the data for the 
X-axis, and the conduction loss, output capacitance loss, switching loss, and driving 
loss are assigned to the data for the Y-axis and are accumulated in this order.

You can change the minimum and maximum values on the X and Y-axes by clicking 
the value.

1
2
--- f Vds Id Rg Rg ext +  Qsw

1
Vgs on  Vgs pl –
------------------------------------------------- 1

Vgs pl  Vgs off –
----------------------------------------------------+

 
 
 



1
6
--- f Vds Id Rg Rg ext +  Qsw

1
Vgs on  Vgs pl –
------------------------------------------------- 1

Vgs pl  Vgs off –
----------------------------------------------------+

 
 
 



1
2
--- f Vce Ic Rg Rg ext +  Qsw

1
Vge on  Vge pl –
------------------------------------------------- 1

Vge pl  Vge off –
----------------------------------------------------+

 
 
 



1
6
--- f Vce Ic Rg Rg ext +  Qsw

1
Vge on  Vge pl –
------------------------------------------------- 1

Vge pl  Vge off –
----------------------------------------------------+

 
 
 



f Qg on  Vgs on  Qg off – Vgs off  

f Qg on  Vge on  Qg off – Vge off  
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Automatic Data Save
This area sets the automatic saving for the setup data and measurement data. These 
data are automatically saved to a new measurement data file in the specified folder 
at the end of the measurement.

The Data folder and Recent data fields can be shown or hidden by clicking the line 
of  Automatic Data Save.

Figure 4-36 Automatic Data Save

Device ID Enter device ID string to the Device ID field. The maximum 10 
recently-entered device IDs can be kept as history, and you can 
also select one from the history list.

The entered device ID is automatically saved to the calculation 
data file at the end of the calculation.

You can also change the device ID in the latest calculation data 
file after the calculation here. To change it, change the device 
ID in the Device ID field, and then click the Apply button .

Comment Enter a comment string to the Comment field.

The entered comment is automatically saved to the calculation 
data file at the end of the calculation.

You can also change the comment in the latest calculation data 
file after the calculation here. To change it, change the comment 
in the Comment field, and then click the Apply button .

Data The Data field shows the latest auto-saved or last-opened 
calculation data file name. You can do the following operations.

• Open the calculation data file by clicking the Open 
button .

• Rename the calculation data file by clicking the calculation 
data file name.

• Delete the calculation data file by clicking the Delete 
button .
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Data folder Shows the absolute path of the auto-saved calculation data file. 
To change this, click the Browse button to open the folder 
selection dialog box. Select your desired folder in the dialog 
box.

For the initial setting of the data folder, see “Summary of Files” 
on page 4-161.

Recent data Shows up to 10 auto-saved calculation data files that were 
automatically saved recently, in the hyper-link format. Clicking 
the hyper-link opens the selected calculation data file. This 
destroys the presently-editing data.

If the number of the auto-saved calculation data files is over ten, 
this field shows “more...”. Clicking this opens the file selection 
dialog box. Select a calculation data file to open.

Toolbar

Figure 4-37 Toolbar

The toolbar has four tool button groups. The following shows the tool buttons in the 
tool button groups.

File tool button group

Open Opens the Open File dialog box used to open a 
specified setup file or calculation data file. The present 
data is cleared by opening the file.

Save Saves the present data as the same file name.

Exit Exits the power loss calculation software. Unsaved data 
is destroyed.

Edit tool button group

Cut Moves the selected text to the clipboard.
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Copy Copies the selected text to the clipboard.

Paste Pastes the text from the clipboard to the insertion point.

On-screen 
keyboard

Displays the on-screen keyboard.

Calculation tool button group

Start 
Calculation

Starts a calculation. 

To stop the calculation, select the Calculation > Stop 
menu, click the Stop Calculation button  on the 
toolbar, or press the Stop key on the front panel.

Stop 
Calculation

Stops the calculation.

View tool button group

Go to Palette Displays the software palette in fullscreen mode.
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Main Menu

Figure 4-38 Main Menu

The following describes the functions of the main menu.

File Menu Displays the following menu items to operate the setup file and calculation data file. 
For the file types and extensions, see “Summary of Files” on page 4-161.

New Clears the present data to start from initial setting.

Open... Opens the Open File dialog box used to open a specified setup 
file or calculation data file. The present data is cleared by 
opening the file.

Save Saves the present data as the same file name.

Save Setup As... Opens the Save Data File dialog box used to save the present 
setup data as the specified setup file.

Save Data As... Opens the Save Data File dialog box used to save the present 
setup data and calculation data as the specified calculation data 
file.

Change Device 
ID... Changes the device ID recorded in the calculation data file.

This opens the Change Device ID dialog box, and changes the 
device ID recorded in the selected calculation data file(s). See 
“Change Device ID Dialog Box” on page 4-160.

Recent Setup Files 
Lists a maximum of 10 names of the setup files that were 
recently edited, as menu items. You can easily open a setup file 
by using them.

Exit Exits the power loss calculation software. Unsaved data is 
destroyed.

Edit Menu Displays the following menu items to edit the setup.

Cut Moves the selected text to the clipboard.

Copy Copies the selected text to the clipboard.

Paste Pastes the text from the clipboard to the insertion point.
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On-screen 
keyboard... Displays the on-screen keyboard.

View Menu Displays the following menu items for the display setting.

Go to Palette Displays the software palette in fullscreen mode.

Main Window Displays the following menu item.

Fullscreen Changes the display style of the main 
window.

If this is marked, the main window does not 
have the titlebar and is displayed in 
fullscreen mode.

If this is unmarked, the main window has 
the titlebar and is displayed in the regular 
window style.

This is initially marked.

Color Settings... Opens the Color Setting dialog box to set the color for parts in 
this software. See “Color Setting Dialog Box” on page 4-160.

Calculation Menu Displays the following menu items for controlling the calculation.

Start Starts a calculation.

To stop the present calculation, select the Calculation > Stop 
menu, click the Stop Calculation button  on the toolbar, or 
press the Stop key on the front panel.

Stop Stops the calculation.

Help Menu Displays the following menu item.

About... Opens the about box. See “About Box” on page 4-161.
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Dialog Boxes

Change Device ID Dialog Box
The Change Device ID dialog box is used to change the device ID in all selected 
calculation data files at once.

This dialog box is opened by selecting the main menu File > Change Device ID....

Device ID field Enter a new device ID. You can also select it from the history.

Add... button Opens the file selection dialog box to select the calculation data 
file(s) that you want to change the device ID. The selected files 
are displayed into the list.

Remove button Excludes the selected calculation data file from the list.

Execute button Changes the device ID.

Close button Closes this dialog box.

Color Setting Dialog Box
The Color Setting dialog box is used to set colors of the following parts in this 
software. The setting in the Color Setting dialog box is saved as a user setting.

• Graph Background

• Graph Axis

• Graph Grid

• Graph Text

• Trend

• Driving Loss

• Output Capacitance Loss

• Switching Loss

• Conduction Loss

• Trace

This dialog box is opened by selecting the main menu View > Color Settings....

Clicking the color pattern opens the dialog box for selecting a color.

Apply button Applies the present setting to the graph.
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Reset button Resets to the default setting.

OK button Applies the present setting to the graph, and closes this dialog 
box.

Cancel button Closes this dialog box without applying the present setting.

About Box
The about box displays the model number, the software revision number, download 
URL for software updating, and so on.

This dialog box is opened by selecting the main menu Help > About....

Summary of Files
The following shows the summary of the files handled by the power loss calculation 
software.

Table 4-25 Summary of Files

File Type Description Extension Folder as Initial Setting

Setup File This has the setup data only.

You can save this using the File menu 
anytime.

*.pda-pl (You can specify the folder 
when saving the data)

Calculation data 
File

This has the setup data and calculation 
data including the device ID and 
comment. 

The setup data and calculation data are 
automatically saved to this file in the 
specified folder at the end of the 
calculation. And, you can also save 
this using the File menu anytime.

*.pda-pl.txt C:\Users\<user name>\
Documents\Keysight\Serie
sB150x\PowerDeviceAnal
yzer\PowerLoss\DataStore
(You can change this)
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File name of calculation data File on Auto-saving
An auto-saved calculation data file is named as follows:

<DeviceID>_<TIME>.pda-pl.txt

<DeviceID>:  Device ID

<TIME>:  Time stamp on auto-saving

Example)
Device-1_2014-10-30_18-56-55.pda-pl.txt

And, the file name is decided according to the following rule.

1. <TIME> is the characters of year, month, day, hour, minute, and second. The 
time stamp representation depends on the time setting on Windows. And, an 
invalid character is replaced with an underscore (_).

Example 1) 2014-10-30_18-56-55
Example 2) 30-10-2014_6-56-55_PM

2. If the file name duplicates the existing file name, the serial number from 2 
enclosed by brackets is concatenated before the file extension.

Example)
Device-1_2014-10-30_18-56-55(3).pda-pl.txt
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Thermal Monitor/Control Software
Thermal monitor/control software provides:

• Thermometer indication

• Thermal profile with measurement triggers

• Control of thermostream/thermal plate

The thermal monitor/control software has two view modes: Monitor mode and 
Control mode. Just after starting this software, the control mode GUI is displayed.

The following sections describes about GUI (Graphical User Interface) in two view 
modes.

• Monitor Mode GUI

• Control Mode GUI
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Monitor Mode GUI
The monitor mode GUI is a panel without a frame, and is displayed at the 
upper-right corner of the screen. It always stays on top of other windows. You can 
move this panel by dragging and releasing it.

The monitor mode GUI is comprised of the following areas.

Figure 4-39 Thermal Monitor/Control Software GUI (Monitor Mode)

1. Trigger Status (See p. 4-164.)

This displays the thermal condition for the idled DUT characteristics 
measurement and the target temperature.

2. Thermometer Readings (See p. 4-165.)

This displays the readings on the thermometers.

3. Context Menu (See p. 4-165.)

This provides the functions needed for various operations in the menu format.

Trigger Status
This displays the thermal condition for the idled DUT characteristics measurement 
and the target temperature. When no thermo-trigger list is executing, this displays 
“Idle”.

• During the DUT characteristics measurement is waiting until the thermal 
condition is true, this displays the thermal condition for the idled measurement.

• During controlling the temperature, this displays the target temperature and the 
thermometer position. 

For details, see “Thermo-Trigger” on page 4-171. Also see “Thermal Source” on 
page 4-167 for selecting the thermostream or the thermal plate.

1
2

3
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Thermometer Readings
This displays the readings of the following thermometers. It displays invalid value 
for invalid thermometers.

B1506A Displays temperatures measured by thermocouples connected 
to the test fixture.

• Ch.1

Displays a temperature measured by a thermocouple 
connected to the thermocouple connector 1.

• Ch.2

Displays a temperature measured by a thermocouple 
connected to the thermocouple connector 2.

• Ch.1 - 2

Displays a gap between the above Ch.1 and 2 values.

ThermoStream Displays temperatures measured by thermometers on the 
thermostream when ThermoStream is set to Thermal Source.

• Air: Displays a temperature at the air outlet.

• DUT: 
Displays a temperature measured by the DUT thermometer.

ThermalPlate Displays temperature measured by thermometer on the thermal 
plate when ThermalPlate is set to Thermal Source.

• Plate: 
Displays a temperature measured by the thermal plate. 

Context Menu
The following context menu is displayed by right-clicking on the panel.

Switch View Switches the view mode to the Control mode.
You can also switch to the Control mode by double-clicking on 
the panel.

Minimize Minimizes the panel.

Move to the Initial 
Position Moves the panel to the initial position.

Exit Closes the panel and exits the thermal monitor/control software.
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Control Mode GUI
The control mode GUI is comprised of the following areas.

Figure 4-40 Thermal Monitor/Control Software GUI (Control Mode)

1. Work Area (See p. 4-167.)

This area provides the functions to set the thermometers and thermal source, and 
create the thermo-trigger list, in addition to all the functions on the monitor 
mode panel. This is separated to the following areas.

a. Thermal Source (See p. 4-167.)

b. Monitor (See p. 4-167.)

c. Configuration (See p. 4-168.)

d. Thermo-Trigger (See p. 4-171.)

2. Operating Tools

• Toolbar (See p. 4-175.)

This provides the functions that are very frequently used in the button 
format.

• Main Menu (See p. 4-176.)

This provides the functions needed for various operations in the menu 
format.

2

b

c

d

1

a
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For the dialog box displayed during this software operation, see “Dialog Boxes” on 
page 4-181. 

For the files handled by this software, see “Summary of Files” on page 4-182.

Work Area
In this area, set the thermometers and thermal source, and create the thermo-trigger 
list. This is separated to the following areas.

• Thermal Source (See p. 4-167.)

• Monitor (See p. 4-167.)

• Configuration (See p. 4-168.)

• Thermo-Trigger (See p. 4-171.)

Thermal Source This field selects the thermal source used for the thermal control/monitor.

ThermoStream Thermostream is used.

ThermalPlate Thermal plate is used.

Monitor This is an area to display the following items that are common information on the 
monitor mode panel.

The following fields can be hidden or shown by clicking the line of  Monitor.

Figure 4-41 Monitor

Trigger Status This displays the thermal condition for the idled DUT 
characteristics measurement and the target temperature. When 
no thermo-trigger list is executing, this displays “Idle”.

• During the DUT characteristics measurement is waiting 
until the thermal condition is true, this displays the thermal 
condition for the idled measurement.

• During controlling the temperature, this displays the target 
temperature and the thermometer position.

For details, see “Thermo-Trigger” on page 4-171.
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B1506A Displays temperatures measured by thermocouples connected 
to the test fixture.

• Ch.1

Displays a temperature measured by a thermocouple 
connected to the thermocouple connector 1.

• Ch.2

Displays a temperature measured by a thermocouple 
connected to the thermocouple connector 2.

• Ch.1 - 2

Displays a gap between the above Ch.1 and 2 values.

ThermoStream Displays temperatures measured by thermometers on the 
thermostream when ThermoStream is set to Thermal Source.

• Air: Displays a temperature at the air outlet.

• DUT: 
Displays a temperature measured by the DUT thermometer.

ThermalPlate Displays temperature measured by thermometer on the thermal 
plate when ThermalPlate is set to Thermal Source.

• Plate: 
Displays a temperature measured by the thermal plate. 

Configuration This is an area to set the following items regarding the B1506A’s thermometers and 
the thermometers and control of the thermostream/thermal plate.

Figure 4-42 Configuration

The following fields can be hidden or shown by clicking the line of  
Configuration.

b

c

a
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a. B1506A Thermometer

This is an area to set the following items regarding the B1506A’s thermometers.

Reading Time 
Span Specify the reading time span for the thermometer.

Setting range: 2 s to 3600 s (resolution: 1 s). The default 
setting is 5 s.
While executing a measurement by any measurement 
software, the reading is delayed.

Channel 1 
check box Enable (On) or disable (Off) a thermocouple connected to 

the thermocouple connector 1 on the test fixture.

Channel 2 
check box Enable (On) or disable (Off) a thermocouple connected to 

the thermocouple connector 2 on the test fixture.

b. ThermoStream or ThermalPlate

This is an area to set the following items regarding the thermal source.

Thermometer Set up the thermometers of the thermal source.

• Reading Time Span

Specify the reading time span for the thermometer.
Setting range: 2 s to 3600 s (resolution: 1 s). The default 
setting is 5 s.

• Air check box, for ThermoStream

Enable (On) or disable (Off) the thermometer at the air 
outlet.

• DUT check box, for ThermoStream

Enable (On) or disable (Off) the DUT thermometer.

• Plate check box, for ThermalPlate

Enable (On) or disable (Off) the thermometer.
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GPIB Set up the communication with thermal source using the 
GPIB.

NOTE To control the thermal source from B1506A, set B1506A to the system controller.

• VISA Address

Specify the VISA address string of the thermal source.

The default value is ”GPIB0::9::INSTR”.

• Connect/Disconnect button

Tries to connect with the thermal source using the 
specified VISA Address, or to disconnect from it.

• Connection Status

Displays the result of the connection trial.

• Connected

Means that it is successfully connected.

• Disconnected

Means that it is NOT connected or is disconnected.

c. Optional Commands

This function allows to send additional command string to the thermal source 
when executing the thermo-trigger list. For the commands, see manual of the 
thermal source.

This field can be shown or hidden by clicking the line of  Optional 
Commands.

• Initialization

Specify command string that is sent at the beginning of the thermo-trigger 
list execution.

You can specify multiple commands in list format.

• Finalization

Specify command string that is sent at the end of the thermo-trigger list 
execution.

You can specify multiple commands in list format.
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Thermo-Trigger This is an area to create a thermo-trigger list.

Insert thermal condition steps and thermal control steps using the edition buttons on 
the bottom of the thermo-trigger list area, and set up the parameters of their steps to 
create a thermo-trigger list.

The following fields can be hidden or shown by clicking the line of  
Thermo-Trigger.

Figure 4-43 Thermo-Trigger

a. Thermo-Trigger List

The thermo-trigger list is a sequence comprised of thermal condition steps and 
thermal control steps.

The thermo-trigger list is executed from the top to the bottom of the list. If the 
thermostream is not connected, all thermal control steps in the list are skipped.

During executing one thermo-trigger list, a measurement on the measurement 
software waits until the thermal condition is true. Then, when it is true, the 
measurement is executed.

A thermo-trigger list can have maximum 100 steps.

Create a thermo-trigger list using the following edition buttons.

b. Edition Buttons

• Insert Condition

Inserts a new thermal condition step just before the selected step.

A new thermal condition step is added if the list is empty.

• Insert Control

a

b

c
d
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Inserts a new thermal control step just before the selected step.

A new thermal control step is added if the list is empty.

• Duplicate

Makes a duplicate of the selected step and insert it just before the selected 
step.

• Up

Move the selected step up one line.

• Down

Moves the selected step down one line.

• Delete

Deletes the selected step.

c. Parameters of Thermal Condition Step

The thermal condition step compares the specified temperature reading with the 
specified temperature window, and do the specified action such as triggering the 
DUT characteristics measurement if the temperature is within the window.

Specify a thermal condition (used thermometer and temperature window) and an 
action if the condition is true, in a thermal condition step.

Temperature Select a temperature that is used for the condition judgment.

• Channel1

Temperature measured by a thermocouple connected to 
the thermocouple connector 1 on the test fixture.

• Channel2

Temperature measured by a thermocouple connected to 
the thermocouple connector 2 on the test fixture.

• Channel1_2

A gap between the above Channel 1 and 2 values.

• ThermoStream_Air, for ThermoStream

Temperature at the air outlet of thermostream.

• ThermoStream_DUT, for ThermoStream

Temperature measured by the DUT thermometer of 
thermostream.
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• ThermalPlate, for ThermalPlate

Temperature measured by the thermometer of thermal 
plate.

Center Specify the center of the temperature window of the thermal 
condition. 

Radius Specify the range of the temperature window of the thermal 
condition. If you specify the Center parameter to 30°C and 
the Radius parameter to 2°C, the range of the thermal 
condition is from 28°C to 32°C.

Delay Specify a time after that the condition is true and before the 
specified action is done.

Action Select an action if the condition is true. 

• TRIGGER

Sends the start trigger for DUT characteristics 
measurement.

• NOP

No operation, and goes to the next step. 
This is useful to set multiple thermal conditions for a 
measurement.

• END

Finishes the thermo-trigger list execution.

d. Parameters of Thermal Control Step

NOTE These parameters are used for the thermal control using the thermal source. Skip this 
section if you do not perform thermal control via GPIB. 

The thermal control step controls the thermal source so that the temperature of 
the specified observation point reaches to the specified target temperature.

If there is a thermal condition step before a thermal control step in the 
thermo-trigger list, the thermal control step is executed after finishing the 
measurement triggered from the thermal condition step.

Specify a temperature observation point (control mode) an a target temperature 
in a thermal control step.

Control Mode Select the thermal control mode from below.
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• Air, for ThermoStream

Controls the temperature with referring to the 
thermometer at the air outlet of thermostream.

• DUT, for ThermoStream

Controls the temperature with referring to the DUT 
thermometer of the thermostream.

• Plate, for ThermalPlate

Controls the temperature with referring to the 
thermometer of the thermal plate.

Setpoint Specify the target temperature.

Ramp Specify the ramp rate of the temperature.

Optional 
Command This function allows to send additional command string to 

the thermal source when executing the thermal control step. 
For the commands, see manual of the thermal source.

You can specify multiple commands in list format.
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Toolbar

Figure 4-44 Toolbar

The toolbar has four tool button groups. The following shows the tool buttons in the 
tool button groups.

File tool button group

Open Opens the Open File dialog box used to open a 
specified setup file. The present data is cleared by 
opening the file.

Save Saves the present data as the same file name.

Exit Exits the thermal monitor/control software. Unsaved 
data is destroyed.

Edit tool button group

Cut Moves the selected text to the clipboard.

Copy Copies the selected text to the clipboard.

Paste Pastes the text from the clipboard to the insertion point.

On-screen 
keyboard

Displays the on-screen keyboard.

Trigger tool button group

Start Starts to execute the thermo-trigger list, and then 
switches the view mode to the monitor mode.

To stop the thermo-trigger list execution, select the 
Trigger > Stop menu, or click the Stop button  on the 
toolbar.
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Main Menu

Figure 4-45 Main Menu

The following describes the functions of the main menu.

File Menu Displays the following menu items to operate the setup file. For the file types and 
extensions, see “Summary of Files” on page 4-182.

New Clears the present data to start from initial setting.

Open... Opens the Open File dialog box used to open a specified setup 
file. The present data is cleared by opening the file.

Save Saves the present data as the same file name.

Save Setup As... Opens the Save Data File dialog box used to save the present 
setup data as the specified setup file.

Recent Setup Files 
Lists a maximum of 10 names of the setup files that were 
recently edited, as menu items. You can easily open a setup file 
by using them.

Exit Exits the thermal monitor/control software. Unsaved data is 
destroyed.

Edit Menu Displays the following menu items to edit the setup.

Cut Moves the selected text to the clipboard.

Stop Stops the thermo-trigger list execution.

View tool button group

Go to Palette Displays the software palette in fullscreen mode.

Switch View Switches the view mode to the Monitor mode.
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Copy Copies the selected text to the clipboard.

Paste Pastes the text from the clipboard to the insertion point.

On-screen 
keyboard... Displays the on-screen keyboard.

View Menu Displays the following menu items for the display setting.

Go to Palette Displays the software palette in fullscreen mode.

Switch View Switches the view mode to the Monitor mode.

Main Window Displays the following menu item.

Fullscreen Changes the display style of the main 
window.

If this is marked, the main window does not 
have the titlebar and is displayed in 
fullscreen mode.

If this is unmarked, the main window has 
the titlebar and is displayed in the regular 
window style.

This is initially marked.

Trigger Menu Displays the following menu items for controlling the thermo-trigger list execution.

Start Starts to execute the thermo-trigger list, and then switches the 
view mode to the monitor mode.

The thermo-trigger list is a sequence comprised of thermal 
condition steps and thermal control steps. For details, see 
“Thermo-Trigger” on page 4-171.

During executing one thermo-trigger list, you can execute a 
measurement on one of the following software in 
synchronization if the thermal conditions are respectively true.

• Datasheet Characterization Software (See p. 4-5.)

• I/V Measurement Software (See p. 4-56.)

• Capacitance Measurement Software (See p. 4-90.)

• Gate Charge Measurement Software (See p. 4-118.)
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During executing one thermo-trigger list, a measurement on the 
measurement software waits until the thermal condition is true. 
Then, when it is true, the measurement is executed. For the 
measurement execution in synchronization with the 
thermo-trigger list, see “Executing Measurement in 
Synchronization with Thermo-trigger List” on page 4-179.

Stop Stops the thermo-trigger list execution.

The measurement software cancels the idled measurement. 
Hence, the measurement is not executed.

Configuration 
Menu

Displays the following menu item for the thermostream parameter setting.

Define
ThermoStream
Parameters... Opens the ThermoStream Parameters dialog box. See 

“ThermoStream Parameters Dialog Box” on page 4-181.

Define
ThermalPlate
Parameters... Opens the ThermalPlate Parameters dialog box. See 

“ThermalPlate Parameters Dialog Box” on page 4-182.

Help Menu Displays the following menu item.

About... Opens the about box. See “About Box” on page 4-182.
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Executing Measurement in Synchronization with 
Thermo-trigger List
You can execute a DUT characteristics measurement using one of the following 
software in synchronization with the thermo-trigger list. Along the progress of the 
thermo-trigger list, the temperature around DUT is controlled and the measurement 
is executed if it reaches within the target temperature window. 

• Datasheet Characterization Software

• I/V Measurement Software

• Capacitance Measurement Software

• Gate Charge Measurement Software

If you use the thermal source to control the temperature around DUT, do the 
following preparation for the measurement in synchronization with the 
thermo-trigger list.

• On the measurement software: 
Set up the measurement conditions, and confirm the measurement is 
successfully executed at normal temperature. And then, save the setup data to a 
setup file or measurement data file.

• On the thermal monitor/control software: 
Set up the thermal condition and the thermal source control, and create a 
thermo-trigger list in the control mode. And then, save the setup data to a setup 
file.

After this preparation, follow the step below to execute the measurement in 
synchronization with the thermo-trigger list.

1. Start the thermal monitor/control software.

2. Switch the view mode to the Control mode.

3. Open the prepared setup file on the thermal monitor/control software.

4. Start the measurement software.

5. Open the prepared setup file or measurement data file on the measurement 
software.

6. Click Start tool button in the toolbar (or select Trigger > Start menu) on the 
thermal monitor/control software. The thermo-trigger list is executed.
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7. Click Start tool button in the toolbar (or select Measurement > Start menu) on 
the measurement software.
At this time, the measurement is not executed, and waits until the temperature 
reaches within the target temperature window. Along the progress of the 
thermo-trigger list, the temperature around DUT is controlled and the 
measurement is executed if it reaches within the target temperature window.

If you control the thermal source manually, you can execute the measurement in 
synchronization with the thermo-trigger list using the similar manner as above. The 
following shows the differences. 

• Preparation on the thermal monitor/control software: 
Set up the thermal conditions only, and create a thermo-trigger list that has only 
thermal condition steps, not thermal control steps.

• With checking the present temperature around DUT and the next target 
temperature window (thermal condition) using the monitor mode panel of the 
thermal monitor/control software, control the thermal source manually.
When the present temperature reaches within the target temperature window, the 
measurement is executed. Wait until finishing the measurement, control the 
thermal source again so that the temperature goes to the next target temperature 
window.
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Dialog Boxes

ThermoStream Parameters Dialog Box
This dialog box is used to define the thermostream parameters. For details of the 
parameters, see manual of thermostream.

This dialog box is opened by selecting the main menu Configuration > Define 
ThermoStream Parameters....

DUT sensor Select the type of the thermocouple used as the DUT 
thermometer.

• OFF (disable)

• K

• T

DUT self tuning 
control Select OFF or ON to disable or enable the self tuning control 

regarding the overshoot and speed of the DUT thermal 
controlling.

DUT thermal 
constant Specify a thermal constant for DUT thermal controlling.

Air to DUT max Specify the maximum acceptable difference between the DUT 
temperature and the temperature at the air outlet of 
thermostream.

Air temperature 
max Specify the maximum temperature at the air outlet of 

thermostream.

Air temperature 
min Specify the minimum temperature at the air outlet of 

thermostream.

Apply button Applies the present setting to the thermostream.

OK button Applies the present setting to the thermostream, and closes this 
dialog box.

Cancel button Closes this dialog box without applying the present setting.
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ThermalPlate Parameters Dialog Box
This dialog box is used to define the thermal plate parameters. For details of the 
parameters, see manual of thermal plate.

This dialog box is opened by selecting the main menu Configuration > Define 
ThermalPlate Parameters....

Frequency Specify the line frequency.

• 50Hz

• 60Hz

Upper 
Temperature 
Limit Specify the maximum programmable temperature.

Apply button Applies the present setting to the thermal plate.

OK button Applies the present setting to the thermal plate, and closes this 
dialog box.

Cancel button Closes this dialog box without applying the present setting.

About Box
The about box displays the model number, the software revision number, download 
URL for software updating, and so on.

This dialog box is opened by selecting the main menu Help > About....

Summary of Files
The following shows the summary of the files handled by the thermal 
monitor/control software.

Table 4-26 Summary of Files

File Type Description Extension Folder as Initial Setting

Setup File This has the setup data.

You can save this using the File menu 
anytime.

*.pda-th (You can specify the folder 
when saving the data)
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Common GUI Components
This section describes the following GUI components commonly used in the 
Keysight Easy Test Navigator software.

• “Module Configuration Dialog Box”

Module Configuration Dialog Box
You can do the following operations in the Module Configuration dialog box.

• Checking the revision of the firmware

• Setting the power line cycle

• Checking the status of the hardware modules

• Resetting the hardware modules

• Executing the self-test

• Executing the self-calibration

• Executing the self-diagnostics

This dialog box is opened by selecting the main menu Configuration > Module....

Firmware Revision Shows the revision of the firmware.

Line Frequency Sets the power line frequency. Select one from below. 

• 50 Hz

• 60 Hz

Module Name and 
Status

Shows the module’s model numbers and the result of the self-test, self-calibration, 
and self-diagnostics for the modules.

• B1506A-H20

Table 4-27 shows the configuration and status for B1506A-H20.

• B1506A-H21

Table 4-28 shows the configuration and status for B1506A-H21.
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• B1506A-H50/H70

Table 4-29 shows the configuration and status for B1506A-H50/H70.

• B1506A-H51/H71

Table 4-30 shows the configuration and status for B1506A-H51/H71.

Operation Buttons The Module Configuration dialog box has the following buttons for operations.

Reset Initializes and re-acknowledges all the modules.

Self Test Starts the self-test for all the modules.

Self Calibration Starts the self-calibration for all the modules.

Diagnosis Starts the self-diagnostics for all the output selectors.

After clicking this button, a dialog box is opened to instruct the 
terminal connections. Connect the terminals according to the 
displayed instructions.

Abort Aborts the process in progress.

Close Closes the Module Configuration dialog box.

Error Log This is a display area situated between the Abort and Close buttons. Error messages 
are displayed when errors occur during a process. The error messages are cleared 
when you do any new operation.
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Table 4-27 B1506A-H20 Configuration and Status

Configuration Status

GNDU : B1500-66505 • Pass

Passed

• Testing

Self-testing now

• Calibrating

Calibrating now

• Fail

Self-test failed or self-calibration 
failed

• Unavailable

Not acknowledged

MPSMU (SMU1) : B1511B

MCSMU (SMU2) : B1514A

HCSMU (SMU3) : B1512A

HVSMU (SMU4) : B1513C

I/V Selector • Pass

Passed

• Diagnosing

Diagnosing now

• Fail

Self-diagnostics failed

• Unavailable a

Not acknowledged

a. This also occurs before it is turned on.
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Table 4-28 B1506A-H21 Configuration and Status

Configuration Status

GNDU : B1500-66505 • Pass

Passed

• Testing

Self-testing now

• Calibrating

Calibrating now

• Fail

Self-test failed or self-calibration 
failed

• Unavailable

Not acknowledged

MPSMU (SMU1) : B1511B

MFCMU : B1520A

MCSMU (SMU2) : B1514A

MCSMU (SMU3) : B1514A

HCSMU (SMU4) : B1512A

HVSMU (SMU5) : B1513C

I/V Selector • Pass

Passed

• Diagnosing

Diagnosing now

• Fail

Self-diagnostics failed

• Unavailable a

Not acknowledged

a. This also occurs before it is turned on.

Device Capacitance Selector
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Table 4-29 B1506A-H50/H70 Configuration and Status

Configuration Status

GNDU : B1500-66505 • Pass

Passed

• Testing

Self-testing now

• Calibrating

Calibrating now

• Fail

Self-test failed or self-calibration 
failed

• Unavailable

Not acknowledged

MPSMU (SMU1) : B1511B

MCSMU (SMU2) : B1514A

MCSMU (SMU3) : B1514A

MCSMU (SMU4) : B1514A

HVSMU (SMU5) : B1513C

UHCU

I/V Selector • Pass

Passed

• Diagnosing

Diagnosing now

• Fail

Self-diagnostics failed

• Unavailable a

Not acknowledged

a. This also occurs before it is turned on.
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Table 4-30 B1506A-H51/H71 Configuration and Status

Configuration Status

GNDU : B1500-66505 • Pass

Passed

• Testing

Self-testing now

• Calibrating

Calibrating now

• Fail

Self-test failed or self-calibration 
failed

• Unavailable

Not acknowledged

MPSMU (SMU1) : B1511B

MFCMU : B1520A

MCSMU (SMU2) : B1514A

MCSMU (SMU3) : B1514A

MCSMU (SMU4) : B1514A

MCSMU (SMU5) : B1514A

HVSMU (SMU6) : B1513C

UHCU

I/V Selector • Pass

Passed

• Diagnosing

Diagnosing now

• Fail

Self-diagnostics failed

• Unavailable a

Not acknowledged

a. This also occurs before it is turned on.

Device Capacitance Selector
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